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Vài dòng giới thiệu
Adobe Photoshop (thường được gọi là Photoshop) là một phần mềm chỉnh sửa đồ họa được 
phát triển và phát hành bởi hãng Adobe Systems ra đời vào năm 1988 trên hệ máy Macintosh.  
Photoshop được đánh giá là phần mềm dẫn đầu thị trường về sửa ảnh bitmap và được coi là 
chuẩn cho các ngành liên quan tới chỉnh sửa ảnh. Từ phiên bản Photoshop 7.0 ra đời năm 2002, 
Photoshop đã làm lên một cuộc cách mạng về ảnh bitmap. Phiên bản mới nhất hiện nay là Adobe 
Photoshop CC.

Ngoài khả năng chính là chỉnh sửa ảnh cho các ấn phẩm, Photoshop còn được sử dụng trong các 
hoạt động như thiết kế trang web, vẽ các loại tranh (matte painting và nhiều thể loại khác), vẽ  
texture cho các chương trình 3D... gần như là mọi hoạt động liên quan đến ảnh bitmap.

Adobe Photoshop có khả năng tương thích với hầu hết các chương trình đồ họa khác của Adobe 
như Adobe Illustrator, Adobe Premiere, After After Effects và Adobe Encore. 

Photoshop đã mở ra cánh cửa giúp các nhà thiết kế đồ họa tự do thay đổi ngành công nghiệp này. 
Chương trình có các chức năng biên tập nâng cao vừa dễ sử dụng vừa luôn sẵn có cho những người 
dành thời gian học cách sử dụng. Nó phổ biến đến mức gần như bất kỳ người học thiết kế đồ họa 
nào cũng biết cách sử dụng; thậm chí là cả những người chuyên nghiệp, hoạt động trong ngành từ 
rất lâu trước khi phần mềm ra đời. Photoshop không chỉ dành cho những người chuyên nghiệp mà 
cả các nhiếp ảnh gia nghiệp dư muốn cải thiện ảnh chụp của mình.

Lịch sử Adobe Photoshop

Từ thuở niên thiếu, hai anh em Thomas Knoll và John Knoll đã thành thạo kỹ thuật xử lý ảnh trong 
buồng tối, do ảnh hưởng bởi niềm đam mê nhiếp ảnh của người cha - Glenn Knoll, giáo sư Đại học 
Michigan. Hai cậu Thomas và John cũng yêu thích việc lập trình trên máy tính Apple II.

Xúc cảm từ nghệ thuật nhiếp ảnh tác động đến việc chọn nghề của Thomas và John. Thomas theo 
ngành khoa học máy tính tại Đại học Michigan, luôn quan tâm đến những giải thuật xử lý ảnh (thu 
nhận từ máy quét). Khác với người anh, John tìm đến Đại học Southern California, theo ngành 
điện ảnh.

Năm 1987, trong khi Thomas đang thực hiện luận án tiến sĩ về xử lý ảnh, John tốt nghiệp đại học 
và tìm được việc làm “trong mơ” tại Công ty ILM (Industrial Light and Magic), nơi chuyên thực 
hiện kỹ xảo hình ảnh cho các xưởng phim ở Hollywood.

Khi thực hiện luận án, Thomas thử nghiệm nhiều giải thuật xử lý ảnh trên máy tính Mac  
(Macintosh). Máy Mac vào lúc đó dùng màn hình đơn sắc, khiến anh phải nghiên cứu giải thuật 
giả lập sắc độ xám để hiển thị được ảnh “đen trắng” trên màn hình. Thomas đặt tên cho tập hợp các 
chương trình nhỏ của mình là Display.

Trong một lần về thăm nhà ở Michigan, John nhận thấy Display có nhiều nét giống với phần mềm 
xử lý ảnh mà anh thường dùng trên máy tính Pixar đắt tiền tại ILM. Không thể đứng ngoài “cuộc 
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chơi”, John tham gia vào việc phát triển phần mềm Display, tự tạo thêm hoặc đề nghị Thomas tạo 
thêm các chức năng mới cho Display giúp ích cho việc làm phim ở ILM.

John đề nghị Thomas đổi tên Display đơn giản thành tên khác, hấp dẫn hơn. Lúc đầu cả hai chọn 
tên ImagePro, sau đổi thành PhotoLab, cuối cùng nhất trí chọn tên PhotoShop, một tên chưa ai 
dùng. Tuy nhiên, khi John đề nghị thương mại hóa PhotoShop, Thomas lại e ngại vì không muốn 
nhảy vào cuộc kinh doanh trong lúc luận án còn dở dang.

Tin chắc vào triển vọng của PhotoShop, khi trở lại làm việc tại California, John tìm cách liên lạc với 
nhiều công ty ở vùng Silicon Valley để tìm kênh phân phối chuyên nghiệp cho sản phẩm “cây nhà 
lá vườn” của mình. Vừa thúc giục Thomas tiếp tục bổ sung chức năng cho PhotoShop, John vừa 
biên soạn tài liệu hướng dẫn sử dụng. Sau khi gửi lại tài liệu cùng đĩa mềm PhotoShop tại nhiều 
công ty, chờ thẩm định và nhận được nhiều lời từ chối, cuối cùng John cũng đạt được ý nguyện. 
Công ty Adobe chấp thuận phân phối PhotoShop với tên gọi Adobe Photoshop (Shop được sửa 
thành shop). 

Để hoàn thiện Photoshop trước khi phát hành, hai chuyên viên của Adobe - Steve Guttman và 
Russell Brown - đề nghị với John nhiều sửa đổi về cấu trúc và giao diện của phần mềm. John truyền 
đạt lại cho Thomas ở Michigan qua điện thoại. Cứ vài ngày, Thomas lại ra bưu điện, gửi cấp tốc đĩa 
mềm chứa chương trình vừa chỉnh sửa cho Adobe (lúc đó chưa phải là thời đại Internet).

Ngày 19/2/1990, phần mềm Adobe Photoshop 1.0 dùng cho máy Mac, có dung lượng 728 KB, được 
phát hành ở dạng đóng gói, gồm một đĩa mềm và tài liệu hướng dẫn.

Từ năm 1992, khi vai trò chuyên nghiệp của Photoshop đã được xác lập, các phần mềm khác có 
chức năng xử lý ảnh tương tự Photoshop (Photo-Paint, Paint Shop Pro tại Mỹ, Nuances tại Pháp,...) 
mới xuất hiện.

Đến năm 1995, tập đoàn Adobe mua bản quyền Photoshop từ anh em Knoll.

Kể từ năm 2003, khi Adobe bắt đầu gói tất cả công cụ Web và in ấn (bao gồm Photoshop) vào một 
gói ứng dụng có tên là Creative Suite, hãng này thường xuyên nâng cấp bộ công cụ này dựa trên ý 
kiến đóng góp của cộng đồng, tập trung chủ yếu vào dịch vụ trực tuyến và phân tích web.

Giới thiệu Adobe Photoshop CC

Photoshop CC là phần mềm đồ họa mới nhất trong Seri Photosop được hãng Adobe công bố tại 
hội nghị Adobe MAX ở Los Angeles, Adobe chủ yếu giới thiệu một số cập nhật nổi bật bao gồm 
Camera Shake Reduction, Camera Raw Improvements, Image Upsampling, Properties Panel Im-
provements, Behance Integration, Sync Setting và một số khác.

Các tính năng và cải tiến mới trong Adobe Photoshop CC

Camera Shake Reduction
Hẳn chúng ta đều có những bức ảnh tưởng chừng như không thể nào dùng được nữa vì một hoặc 
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hai lý do như Shutter (màn chập) đóng chậm hay vì Focal length (tiêu cự ống kính) quá xa khiến 
ảnh bị nhòe, không nhìn rõ chủ thể. Bây giờ bạn không còn phải tiếc vì bị dính các lỗi đó khi chụp 
nữa vì Adobe đã cập nhật tính năng Camera Shake Reduction với khả năng phân tích hướng chụp 
của bức ảnh và giúp khôi phục lại độ sắc nét cho chúng.

Camera Shake Reduction sẽ được dùng dưới dạng của một Filter, chính xác hơn là sẽ được bổ 
sung vào Sharpen Filter với những tinh chỉnh bên trong như Blur Trace Bound, Smoothing,  
Artifact Suppresion cùng với khả năng phân tích hướng chụp ở trong bảng Advanced. Công dụng 
của chi tiết này là sẽ xác định hướng chụp và tính toán hướng cùng độ lệch của tay theo mức độ 
nhòe của ảnh. Đây là một cải tiến vô cùng hữu dụng trong việc cứu chữa những bức ảnh. 

Cải Tiến Camera Raw Retouching

Chức năng này cũng sẽ được đưa vào sử dụng dưới dạng là một Filter cho từng Layer hoặc các 
file bên trong Photoshop và với Adobe Camera RAW 8, chúng ta có thể chỉnh sửa những bức ảnh 
một cách tỉ mỉ hơn qua những chức năng chi tiết bên trong như Spot Removal tool: một công cụ 
dưới dạng Brush dùng để tô vẽ lên những vùng không mong muốn trong bức ảnh hay chức năng 
Visualize Spots giúp xác định những điểm ảnh bị hỏng do Lens hoăc Sensor dính bụi một cách dễ 
dàng hơn trước rất là nhiều.

Ta chỉ việc tô vẽ lên vùng muốn loại bỏ và Camera RAW sẽ tự động tìm vị trí thích hợp nhất để 
thay thế hoặc chúng ta có thể tự xác định chọn vùng thay thế. Ngoài ra chúng ta còn có thể xem lại 
những vùng mà đã được chỉnh sửa. Bất kể chi tiết lớn hay nhỏ, đơn giản hay phức tạp đều có thể 
dễ dàng xử lý với chức năng này.

Camera Raw Radial Filter

Với Camera Raw Radial Filter chúng ta có thể tạo một Radial Filter trên bức ảnh của mình đồng 
thời sử dụng một số Effect khác và hầu như tương tự Camera RAW, chúng hoàn toàn không làm gì 
ảnh hưởng xấu đến bức ảnh cả.

Camera Raw Automactic Upright

Tiếp tục với Camera Raw 8, chúng ta có thể xử lý những vấn đề thuộc về phối cảnh của bức hình 
một cách dễ dàng với Automatic Upright. Có rất là nhiều cách mà chúng ta mong muốn để giải 
quyết vấn đề phối cảnh mà chức năng này mang lại.

Phóng To Ảnh Không Bị Vỡ Bằng Resamping Method

Nếu trước kia việc phóng to một bức ảnh kích thước nhỏ, chất lượng thấp thường bị hiện tượng 
Noise (nhiễu), thì nay vấn đề đó đã được Adobe khắc phục qua chức năng Resampling Method. Do 
đó chúng ta đã có thể sử dụng những bức ảnh chất lượng thấp đưa vào trong những sản phẩm in 
ấn như Poster hoặc những áp phích cỡ lớn (Billboard size) mà không sợ Noise nữa.
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Cải tiến Smart Sharpen

Smart Sharpen là công nghệ tiên tiến nhất trong việc làm sắc nét ảnh ngày nay. Chúng làm cho 
bức ảnh trở nên rõ nhất có thể đồng thời giảm Noise cũng như những chấm sáng không cần thiết 
xuống mức thấp nhất và đưa ra kết quả ảnh chất lượng cao, trông tự nhiên hơn cho bức ảnh.

Ở phiên bản gần nhất là Photoshop CS6 khi dùng Smart Sharpen vẫn bị hiện tượng Noise. Phiên 
bản Photoshop CC đã khắc phục điều đó bằng Option mới là Reduce Noise với khả năng giảm 
thiểu Noise hiệu quả nhất cho dù có đẩy phần trăm của option Amount lên mức hơn 300%. Đây 
hẳn là một bước tiến tuyệt vời từ Adobe và qua đấy lại một lần nữa khẳng định sự tiên tiến của 
công nghệ này

Propertise được cải tiến để làm việc với Shape dễ dàng hơn

Properties Pannel sẽ giúp cho những ai làm việc với các loại Shape hay Icon thường xuyên sẽ dễ 
dàng hơn trong việc điều khiển chúng, nhất là việc xác định, lựa chọn giá trị bo tròn của các góc 
hình vuông, hình chữ nhật hoặc tam giác. Ngoài ra người dùng còn có thể thu nhỏ, kéo giãn độ dài 
các cạnh, hay dễ dàng điều chỉnh chúng bất cứ lúc nào.

Người dùng còn có thể tiết kiệm rất nhiều thời gian khi làm việc với nhiều Layer, Object khác nhau 
do  việc xác định Layer, Object nào đang được chọn qua bộ lọc mới nằm ở trên cùng góc bên trái 
của pannel Layers. 

8/ Tách Layer

Để đơn giản hóa công việc khi sử dụng Photoshop,  người dùng thường gộp những layer có 
tính chất chung trong một chuỗi layer lại với nhau để tiện quản lý. Cập nhật mới này cho phép 
người dùng tập trung làm việc với những layer đã chọn một cách nhanh chóng bằng một vài 
cú click chuột.

9/ Đồng bộ hóa dữ liệu

Việc đồng hóa các dữ liệu giúp chúng ta có thể động  và lưu trữ chúng trên cùng một tài khoản ta 
sẽ không mất nhiều thời gian vào việc cập nhật từng li từng tí, thay vì tìm đủ font, chép hết toàn bộ 
brush, action trong máy vào ổ cứng rồi đem lên cơ quan đăng bạn chỉ việc  nhập account Adobe 
và Sync chúng là ok.

Với những người phải thường xuyên sử dụng nhiều máy tính khác nhau để làm việc, chẳng hạn 
như máy ở cơ quan, máy ở nhà rồi laptop này, laptop kia thì sẽ gặp phải vấn đề với font do hệ thống 
fonts ở từng máy là khác nhau. Với Photoshop CC, người dùng có thể làm việc với dữ liệu và lưu 
trữ chúng trên cùng một tài khoản. 

Ví dụ như đang làm dở 1 project tại nhà, thay vì tìm đủ font, chép hết toàn bộ brush, action trong 
máy vào ổ cứng rồi đem lên chỗ làm chép lại vào máy tính ở đó thì người dùng chỉ cần đăng nhập 
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account Adobe và Sync chúng. Sẽ chỉ mất vài phút để chờ download toàn bộ xuống máy tính hiện 
tại và thế là xong.

Chia Sẽ Lên Behance

Adobe Creative Cloud và Behance bây giờ đã là một nhằm mục đích tham khảo ý tưởng đồng thời 
chia sẽ công việc với nhau tiện lợi. Làm nhiều hơn, chia sẽ nhiều hơn, không bao giờ ngừng học 
hỏi. Đó là Creative Cloude.

Như vậy là người dùng đang có một công cụ vô cùng mạnh mẽ và thân thiện để có thê thực hiện bất 
cứ công việc hay sáng tạo nào với ảnh. Chúng ta sẽ giới thiệu chi tiết  về các công cụ, lệnh, panels....
trong các phần tiếp theo.
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Làm quen với hộp công cụ - Tool box



Giáo trình Adobe Photoshop CC 11Created by GiangPM

www.enterfocus.edu.vn

Các công cụ đơn và công cụ nhóm

Hộp công cụ là nơi chứa các công cụ mà bạn sẽ sử dụng trong suốt quá 
trình chỉnh sửa ảnh hay thiết kế. Hộp công cụ thường nằm sát rìa trái cửa 
sổ làm việc của chương trình Adobe Photoshop.
Trong hộp công cụ chỉ có 2 công cụ đơn là Move Tool và Zoom Tool, còn 
lại là công cụ theo nhóm. Nếu công cụ nào mà bên dưới phía phải có một 
hình tam giác đen nhỏ thì đó chính là công cụ nhóm. Nhấn giữ chuột 
khoảng 1 giây trên công cụ đó sẽ mở ra hộp công cụ ẩn và bạn sẽ thấy đầy 
đủ các công cụ trong nhóm đó.
Nếu để ý, bạn sẽ thấy trên đỉnh hộp công cụ, phần màu sẫm có một mũi 
tên phía bên trái, nếu bấm vào mũi tên đó, hộp công cụ sẽ được trình bày 
thành dạng 2 cột thay cho dạng 1 cột dài hiện tại. Nếu bạn không thích 
kiểu đó, nhấn lại vào mũi tên một lần nữa, hộp công cụ sẽ trở về dạng 
mặc định. 

Hộp màu Foreground và Background

Ngoài các công cụ, phía dưới hộp còn có 2 ô màu, được gọi là Foreground 
Color và Background Color - Màu Tiền cảnh và màu hậu cảnh. Hầu hết 
các công cụ tô vẽ trong hộp công cụ đều lấy màu trong hộp Foreground 
Color - màu tiền cảnh để sử dụng.

Để thiết lập một màu mới trong ô Foreground Color hoặc Background 
Color, bạn hãy nhấp chuột vào ô màu muốn làm việc, sẽ có một hộp thoại 
mở ra, tùy vào bạn chọn ô nào, nó sẽ có tên là Color Picker (Foreground 
Color) hoặc Color Picker (Background Color).
Để thiết lập một giá trị màu mới, bạn có thể nhấp chuột vào vùng màu 
bạn muốn sử dụng trong ô vuông màu hiện hành của hộp thoại; nếu 
không phải vùng màu bạn muốn, hãy nhấp chuột vào dãy  màu hình chữ 
nhật bên phải của ô vuông màu để chuyển tới một vùng màu mới rồi tiến 
hành nhấp chọn khu vực màu mà bạn muốn.
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Muốn đưa màu trong 2 ô Foreground và Background về giá trị mặc định là đen và trắng, bạn cần 
nhấn vào biểu tượng 2 hình vuông nhỏ màu đen và trắng nằm chồng lên nhau ở sát gần 2 ô màu 
Foreground và Background, khi đó màu trong 2 ô sẽ được trả về giá trị mặc định là ô Foreground 
là màu đen và ô Background là màu trắng. Hoặc bạn có thể sử dụng phím tắt trên bàn phím là 
phím D.

Nếu bạn muốn hoán đổi vị trí của 2 ô màu, hãy nhấn vào biểu tượng mũi tên 2 đầu cong cong ở sát 
gần 2 ô màu Foreground và Background, 2 ô màu này sẽ hoán đổi cho nhau. Hoặc bạn có thể nhấn 
phím X để thực hiện thao tác hoán đổi 2 ô màu này.

Nút hoán chuyển giữa chế độ Standard và chế độ Quick Mask

Dưới cùng trong hộp công cụ là nút để chuyển đổi chế độ làm việc thông thường và chế độ Quick 
Mask, một phương pháp giúp bạn chỉnh sửa cho vùng chọn hiện hành với công cụ Erase và Brush.

Bạn có thể nhấn vào nút này để chuyển đổi giữa chế độ Standard và chế độ Quick Mask, hoặc nhấn 
phím Q để chuyển đổi giữa hai chế độ Standard và Quick Mask Mode.
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CHƯƠNG I: LÀM QUEN VỚI  ADOBE PHOTOSHOP - ĐIỂM 
ẢNH - VÙNG CHỌN - CÁC CÔNG CỤ TẠO VÙNG CHỌN - 
CÁC LỆNH LIÊN QUAN TỚI VÙNG CHỌN

Làm quen với Adobe Photoshop

Có rất nhiều chương trình xử lý ảnh số, tuy nhiên Photoshop luôn khẳng định được vai trò dẫn đầu 
của mình trong lĩnh vực này - điều này là không phải tranh cãi vì sự phổ dụng của chương trình 
đã đi vào đời sống tới mức khi nói tới việc một bức ảnh đã được chỉnh sửa, thì mọi người nói bức 
ảnh đã được Photoshop. 

Giao diện chương trình:

Để khởi động chương trình Photoshop, bạn vào Start/ All Programs/ Adobe Photoshop CC.

Khi chương trình được kích hoạt, bạn sẽ thấy giao diện của nó như hình sau

Bên lề trái màn hình là hộp công cụ (Tool Box) đây là nơi chứa toàn bộ các công cụ mà bạn sẽ sử 
dụng trong quá trình làm việc.

Bên lề phải màn hình là hệ thống Panel, chứa đựng các Panel như Layer, Channel, Path... trợ giúp 
các bạn trong quá trình làm việc. Các Panel này không phải là cố định, tùy thuộc vào công việc 
hay nhu cầu hoặc thói quen làm việc, bạn có thể đóng, mở thêm vào hay bớt đi các Panel sao cho 
thuận tiện.
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Sát khu vực màu xám đậm là thanh Options, đây là một trợ thủ của bạn trong quá trình làm việc 
vì nó biến đổi liên tục sao cho phù hợp với công cụ bạn đang chọn hay thao tác mà bạn đang thực 
hiện để giúp bạn đưa ra các lựa chọn hay ra lệnh một cách nhanh nhất mà không phải truy cập vào 
thanh Menu ở phía trên.

Sát ngay bên trên thanh Options chính là thanh Menu. Đây là nơi chứa các Menu giúp bạn chọn 
lựa các lệnh một cách chi tiết tùy theo thao tác mà bạn muốn thực hiện. 

Tìm hiểu về điểm ảnh:

Mở một bức ảnh trong Photoshop, ví dụ như bức ảnh bên dưới đây, chúng ta thấy gì trong đó?

Với mắt nhìn của chúng ta thì bức ảnh bên trên bao gồm một quả dưa vàng, một lát Kiwi, một cái 
nấm củ, một lát thịt, một quả việt quất, một cây củ cải đỏ...

Thế còn Photoshop thì sao? Nó có nhận ra các thứ giống như mắt nhìn của chúng ta không?

Để tìm hiểu xem Photoshop nhận diện một bức ảnh như thế nào, hãy nhấn chọn công cụ Zoom 
trong thanh Công cụ rồi nhấn vào một khu vực trên bức ảnh một vài lần để phóng to một phần bức 
ảnh lên, tới một mức độ phóng to nào đó chúng ta sẽ thấy những quả dưa vàng, lát Kiwi, cái nấm 
củ, lát thịt, quả việt quất, cây củ cải đỏ... thực chất được tạo nên bởi tổ hợp của vô số  những hình 
vuông nhỏ, mỗi hình vuông chứa một màu khác nhau. Những hình mà chúng ta thấy trên bức ảnh 
đều được tao nên bởi sự sắp xếp các hình vuông đó. Nếu bạn đã từng chơi trò xếp hình, bạn sẽ thấy 
một sự tương đồng giữa trò xếp hình và cách hiển thị ảnh số trong các chương trình chỉnh sửa ảnh 
nói chung hay trong Photoshop nói riêng: một bức ảnh được tạo nên bởi nhiều miếng ghép nhỏ. 
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Tuy nhiên sự khác biệt giữa một bức ảnh số với một bức tranh ghép hình là trong một mảnh của 
bức tranh ghép hình thì chứa nhiều chi tiết khác nhau, còn mảnh ghép trong bức ảnh số thì chỉ có 
một màu, không có nhiều chi tiết. Vậy đơn vị nhỏ nhất để tạo nên một bức ảnh số chính là các hình 
vuông nhỏ đó, và chúng ta gọi các hình vuông nhỏ đó là Điểm ảnh hay là “Pixel”.

Một bức ảnh tùy thuộc vào kích thước lớn hay nhỏ mà số lượng pixel cũng nhiều hay ít. Các thao 
tác  chỉnh sửa hay tô vẽ trên bức ảnh thực chất là làm việc với các pixel.

Khái niệm về vùng chọn

Như phần trên đã giới thiệu, một bức ảnh số thực chất là tập hợp của rất nhiều điểm ảnh mà tạo 
thành. Vậy khi chúng ta thao tác chỉnh sửa một bức ảnh, thực chất là chúng ta thao tác trên các 
điểm ảnh của bức ảnh số đó. 

Một vấn đề đặt ra là nếu chỉ muốn thao tác với một vùng nào đó trên bức ảnh, thì làm sao cho 
chương trình hiểu được và thao tác đúng trong vùng ta muốn thôi?

Bạn hãy làm một thử nghiệm nhỏ cùng tôi:

Với bức ảnh đang mở, bạn hãy chọn menu Edit/ Fill (hoặc nhấn tổ hợp Shift+F5); khi hộp thại Fill 
hiện ra, trong mục Contents, xổ danh sách xuống, hãy chọn Black, các mục còn lại để nguyên rồi 
nhấn nút OK. Thao tác vừa thực hiện là tô màu đen cho bức ảnh. Kết quả là bức ảnh sẽ giống như 
hình bên dưới. Tất cả hình ảnh trước đó không còn, thay vào đó là một màu đen.  Chính vì không 
xác định được những điểm ảnh nào sẽ nhận lệnh tô, nên toàn bộ các điểm ảnh trên bức ảnh đã 
được tô màu đen. 
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Bây giờ chúng ta lại thực hiện một thử nghiệm khác: 

Vào menu File/ Revert (F12) để khôi phục bức ảnh về trạng thái ban đầu. Tiếp đó nhấn chọn công 
cụ  Marquee Tool trong hộp công cụ rồi đưa vào trong bức ảnh, nhấn giữ phím trái chuột, kéo rê 
chéo một đoạn. Khi bạn nhả phím chuột ra, bạn sẽ thấy một vùng chọn hình chữ nhật đã được tạo 
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ra, giới hạn bởi một chu vi có đường viền đứt đoạn như hình vẽ bên dưới. Lúc này chúng ta lại lặp 
lại thao tác tô đã làm và kết quả là chỉ các điểm ảnh nằm trong phạm vi vùng chọn mà bạn vừa vẽ 
ra mới được tô  màu đen, còn các điểm ảnh khác không nằm trong phạm vi của vùng chọn thì vẫn 
giống như ban đầu.

Như vậy có thể nói vùng chọn có tác dụng giới hạn chính xác vùng điểm ảnh được phép làm việc.

Các tùy chọn và menu liên quan tới vùng chọn:

Trên thanh Option có một trường có tên là Feather được hiển thị khi công cụ thuộc nhóm  
Marquee và Lasso được chọn. Nó có tác dụng gán vùng ảnh hưởng mở rộng cho một vùng chọn.

Chúng ta làm một thực nghiệm để tìm hiểu vai trò của Feather đối với vùng chọn:

Sử dụng công cụ Rectangle Marquee, tạo một vùng chọn trên tấm ảnh đang mở, lưu ý lúc này 
tham số trong trường Feather là 0. Sau đó nhấn tổ hợp Shift+F6 để gọi hộp thoại Fill, chọn màu 
Black, nhấn OK để tô màu vào trong vùng chọn vừa tạo. 

Tiếp theo, ta gán một giá trị vào trường Feather, ví dụ là 15 px, sau đó vẽ tiếp một vùng chọn có độ 
lớn tương tự như vùng chọn vừa tạo, đặt ngay kế bên vùng chọn cũ. Dễ thấy sự khác biệt của vùng 
chọn cũ và vùng chọn được gán Feather là vùng chọn cũ thì vuông vắn, trong khi vùng chọn mới có 
gán Feather thì các góc bị bo tròn. Thực hiện lại lệnh tô màu, sau đó quan sát sự khác biệt kết quả:

•	 Vùng chọn không gán Feather thì kết quả tô sắc nét, màu trong vùng chọn đồng nhất, và lệnh 
tô chỉ được áp dụng trong phạm vi bên trong vùng chọn.

•	 Vùng chọn có gán Feather thì kết quả tô không đồng nhất, tâm vùng chọn có màu đậm, rìa 
vùng chọn có màu nhạt, và khác biệt quan trọng nhất là lệnh tô không giới hạn trong phạm 



Giáo trình Adobe Photoshop CC 19Created by GiangPM

www.enterfocus.edu.vn

vi vùng chọn mà còn tô lấn ra bên ngoài một khoảng.

Việc gán giá trị vào trường Feather, cho phép tạo một vùng ảnh hưởng vượt ra khỏi phạm vi của 
vùng chọn hiện hành. Khi chúng ta thực hiện lệnh tô (hay một lệnh bất kỳ) trên vùng chọn đã gán 
Feather, thì không chỉ các điểm ảnh trong vùng chọn được tô, mà cả các điểm ảnh xung quanh 
vùng chọn, trong khoảng 15 px cũng được tô màu. Vùng chọn có gán Feather nhận lệnh mạnh ở 
tâm vùng chọn, và yếu dần ra phía ngoài biên, càng ra ngoài càng yếu dần đi.
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Lưu ý: Không nên gán giá trị vào trường Feather trên thanh Option, vì giá trị này sẽ bị lưu, phiên 
làm việc sau đó, mặc dù chúng ta không có ý định gán Feather cho vùng chọn, nhưng nó vẫn tác 
động tới vùng chọn mới được tạo ra. Vậy khi dùng xong, bạn nên trả lại giá trị trong trường Feather 
trên thanh Option về 0 px, hay tốt nhất là nhấn tổ hợp phím Shift+F6 để gọi hộp thoại Feather; sử 
dụng hộp thoại này gán giá trị Feather cho vùng chọn sẽ tốt hơn  bới mỗi lần gán, giá trị, chỉ có tác 
dụng một lần duy nhất cho vùng chọn hiện hành mà thôi.

Khái niệm vùng chọn trôi nổi:

Ta có thể sử dụng công cụ đã tạo ra vùng chọn đưa vào bên trong vùng chọn hiện hành để kéo nó 
tới  bất cứ vị trí nào trên bức ảnh. Khi buông phím chuột, vùng chọn sẽ chuyển tới vị trí mới.
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Di chuyển các điểm ảnh trong vùng chọn tới vị trí mới:

Chọn công cụ Move (V) trong hộp công cụ và đưa vào trong phạm vi vùng chọn hiện hành, ta sẽ 
thấy  trỏ chuột thay đổi thành hình mũi tên đen nhỏ kèm theo hình cái kéo. 

Nếu nhấn chuột và kéo, ta thấy vùng chọn cùng các điểm ảnh bên trong sẽ được cắt khỏi vị trí hiện 
tai, di chuyển tới vị trí mới.

Lúc này, vùng điểm ảnh trong vùng chọn được gọi là vùng ảnh trôi nổi - Floating Image - và có thể 
được kéo tới bất cứ đâu trên bức ảnh. Chỉ khi chúng ta hủy bỏ vùng chọn thì vùng điểm ảnh này sẽ 
được dán vào vị trí mới, thay thể cho các điểm ảnh cũ tại vị trí đó.

Nếu trong quá trình di chuyển, ta nhấn giữ phím Alt thì mỗi khi dừng lại tại đâu, các điểm ảnh nằm 
trong vùng chọn sẽ tạo ra bản sao tại đó.
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Nếu chúng ta sử dụng công cụ Move kéo một vùng điểm ảnh được chọn sang một cửa sổ ảnh khác 
thì  các điểm ảnh trong bức ảnh gốc không thay đổi, mà thao tác này sẽ Copy các điểm ảnh trong 
vùng chọn và Paste sang cửa sổ ảnh kia.

Copy - Cut - Paste  các điểm ảnh trong vùng chọn

Khi có một vùng chọn, ta có thể thực hiện việc Copy, Cut, Paste các điểm ảnh nằm trong vùng chọn 
này. Có thể Paste một vùng điểm ảnh thành một layer mới trong chính cửa sổ đang mở của bức 
ảnh; cũng có thể Copy điểm ảnh từ bức ảnh này, Paste sang một bức ảnh khác.

Di chuyển và chỉnh sửa vùng chọn trong khi đang tạo vùng chọn

Nếu bạn sử dụng công cụ Rectangle Marquee để tạo vùng chọn cho một vùng ảnh có hình chữ nhật 
thì thao tác sẽ hết sức đơn giản vì chỉ cần chọn công cụ, đặt chính xác vào điểm góc trên cùng bên 
trái của vùng ảnh bạn muốn chọn rồi nhấn giữ phím trái chuột và kéo rê đi để tạo vùng chọn thì 
chắc chắn bạn sẽ tạo được vùng chọn chính xác bao lấy vùng bạn muốn. 

Nhưng sẽ không dễ dàng như vậy nếu vùng hình ảnh bạn muốn chọn có hình elipse, thì khi đó 
việc đặt chuột chính xác vào điểm góc trên bên trái của vùng hình ảnh là rất khó khăn và thường 
thì vùng chọn mà bạn tạo ra không khớp được với vùng ảnh mà bạn muốn lấy. Vậy có thể nào tạo 
một vùng chọn hình elipse cũng chính xác như tạo một vùng chọn hình chữ nhật không? Và cách 
làm thế nào?
Để thực hiện việc này, đầu tiên bạn hãy chọn công cụ tạo vùng chọn hình elipse, nhấn chột và vẽ 
một vùng chọn bất kỳ, không cần biết là to hay nhỏ, đã chính xác hay chưa; sau đó vẫn giữ phím trái 
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chuột, đồng thời nhấn giữ phím cách trên bàn phím (Space Bar), lúc này neus bạn di chuyển chuột, 
vùng chọn đang vẽ của bạn cũng di chuyển theo, hãy đưa vùng chọn tới mép trái và đỉnh trên của 
vùng hình ảnh muốn lấy, nhả phím cách ra rồi tiếp tục di chuột sao cho vùng chọn bạn vẽ bao lấy 
vùng ảnh  bạn muốn lấy. Trong suốt quá trình thao tác, hãy nhớ luôn giứ phím trái chuột và chỉ 
được buông ra khi vùng chọn đã hoàn thành, bao một cách chính xác vùng bạn muốn.

Vẽ vùng chọn từ tâm 

Thông thường, ta vẽ một vùng chọn từ điểm đặt chuột, theo thói quen là từ góc trên, bên trái rồi 
kéo chuột xuống phía dưới, bên phải. Nếu trường hợp muốn vẽ vùng chọn từ tâm ra, bạn nhấp 
chuột vào tâm của vùng hình ảnh muốn chọn, đồng thời nhấn giữ phím Alt, lúc này vùng chọn sẽ 
được vẽ từ tâm ra thay vì từ góc.  

Mở rộng, thu hẹp vùng chọn hiện hành

Nếu bạn muốn mở rộng vùng chọn hiện hành, bạn cần nhấn giữ phím Shift đồng thời sử dụng 
công cụ tạo vùng chọn vẽ thêm một vùng chọn mới. Nếu vùng chọn mới giao cắt với vùng chọn cũ, 
chúng sẽ tự động hòa trộn với nhau để tạo nên một vùng chọn lớn hơn; nếu chúng không giao cắt 
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nhau thì  chúng tạo ra một vùng chọn bao gồm 2 khu vực là vùng chọn cũ và vùng chọn mới vẽ. Về 
thực chất đó chỉ là một vùng chọn mà thôi, vì khi chúng ta thực hiện một lệnh bất kỳ, ví dụ như tô 
màu vào vùng chọn thì cùng lúc, cả 2 khu vực đều nhận lệnh tô giống nhau.

Trường hợp bạn muốn thu hẹp bớt vùng chọn hiện hành, bạn cần nhấn giữ phím Alt và vẽ một 
vùng chọn mới giao cắt với vùng chọn cũ, khi hoàn thành vùng chọn mới sẽ cắt bỏ vùng chọn cũ ở 
vùng giao nhau, vùng chọn còn lại sẽ là vùng chọn cũ loại bỏ đi vùng giao nhau với vùng chọn mới.

Một cách khác là bạn sử dụng Tùy chọn trên thanh Options:

Khi bạn vẽ một vùng chọn, thanh Options sẽ biến đổi để hỗ trợ thao tác vẽ vùng chọn của bạn. 
Nhìn lên trên thanh Optons, bạn sẽ thấy một số Icon có hình dạng như sau:

•	 New selection: khi chế độ này được chọn, sẽ luôn tạo ra vùng chọn mới, nếu đang có một vùng 
chọn hiện hành thì vùng chọn mới sẽ tự động hủy bỏ vùng chọn cũ.

•	 Add to selection: khi chế độ này được chọn, thì vùng chọn mới sẽ không hủy bỏ vùng chọn 
hiện hành, mà thêm vào và mở rộng diện tích cho vùng chọn cũ, lựa chọn này tương tự như 
thao tác nhấn giữ phím Shift khi vẽ vùng chọn.

•	 Subtract from selection: khi chế độ này được chọn, thì vùng chọn mới được tạo nếu giao nhau 
với vùng chọn hiện hành, sẽ tự động cắt bỏ phần giao nhau giữa hai vùng chọn mới và cũ, chỉ 
giữ lại phần vùng chọn cũ không nằm trong vùng giao cắt. Thao tác này tương đương với việc 
nhấn giữ phím Alt khi vẽ vùng chọn.

•	 Intersect from selection: khi chế độ này được chọn, thì vùng chọn mới được tạo nếu giao 
nhau với vùng chọn hiện hành, sẽ giữ lại phần giao nhau giữa hai vùng chọn, đồng thời hủy bỏ 
nhũng phần không giao nhau. 

Vậy có nên sử dụng các chế độ trên không? Nếu có thì sử dụng chế độ nào?
Bạn nên luôn luôn chọn chế độ New selection khi làm việc; còn nếu muốn thêm hay bớt cho 
vùng chọn hiện hành, cách nhanh nhất và linh hoạt là nhấn giữ phím Shift hay phím Alt vì nếu 
chế độ Add to selection hay Subtract from selection được kích hoạt thì vùng chọn mới luôn 
thêm vào hay cắt bớt vùng chọn cũ, rất khó chịu cho người làm việc; trường hợp muốn giữ vùng 
giao nhau giữa vùng chọn mới và vùng chọn hiện hành thì bạn mới cần kích hoạt nút Intersect 
with selection.

Tinh chỉnh vùng chọn

Đôi khi bạn tạo vùng chọn của một vùng điểm ảnh phức tạp, trên một nền cũng phức tạp nên cần 
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phải hiệu chỉnh lại vùng biên cho tinh tế và chính xác hơn. Adobe Photoshop CS5 cung cấp  cho 
bạn một cách thức hiệu chỉnh biên vùng chọn hoàn toàn mới là  Refine Edge để cải thiện chất 
lượng của vùng chọn và cho phép quan sát vùng chọn với các màu nền khác nhau để dễ hiệu chỉnh.

Để sử dụng tính năng mới này, bạn chọn thực hiện theo cách sau:
 
•	 Tạo vùng chọn bằng 1 công cụ chọn bất kỳ
•	 Chọn menu Select > Refine Edge... (Ctrl + Alt + R) 
•	 Hoặc nhấn chọn nút lệnh Refine Edge trên thanh Option
Radius: xác định kích thước của vùng bao xung quanh vùng chọn mà tại đó việc tinh chỉnh vùng 
chọn sẽ được thực hiện. Bạn có thể tăng giá trị Radius để tạo ra một vùng chọn chính xác cho 
những vùng có độ chuyển nhẹ nhàng và nhiều chi tiết như lông, tóc hoặc các biên mờ.
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Contrast: làm cho biên của vùng chọn sắc cạnh và loại bỏ chi tiết thừa. Khi Radius có giá trị lớn, 
bạn cần tăng Contrast để loại bỏ nhiễu tại biên của vùng chọn.

Smooth: có giá trị từ 0-100 nhằm loại bỏ các “đồi núi” và “thung lũng” trên vùng chọn, giúp cho 
vùng chọn được trơn hơn.

Feather: có giá trị từ 0-250 nhằm tạo ra sự chuyển tiếp nhẹ nhàng giữa vùng chọn và những điểm 
ảnh lân cận.

Contract/Expand: thu hẹp hoặc nới rộng vùng chọn.

Nếu đối tượng cần chọn có màu khác biệt với màu nền, bạn hãy tăng Radius, chỉnh Contrast để làm 
sắc nét biên của vùng chọn, rồi mới điều chỉnh thanh trượt Contract/Expand. 

Nếu màu của đối tượng cần chọn gần trùng với màu nền bạn hãy điều chỉnh Smooth trước, sau đó 
đến Feather rồi mới điều chỉnh thanh trượt Contract/Expand.

M. Xem trước ở chế độ vùng chọn 
V. Xem trước ở chế độ Quick Mask
B. Xem trước với nền đen
W. Xem trước với nền trắng
K . Xem dưới dạng kênh Alpha
L . Xem dưới dạng Layer thông thường

Lưu và tải lại vùng chọn đã lưu

Lưu vùng chọn
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Thao tác bạn phải thực hiện nhiều nhất khi sử dụng Photoshop có lẽ chính là tạo vùng chọn bởi bất 
cứ thao tác nào cũng dựa trên vùng chọn để giới hạn phạm vi làm việc, không tác động tới những 
vùng điểm ảnh không mong muốn. Tuy nhiên, không phải thao tác một lần là đạt được kết quả 
ưng ý ngay, mà có lúc bạn cần chỉnh lại một vùng ảnh đã thao tác. Vậy là lại phải chọn lại vùng đó. 
Do đó bạn cần lưu lại vùng chọn đã tạo nhằm mục đích tái sử dụng trong các phiên làm việc khác.

Để lưu một vùng chọn, bạn thực hiện theo những cách sau:

Cách 1: Chọn Window > Channels để hiển thị Channels panel. Bấm chuột vào nút Save selection 
as channel (lưu vùng chọn)   của Channels panel.

Sau khi lưu vùng chọn, trên Channels panel sẽ xuất hiện một kênh mới, gọi là kênh alpha (alpha 
channel). Mục đích của kênh alpha là dùng để lưu trữ vùng chọn. Vùng trắng trên kênh alpha 
tượng trưng cho vùng chọn (selected area). Vùng đen trên kênh alpha tượng trưng cho vùng 
không được chọn (non-selected area) hay còn gọi là vùng bị che (masked area).
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Cách 2: Chọn Select > Save Selection...

Bạn có thể đặt tên cho vùng chọn bạn muốn lưu tại trường Name thay vì để Photoshop đặt tên tự 
động là Alpha Channel.

Tải lại vùng chọn đã lưu

Nếu muốn nạp trở lại vùng chọn đã được lưu trên kênh alpha, bạn có những cách sau:

Cách 1: Chọn Select > Load Selection... để hiển thị hộp thoại Load Selection

Cách 2: Trên Channels panel, dùng chuột kéo kênh cần nạp vùng chọn vào nút  Load channel as selection 
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Cách 3:  Nhấn giữ phím Ctrl rồi bấm chuột vào kênh cần nạp vùng chọn trên Channels panel.

Khi bạn tạo một vùng chọn, thì phần hình ảnh không được chọn (non-selected area) được che đi 
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(masked), tức là được bảo vệ trước các thao tác chỉnh sửa hình ảnh. Như vậy khi bạn tạo ra một 
bản che (mask), bạn đã cô lập và bảo vệ một số phần của hình ảnh trước các thao tác như: chỉnh 
sửa màu, áp dụng bộ lọc (filter), tô vẽ...

CÁC CÔNG CỤ VÀ PHƯƠNG PHÁP TẠO VÙNG CHỌN

Tạo vùng chọn với nhóm công cụ Marquee

Nhóm Marquee tool gồm có 4 công cụ, lần lượt có tên và công dụng như sau:

•	 Rectangular Marquee (M): tạo vùng chọn hình chữ nhật 
•	 Eliptical Marquee (M): tạo vùng chọn hình elipse
•	 Single Row Marquee: tạo vùng chọn hình chữ nhật rộng 1 pixel, cao bằng chiều cao bức ảnh
•	 Single Collumn Marquee: tạo vùng chọn hình chữ nhật cao 1 pixel, rộng bằng chiều rộng bức ảnh.

      

Thao tác vẽ vùng chọn:

Với 2 công cụ Rectangle Marquee và Eliptical Marquee, đưa trỏ chuột tới góc trên bên trái của 
vùng hình ảnh muốn chọn, nhấn giữ phím trái chuột và kéo chéo theo chiều từ trên xuống dưới, 
từ trái qua phải, khi thấy vùng chọn giới hạn bởi một khung đứt đoạn bao lấy vùng hình ảnh muốn 
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chọn thì nhả phím chuột kết thúc thao tác tạo vùng chọn.
Với 2 công cụ Single Row Marquee và Single Collumn Marquee, chỉ cần đưa trỏ chuột tới vùng 
muốn chọn, click chuột trái là vùng chọn sẽ được tự động tạo ra. 

Các tùy chọn liên quan tới 2 công cụ Rectangle Marquee và Eliptical Marquee trên thanh Option:
Trong trường Style có 3 tùy chọn lần lượt là 

•	 Normal		
•	 Fixed Ratio
•	 Fixed Size

Chế độ Normal được coi là tùy chọn mặc định của cả hai công cụ . Với tùy chọn này, vùng chọn có 
thể tạo ra ngắn - dài - cao - thấp - rộng - hẹp tùy ý, không có bất cứ hạn chế nào, trỏ chuột đưa tới 
đâu, vùng chọn được tạo ra tới đó

Chế độ Fixed Ratio khi được chọn, sẽ kích hoạt 2 trường Width và Height, mặc định được điền 
sẵn giá trị là 1. Với tùy chọn này, khi rê chuột tạo vùng chọn, sẽ khóa tỷ lệ 2 chiều rộng và cao của 
vùng chọn đang được vẽ là 1:1 tức là nếu vẽ bằng công cụ Rectangle Marquee sẽ cho ra vùng chọn 
hình vuông, còn nếu sử dụng công cụ Eliptical Marquee sẽ tạo ra vùng chọn hình tròn. Các tham 
số ở 2 trường này có thể thay đổi, khi đó, hình dáng vùng chọn khi vẽ ra sẽ tuân theo tỷ lệ được quy 
định trong 2 trường này.

Chế độ Fixed Size khi được chọn, mặc định Photoshop điền sẵn trong 2 trường Width và Height 
là 64 px. Khi ta đưa trỏ chuột vào trong bức ảnh, click chuột tại đâu thì sẽ tạo ra từ điểm click chuột 
về bên phải, xuống phía dưới một vùng chọn có kích thước chính xác là 64x64 px. Nếu muốn, ta có 
thể thay thế tham số mặc định này.

Vậy người sử dụng Photoshop nên dùng chế độ nào trong 3 tùy chọn trên?

Thông thường, chế độ mặc định được thiết lập là Normal. Ở chế độ này, người sử dụng sẽ thoải 
mái tạo các vùng chọn lớn bé theo ý thích, không bị gò bó. 

Chế độ Fixed Ratio giúp tạo vùng chọn có tỷ số giữa chiều rộng và chiều cao, tuy nhiên người sử 
dụng hay sử dụng nhất là tỷ số 1x1 để tạo vùng chọn hình vuông hay hình tròn; mà để tạo vùng 
chọn kiểu này, vẫn có thể sử dụng chế độ Normal, kèm theo thao tác nhấn giữ phím Shift khi tạo 
vùng chọn thì cũng tạo ra vùng chọn hình tròn hay hình vuông.

Chế độ Fixed Size cho phép tạo vùng chọn có kích thước chính xác, thường dùng trong trường 
hợp thiết kế giao diện cho các phần mềm hay chương trình đòi hỏi độ chính xác cao, chạy trên nền 
Mobile do màn hình của các thiết bị này có kích thước nhỏ. Nếu bạn sử dụng Photoshop để thiết 
kế in ấn thì hầu như không cần dùng đến tùy chọn này.
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Checkbox Anti Alias cho Eliptical Marquee:

Về cơ bản, các tùy chọn của 2 công cụ Rectangle Marquee và Eliptical Marquee là giống nhau, tuy 
nhiên khi chọn sử dụng công cụ Eliptical Marquee thì trên thanh Option có một checkbox có tên 
là Anti Alias được kích hoạt. Nhiệm vụ của checkbox này là khử hiệu ứng răng cửa cho vùng chọn 
hình elipse.

Tại sao lại nói khử hiệu ứng răng cưa?

Trong Photoshop, dùng công cụ Eliptical Marquee, nhấn giữ phím Shift vẽ một vùng chọn hình 
tròn. Vùng chọn này có thực sự tròn không? Nếu nhìn qua thì có vẻ là nó tròn, nhưng nếu phóng 
to lên để quan sát thì rõ ràng vùng chọn này rất mấp mô. điều này là đương nhiên vì vùng chọn là 
chọn các điểm ảnh, mà các điểm ảnh thì có hình vuông cho nên chu vi của một tổ hợp các hình 
vuông thì không thể là một hình tròn thật sự được. Nếu ta tiến hành tô màu vào vùng chọn này, 
hiệu ứng Anti Alias sẽ tô bù một số điểm ảnh vào các vùng gãy góc để tạo ảo giác là vùng tô này 
là tròn. Màu tô bù sẽ được tô từ trong vùng chọn ra một vài pixel bên ngoài vùng chọn, là một dãy 
màu, chuyển sắc dần từ màu bên trong vùng chọn tới màu bên ngoài vùng chọn. Hiệu ứng này chỉ 
tác dụng tới một dãy các pixel nằm sát rìa vùng chọn.

Hình trái là hình không có Anti Alias So sánh biên của 2 vùng tô có và không có Anti Alias

Thao tác mở rộng hay thu hẹp vùng chọn; vừa vẽ vừa di chuyển vừa chỉnh sửa vùng chọn đối với 
nhóm công cụ Marquee cũng giống như đối với vùng chọn nói chung.

Đối với 2 công cụ Single Row Marquee và Single Collumn Marquee thì chỉ có chế độ Normal hiển 
thị, do 2 công cụ này mang một sỗ trói buộc về độ cao hay độ rộng của vùng chọn, mặt khác, do 
hình của vùng chọn là chữ nhật, không có chứa yếu tố đường cong nên tùy chọn checkbox Anti 
Alias cũng không khả dụng trong trường hợp người sử dụng chọn các công cụ này.

Tạo vùng chọn với nhóm công cụ Lasso

Nhóm Lasso gồm có 3 công cụ có tên và công dụng như sau:  
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•	 Lasso: tạo vùng chọn bằng cách vẽ tự do bao quanh vùng 
ảnh muốn chọn

•	 Polygon Lasso: tạo vùng chọn bằng cách vẽ hình đa giác 
bao quanh vùng ảnh muốn chọn

•	 Magnetic Lasso: tạo vùng chọn bằng cách tự xác định và 
bám vào biên giới của các đối tượng trên hình ảnh.

Thao tác vẽ vùng chọn:

Với công cụ Lasso:

Chọn công cụ Lasso trong hộp công cụ, nhấp giữ phím trái và kéo rê chuột sao cho đường 
viền chọn chạy theo chu vi của một đối tượng, để kết thúc ta chỉ cần nhả chuột.

Vùng chọn vẽ bằng công cụ Lasso có tính tùy biến về hình dạng cao, linh hoạt nhưng nhược 
điểm là thiếu sự chuẩn xác, hầu như không thể vẽ chính xác một vùng chọn bám theo biên 
của vùng hình ảnh đối tượng muốn chọn. Lasso thường được dùng để tạo một vùng chọn 
mang tính tương đối, sau đó sẽ kết hợp với một công cụ tạo vùng chọn khác, thường là Magic 
Wand để hoàn thiện vùng chọn.

Lưu ý là bạn không được nhả phím chuột trước khi hoàn thành việc vẽ vùng bao, bất cứ khi 
nào bạn nhả phím chuột, thao tác coi như kết thúc và vùng chọn luôn được tự động kép kín 
bằng cách nối điểm đầu và điểm cuối của vùng chọn bằng một đường thẳng. 

Với công cụ Polygon Lasso:  
 

Chọn công Polygon Lasso trong hộp công cụ, kích từng điểm để tạo khung viền chọn trên 
hình ảnh. Kích lại điểm đầu tiên hoặc kích kép để kết thúc. Xóa từng điểm chọn sai bằng 
phím Delete.

Trong khi Lasso buộc bạn phải giữ phím chuột cho tới khi kết thúc việc vẽ vùng chọn thì 
Polygon Lasso lại cho phép bạn nhấp, nhả phím chuột theo từng điểm trên biên vùng chọn. 
Bạn sẽ thấy thoải mái hơn khi thao tác với công cụ này, đặc biệt là khi vùng ảnh bạn chọn có 
đường biên là đường thẳng; còn với vùng đường biên có dạng cong, bạn hãy nhấp chuột từng 
đoạn thẳng ngắn để tạo một vùng biên cong tương đối và bao lấy nó.

Đôi khi bạn muốn hoán đổi tạm thời giữa công cụ Polygon Lasso với Lasso thì bạn hãy nhả 
phím chuột, sau đó nhấn giữ phím Alt, nhấp giữ phím chuột và kéo rê chuột để vẽ như với 
công cụ Lasso, khi bạn nhả phím chuột và phím Alt, công cụ lại trở về cách thức hoạt động 
của Polygon Lasso.
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Với công cụ Magnetic Lasso:  

Magnetic là từ tính, có tính chất hút sắt, khi gặp sắt sẽ tự động bám dính vào. Ở đây chúng 
ta không có sắt, cũng chẳng có nam châm mà chỉ có công cụ tạo vùng chọn và các điểm 
ảnh vậy tại sao lại gọi là Magnetic Lasso? 

Cái chúng ta cần chọn làc các điểm ảnh, mà Photoshop lại quản lý các điểm ảnh chứ không 
quản lý các đối tượng có mặt trong bức ảnh, nó không biết trên bức ảnh có những đối tượng 
nào. Vậy làm sao nó có thể tự bám vào đường biên của đối tượng trong ảnh? 

Thực ra Adobe Photoshop đưa ra một cách nhận diện cũng rất dế hiểu: các đối tượng khác 
nhau thì có màu khác nhau, chất liệu khác nhau, bắt ánh sáng nhiều ít khác nhau, do đó 
nếu có 2 đối tượng khác nhau đặt cạnh nhau hoặc một đối tượng trên một nền nào đó thì 
biên giới giữa chúng sẽ là một vùng kéo dài, mỗi bên là một màu khác nhau, một chất liệu 
khác nhau... do đó nếu xuất hiện một dải khác biệt kéo dài mỗi bên là một màu thì thường 
đó chính là ranh giới của đối tượng và việc tự động bám vào đó sẽ tạo được vùng chọn bao 
quanh đối tượng cần chọn.

Thao tác chọn như sau: chọn công cụ Magnetic Lasso trong hộp công cụ, đưa trỏ chuột tới 
vùng biên của đối tượng, click chuột để công cụ nhận diện mẫu sự khác biệt màu tại điểm đó, 
sau đó rê chuột tương đối chính xác xung quanh chu vi của hình muốn chọn, Magnetic Lasso 
sẽ theo mẫu nhận diện được khi click chuột lần đầu và tự động bám theo các vùng có sự khác 
biệt đó để tạo nên vùng chọn.  Trong quá trình di chuyển chuột quanh chu vi đối tượng, ta có 
thể kích để cưỡng chế vùng chọn đi đúng hướng (nếu chế độ tự động không chính xác). Xóa 
từng điểm chọn sai bằng phím Delete.

Thao tác sẽ kết thúc khi trỏ chuột quay về điểm đầu tiên để tạo nên vùng khép kín hay bạn 
nhấp đúp chuột tại bất cứ vị trí nào, thì vùng chọn được tự động nối kín giữa điểm bắt đầu 
và điểm mà bạn nhấp đúp chuột bằng một đoạn thẳng.

Thuộc tính (Options) của công cụ Magnetic Lasso:
 

•	 Width: khoảng cách lớn nhất mà đường Lasso di chuyển (10px).
•	 Frequency: tần số xuất hiện các điểm neo, tần số càng cao thì điểm neo xuất hiện càng 

dày.
•	 Edge Contrast: độ nét của biên màu, khi biên màu bị nhoè thì mới tăng Contrast.

Tạo vùng chọn với nhóm công cụ Magic Wand  
Nhóm Magic Wand gồm có 2 công cụ có tên và công dụng như sau:

•	 Magic Wand:
•	 Quick Selection
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Thao tác tạo vùng chọn:

Với công cụ Magic Wand 

Chọn công cụ Magic Wand  trong hộp công cụ, click vào màu mà bạn muốn chọn trên hình 
ảnh, công cụ sẽ xác định chính xác giá trị màu của pixel mà bạn đã click vào, sau đó, từ tâm 
điểm là pixel mà bạn click, công cụ Magic Wand sẽ dò tìm ra bốn phía xung quanh, gặp bất 
cứ pixel nào có giá trị tương tự như pixel mẫu, nó liền kết nạp vào vùng chọn. một vùng 
màu tương ứng được chọn. Độ rộng của vùng chọn tùy thuộc vào giá trị Tolerance trên 
thanh Options: giá trị Tolerance càng thấp, vùng chọn tạo ra càng nhỏ, nhưng độ đồng đều 
về mầu càng cao; ngược lại giá trị Tolerance càng cao, vùng chọn được tạo càng lớn nhưng 
độ đồng đều về màu thì lại thấp đi, lúc này vùng chọn có thể bao gồm cả những pixel chỉ 
giống một phần so với màu của pixel mẫu. Với cách chọn này, bạn không thể biết trước 
vùng chọn khi ta nhấp chuột sẽ có hình dạng và độ lớn nhỏ ra sao.

 
Thuộc tính: 
 

•	 Tolerance: Dung sai của vùng chọn, dung sai càng lớn thì vùng chọn càng rộng.
•	 Anti – Alias: Khử răng cưa
•	 Contiguous: Chọn màu cục bộ - màu được giới hạn bởi những vùng màu lân cận. (Nếu 

không được kiểm nhận thì sẽ chọn trên toàn file)
•	 Use All Layers: Chọn trên tất cả các Layer, không phân biệt Layer hiện hành hay những 

Layer khác.

Để mở rộng - thu hẹp vùng chọn, nhấn giữ phím Shift hoặc Alt trong lúc click chuột để tạo vùng 
chọn.

Với công cụ Quick Selection

Trong khi Magic Wand tạo vùng chọn bằng giá trị màu tương đồng của một màu mẫu được 
chỉ định, thì Quick Selection lại tạo vùng chọn bằng cách lấy vùng giá trị trung bình cộng 
của các điểm ảnh nằm trong diện tích của đầu công cụ. Click chuột vào vùng muốn chọn, 
sẽ tạo ra vùng chọn đầu tiên có diện tích đúng bằng diện tích đầu công cụ, tiếp theo click 
thêm vào một điểm mới trong phạm vi vùng ảnh mà bạn muốn lấy, Quick Selection sẽ tự 
động nối các vùng chọn lại với nhau nếu giá trị trung bình cộng của các vùng chọn này 
giống nhau.

Tạo vùng chọn bằng Quick Mask

Chế độ Quick Mask

Chế độ Quick Mask cho phép chuyển vùng chọn thành một bản che tạm (temporary mask) để tiện 
việc chỉnh sửa vùng chọn. Sự tiện lợi trong việc chỉnh sửa vùng chọn như là một mask là ở chỗ bạn 
có thể sử dụng hầu hết các công cụ và filter của Photoshop để hiệu chỉnh mask. Mỗi khi bạn thoát 
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khỏi chế độ Quick Mask, mask sẽ được chuyển trở lại thành vùng chọn.

Cách sử dụng:

- Vẽ phác một vùng chọn. 
- Chọn nút Edit in Quick Mask mode trên thanh công cụ hoặc nhấn phím Q.
- Một cách mặc nhiên, khi đó vùng che (masked areas) sẽ được phủ bằng 50% của màu đỏ (red).
- Để hiệu chỉnh mask, bạn có thể dùng các công cụ tô vẽ hoặc filter. Khi đó, màu foreground và 
background trên thanh công cụ được tự động chuyển thành đen và trắng. Tô với màu đen là để mở 
rộng vùng che và thu hẹp vùng chọn. Tô với màu trắng là mở rộng vùng chọn và thu hẹp vùng che. 
Tô với màu xám là để tạo vùng chọn nửa trong suốt (semi-transparent).
Để quay trở lại chế độ chuẩn (Standard mode), bạn chọn nút   trên thanh công cụ. Khi đó vùng 
chọn sẽ được hiện trở lại như bình thường.

A. Chế độ chuẩn 

B. Chế độ Quick Mask 

C.Vùng chọn được biểu thị bằng màu 
trắng trên biểu tượng thu nhỏ trên 
Channels panel

D. Vùng không chọn được biểu thị 
bằng màu đen trên biểu tượng thu nhỏ 
trên Channels panel
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A.Vùng chọn ban đầu và chế độ Quick Mask với màu lục tượng 
trưng cho vùng che

B.Tô màu trắng trong chế độ Quick Mask để mở rộng vùng chọn

C.Tô với màu đen trong chế độ Quick Mask để thu hẹp vùng 
chọn

Lưu ý: 

•	 Để chuyển đổi qua lại giữa 2 chế độ Standard mode   và Quick Mask mode    , bạn có 
thể bấm phím tắt (Q).

•	 Để đảo màu foreground color và backgound color, bạn bấm chuột vào biểu tượng    trên 
thanh công cụ hoặc bấm phím tắt (X).

•	 Vùng chọn tạo bởi chế độ Quick Mask chỉ là vùng chọn tạm thời. Để lưu vùng chọn này thành 
kênh alpha, bạn hãy sử dụng những cách đã tìm hiểu trong phần Lưu và tải lại vùng chọn đã 
lưu.

Thay đổi tùy chọn của Quick Mask

Muốn thay đổi các tùy chọn của chế độ Quick Mask, bạn bấm đúp chuột vào biểu tượng   trên 
thanh công cụ để hiển thị hộp thoại sau: 
Mặc định 50% red tượng trưng cho vùng che (masked areas). Bạn có thể bấm chuột vào ô màu để 
thay đổi màu mặc định

Masked Areas: chọn tùy chọn này để định vùng che là đen (đục) và vùng chọn là trắng (trong 
suốt). Tô với đen để mở rộng vùng che; tô với trắng để mở rộng vùng chọn. Khi chọn tùy chọn này, 
nút Quick Mask trên thanh công cụ có dạng hình tròn màu trắng trên nền xám  

Selected Areas: chọn tùy chọn này để định vùng che là trắng (trong suốt) và vùng chọn là đen 
(đục). Tô với trắng để mở rộng vùng che; tô với đen mở rộng vùng chọn. Khi chọn tùy chọn này, 
nút Quick Mask trên thanh công cụ có dạng hình tròn màu xám trên nền trắng  
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Mẹo: Để chuyển đổi qua lại giữa 2 tùy chọn Masked Areas và Selected Areas của chế độ Quick 
Mask, bạn có thể nhấn giữ phím Alt và bấm chuột vào nút Quick Mask trên thanh công cụ.

Menu Select và các lệnh liên quan với vùng chọn 

•	 Lệnh Select All (Ctrl + A): Tạo vùng chọn trên toàn bộ hình ảnh hay trên toàn bộ layer. 
•	 Lệnh Deselect (Ctrl + D): Hủy bỏ vùng chọn hiện hành trên màn hình làm việc.
•	 Lệnh Reselect (Ctrl + Shift + D): Tải lại vùng chọn mà bạn vừa hủy bỏ.
•	 Lệnh Inverse (Ctrl + Shift + I): Nghịch đảo vùng chọn hiện hành.
•	 Color Range: Tạo vùng chọn trên một màu của bức ảnh. Công dụng tương tự như Magic 

Wand nhưng có ưu điểm hơn nhờ có chức năng Fuzziness để tăng giảm lượng màu tương ứng.

-	 Selection: Ô preview chỉ hiển thị hình ảnh dưới dạng màu trắng, đen. Vùng có 
màu trắng là vùng được chọn, vùng màu đen là vùng không được chọn.

-	 Image: Ô Preview hiển thị dạng ảnh màu.
•	 Feather (Ctrl + Alt + D): Gán giá trị vùng ảnh hưởng mở rộng cho một vùng chọn.
•	  Modify: bao gồm 5 lệnh giúp hiệu chỉnh vùng chọn hiện hành

		  - Border: Tạo khung viền cho biên vùng chọn (Width: gán độ rộng của khung viền)
		  - Smooth: Làm mịn vùng chọn bằng cách cắt bỏ các đỉnh nhọn sắc của vùng chọn, 
		  - Expand: Mở rộng đều chu vi vùng chọn
		  - Contract: Thu hẹp đều chu vi vùng chọn

•	 Lệnh Grow: Nới rộng vùng chọn có vùng màu gần nhất (chọn màu cục bộ).
•	 Lệnh Similar: Dò tìm trên toàn file tất cả các mẫu màu trùng với màu đã chọn ban đầu và chọn 

hết (Chọn theo tông màu đã chọn trước trên toàn file).
•	 Lệnh Transform Selection: Phóng to thu nhỏ, xoay,… vùng chọn. Giữ shift bấm vào bốn góc 

hộp vuông vùng chọn sẽ đều hơn. (Hoặc ta có thể kích phải mouse vào bên trong vùng chọn 
để chọn chế độ Transform Selection).

•	 Lệnh Save Selection: Lưu vùng chọn, vùng chọn được lưu sẽ hiển thị trong kênh Alpha và đặt 
tên cho vùng chọn đó.
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•	 Lệnh Load Selection: tải vùng chọn đã lưu trữ.
-	 New selection: vùng chọn mới

-	 Add to selection: vùng chọn mới sẽ là sự kết hợp khi vùng chọn vừa vẽ với vùng 
chọn có sẵn trong kênh được chọn.

-	 Subtract from selection: vùng chọn mới sẽ là phần còn lại sau khi vùng chọn vừa 
vẽ cắt vùng chọn có sẵn trong kênh được chọn.

-	 Intersect with selection: vùng chọn mới sẽ là phần giao nhau của vùng chọn vừa 
vẽ với vùng chọn có sẵn trong kênh được chọn. 

Menu Edit và các lệnh biến đổi đối tượng hay vùng điểm ảnh được chọn

Dùng để biến đổi đối tượng hay vùng điểm ảnh được chọn.

Lệnh Transfrom

Lệnh Transform giúp bạn biến đổi đối tượng hay vùng điểm ảnh trên layer. Lệnh Transform bao 
gồm các lệnh cụ thể sau:

•	 Againt (Shift+Ctrl+T): thực hiện thêm một lần nữa lệnh Transform vừa được áp dụng.
•	 Scale: thay đổi tỷ lệ cho đối tượng hay vùng điểm ảnh được chọn
•	 Rotate: xoay đối tượng hay vùng điểm ảnh được chọn
•	 Skew: kéo xiên đối tượng hay vùng điểm ảnh được chọn
•	 Distort: làm biến dạng đối tượng hay vùng điểm ảnh được chọn
•	 Perspective: làm biến dạng đối tượng hay vùng điểm ảnh được chọn theo phối cảnh
•	 Warp: làm biến dạng đối tượng hay vùng điểm ảnh được chọn bằng hệ lưới biến dạng.
•	 Rotate 180 0: xoay đối tượng hay vùng điểm ảnh được chọn 180 0 
•	 Rotate 90 0 CW: xoay đối tượng hay vùng điểm ảnh được chọn 90 0 theo chiều kim đồng hồ
•	 Rotate 90 0 CCW: xoay đối tượng hay vùng điểm ảnh được chọn 90 0 ngược chiều kim đồng 

hồ
•	 Flip Horizontal: lật đối tượng hay vùng điểm ảnh được chọn theo chiều ngang
•	 Flip Vertical: lật đối tượng hay vùng điểm ảnh được chọn theo chiều đứng

Khi thao tác với lệnh Scale: 

Nhấn vào một trong các điểm điều khiển ở giữa của bounding box sẽ giúp thay đổi tỷ lệ chiều 
cao hay chiều rộng của đối tượng hay vùng điểm ảnh được chọn. Trong quá trình  thao tác, nếu 
nhấn giữ thêm phím Alt sẽ tạo ra biến đổi ở chiều cạnh đối diện, cạnh được kéo thay đổi bao nhiêu, 
thì cạnh đối diện cũng se thay đổi bấy nhiêu, nhưng theo chiều ngược lại. 

Trường hợp nhấn vào một trong các điểm điều khiển ở góc của bounding box, nếu nhấn giữ thêm 
phím Shift sẽ giữ tỷ lệ giữa hai chiều của đối tượng hay vùng ảnh đang thao tác; nếu nhấn giữ 
Shift+Alt thì vừa giữ tỷ lệ, vừa biến đổi từ tâm.
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Khi thao tác với lệnh Skew:

Nhấn vào một trong các điểm điều khiển ở giữa của Bounding box và kéo sẽ làm xiên đối tượng 
hay vùng điểm ảnh được chọn theo chiều kéo. Nếu kết hợp với nhấn giữ phím Alt khi kéo thì đồng 
thời sẽ kéo xiên cả hai chiều của cạnh được kéo lẫn cạnh đối diện; tỷ lệ kéo xiên của hai cạnh là 
bằng nhau, nhưng chiều kéo xiên thì ngược nhau.

Khi thao tác với lệnh Distort:

Nhấn vào một trong các điểm điều khiển ở góc của Bounding box và kéo theo chiều hướng bạn 
muốn, đổi tượng hay vùng điểm ảnh được chọn sẽ biến dạng không giữ tỷ lệ; có thể kéo cho hình 
biến dạng theo kiểu vặn xoắn. Trong khi thao tác, nếu nhấn giữ thêm phím Alt thì sẽ làm biến dạng 
cả góc đối diện với cường độ biến dạng tượng tự nhưng chiều hướng thì ngược lại với chiều biến 
dạng ở góc đang được thao tác.

Khi thao tác với lệnh Warp:

Khi áp dụng lệnh này, đối tượng hay vùng điểm ảnh được chọn sẽ được phủ lên một hệ thống lưới. 
Bạn có thể nhấn vào hệ lưới và kéo; khi hệ lưới bị biến dạng, nó làm cho đối tượng hay vùng điểm 
ảnh được chọn biến dạng theo. 

Mặt khác trên thanh Options có một list các khuôn lưới biến dạng cho sẵn, bạn có xổ danh sách 
ra và chọn lấy một kiểu trong danh sách để áp dụng cho đối tượng. Khi kiểu biến dạng được chọn, 
thì trong cửa sổ hình ảnh, đối tượng hay vùng điểm ảnh được chọn sẽ có biến đổi tương ứng để 
bạn hình dung trước sự biến dạng sẽ xảy ra. Nếu chưa vừa ý, bạn xổ danh sách ra và chọn lấy một 
kiểu khác. Khi ưng ý, bạn có thể nhấn OK, hay click vào biểu tượng  để xác nhận áp dụng và kết 
thúc thao tác Warp.

Khung lưới và danh sách kiểu biến dạng Biến dạng khi bóp méo khung lưới
   

Lệnh Free Transform (Ctrl+T):

Lệnh Free Transform (biến đổi tự do) thực chất là một lệnh tổ hợp bao gồm tất cả các phương pháp 
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thay đổi và biến dạng trong lệnh Transform. Sự tiện dụng của nó là do muốn sử dụng thao tác nào 
thì có thể thực hiện luôn, không cần phải chọn lệnh cụ thể như trong lệnh Transform. Thao tác 
Skew, Distort, Pespective khi thực hiện cần nhấn giữ thêm phím Ctrl và bấm vào điểm điều khiển 
phù hợp với thao tác. Nếu nhấn kèm thêm phím Shift hay phím Alt thì hiệu quả cũng tương tự như 
khi nhấn giữ các phím đó trong thao tác với lệnh Transform.

Riêng với thao Warp, bạn cần nhấn chọn icon  trên thanh Options để gán lưới vào cho đối 
tượng hay vùng điểm ảnh mà bạn muốn làm biến dạng. Các thao tác khác cũng giống như khi thực 
hiện với lệnh Transform.

Lệnh Content - Aware Scale:

Trong khi thao tác cắt ghép và chỉnh sửa ảnh, bạn đôi khi cần Resize cho một layer; thao tác này có 
thể thực hiện rất dễ dàng với lệnh Transform hay Free Transform. Tuy nhiên nếu vùng điểm ảnh 
hay đối tượng được Resize là những hình ảnh khó xác định kích thước và tỷ lệ như mây trời, cây cỏ 
hay phong cảnh nói chung thì không sao, nhưng nếu trong khung cảnh có chứa đối tượng có thể 
xác định kích thước hay tỷ lệ như con người chẳng hạn thì đối tượng đó sẽ gây khó chịu cho người 
xem do biến dạng không hợp lý. Để khắc phục tình trạng này, từ phiên bản CS5, Adobe Photoshop 
đưa ra một cách Resize có bảo vệ tỷ lệ cho một vùng xác định bằng một lệnh biến đổi mới là Con-
tent - Aware Scale (Alt+Shift+Ctrl+C). 

Thao tác khi sử dụng lệnh này là bạn phải xác định trước khu vực hình ảnh sẽ được bảo vệ tỷ lệ, 
tạo vùng chọn bao quanh khu vực đó và lưu vùng chọn vừa tạo trước khi thực hiện thao tác Resize.

Chúng ta sử dụng bức ảnh có tên là Guy_wall.psd làm ví dụ minh họa

•	 Mở tấm ảnh muốn thực hiện thao tác resize, ở đây là tấm ảnh Guy_wall.psd

•	 Sử dụng bất cứ công cụ nào bạn muốn, tạo vùng chọn bao quanh người đàn ông trong ảnh, 
không cần chính xác tuyệt đối.
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•	 Vào menu Select> Save Selection, đặt tên cho vùng chọn được lưu là vung_bao_ve, OK

•	 Hủy vùng chọn hiện hành (Ctrl+D), sau đó vào menu Edit> Content-Aware Scale 

•	 Khi Bounding box hiện ra bao lấy vùng ảnh, tại thanh Options, xổ danh sách Protect, chọn 
vung_bao_ve; tiếp đó nhấp chuột vào điểm điều khiển bên hông phải của tấm ảnh, kéo về 
bên trái để thu kích thước chiều ngang của tấm ảnh còn khoảng 1/2 so với nguyên bản. Nhấn 
Enter để xác nhận thao tác.



Giáo trình Adobe Photoshop CC 43Created by GiangPM

www.enterfocus.edu.vn

•	 Kết quả chiều ngang của tấm ảnh giảm còn một nửa, mọi chi tiết trên tấm ảnh đều bị thu 
lại, nhưng người đàn ông trong ảnh thì vẫn giữ nguyên kích thước và tỷ lệ như trong ảnh 
gốc, hoàn toàn không bị ảnh hưởng bởi thao tác resize. Đó cũng là điểm đặc biệt mà lệnh  
Content-Aware Scale mang đến cho người sử dụng từ phiên bản Photoshop CS5.  
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CHƯƠNG II: LÀM VIỆC VỚI LAYER - SMART OBJECT

Trong số các panel được Adobe Photoshop cung cấp, thì Layer là panel được sử dụng nhiều nhất. 
Layer giúp bạn quản lý tài liệu đang mở, hiển thị các phần tử thiết kế hay ẩn giấu một phần chúng. 
Layer giúp chúng ta nắm bắt được tầng thứ của các thành phần trong bức ảnh hay trong bản thiết 
kế, ... có thể nói, không có layer panel thì gần như không thể làm việc được trong Adobe Photoshop.

Layer Backgroud

Khi ta mở một bức ảnh, thì trong Layer panel ít nhất sẽ xuất hiện một layer, trường hợp này nó sẽ 
có tên là Background, layer này sẽ nằm dưới cùng nếu có thêm các layer khác xuất hiện trong Layer 
panel.

Khi có một vùng điểm ảnh được Paste vào cửa sổ ảnh đang mở, trong Layer panel sẽ xuất hiện một 
layer mới, được đặt tên tự động theo thứ tự xuất hiện của layer đó, ví dụ Layer 1, Layer 2... bạn có 
thể sử dụng cách đặt tên mặc định đó hoặc đổi tên layer cho sát với nội dung vùng điểm ảnh đang 
xuất hiện trên layer sao cho dễ hình dung. 

Để đổi tên cho một layer, bạn nhấp đúp chuột vào tên của layer, khi tên layer được bôi đen, bạn nhập 
tên mới vào cho layer, sau đó nhấp chuột vào một vùng bất kỳ bên ngoài để kết thúc việc đổi tên cho 
layer đó.

Đổi hoặc đặt tên cho layer sẽ giúp thao tác với bức ảnh dễ dàng và nhanh hơn vì khi tìm kiếm hay 
lựa chọn một layer thì chúng ta không phải căng mắt ra quan sát trong thumbnail xem layer đó chứa 
đựng nội dung gì mà chỉ cần tìm đúng tên layer mong muốn.
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Chọn một layer để thao tác

Cũng như với các điểm ảnh, do có thể có nhiều layer khác nhau trong một bức ảnh nên khi bạn 
muốn thao tác với các điểm ảnh thuộc layer nào, bạn cần chọn layer chứa các điểm ảnh đó đã.

Có 3 cách để bạn chọn lựa một layer:

•	 Trong Layer pannel, bạn click vào layer mà bạn muốn thao tác, layer được chọn sẽ có màu 
xanh để phân biệt với các layer khác không được chọn.

•	 Trong cửa sổ hiển thị ảnh, bạn click chuột phải vào vùng hình ảnh mà bạn muốn xử lý, một 
menu ngữ cảnh sẽ hiện lên, thông báo tại điểm bạn click chuột có bao nhiêu layer cùng hiển 
thị; click chuột vào layer mà bạn muốn làm việc, layer đó sẽ được chọn, đồng thời trong layer 
pannel, biểu tượng tương ứng của layer đó cũng được đánh dấu bằng màu xanh để phân biệt 
với các layer khác không được chọn.

•	 Trên thanh Option, có một checkbox tên là Auto Select, nếu bạn kích hoạt checkbox này, đồng 
thời ở hộp danh sách ngay bên cạnh, bạn chọn chế độ là Layer thì bạn chỉ cần click chuột vào 
vùng ảnh bất kỳ trông cửa sổ hiển thị ảnh thì Photoshop sẽ tự động xác định layer của vùng 
ảnh đó và tự động lựa chọn layer đó để làm việc.
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Thay đổi tầng thứ cho layer

Để thay đổi tầng thứ của các layer, chúng ta có thể thực hiện theo 3 cách là:

•	 Trực tiếp kéo thả các layer trong Layer panel để đưa chúng tới vị trí mà bạn muốn 
•	 Sử dụng lệnh trong menu Layer > Arrange
•	 Sử dụng phím tắt trên bàn phím

Để trực tiếp kéo thả một layer, ta nhấp chuột vào layer muốn thay đổi tầng thứ, nhấn giữ phím trái 
chuột vào kéo layer đó tới vị trí mới mà bạn muốn trong Layer panel. Trong lúc kéo, ta thấy layer 
được chọn sẽ có hình xanh mờ, và di chuyển tới vị trí mới, khi nhả phím chuột ra, layer mờ biến 
mất, đồng thời layer được chọn cũng sẽ đổi tới vị trí mới. 
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Muốn thay đổi tầng thứ cho một layer bằng lệnh,  đầu tiên bạn cần chọn layer đó trong Layer panel, 
sau đó vào menu Layer> Arrange. 

Khi menu con xổ ra chọn lấy một lệnh trong số các lệnh để thực hiện việc chuyển tầng thứ của  
layer đang được lựa chọn.

•	 Bring To Front: đưa layer được chọn lên trên vị trí đầu trong Layer panel
•	 Bring Forward: đưa layer được chọn lên trên một bậc so với hiện tại
•	 Send Backward: đưa layer được chọn xuống dưới một bậc so với hiện tại
•	 Send to Back: đưa layer được chọn xuống dưới cùng trong Layer panel
•	 Reverse: chọn ít nhất 2 layer, thực hiện lệnh đảo ngược tầng thứ với các layer được chọn.

Còn nếu bạn muốn sử dụng lệnh tắt thì thao tác như sau:

•	 Bring To Front: chọn layer> nhấn tổ hợp phím Ctrl+Shift + ]
•	 Bring Forward: chọn layer> nhấn tổ hợp phím Ctrl+ ]
•	 Send Backward: chọn layer> nhấn tổ hợp phím Ctrl+[
•	 Send to Back: chọn layer> nhấn tổ hợp phím Ctrl+Shift + [
•	 Reverse: không có phím tắt. 

Bất cứ layer nào cũng có thể di chuyển và thay đổi tầng thứ, trừ layer Background. Muốn cho layer 
Background có thể thay đổi tầng thứ, trước hết bạn cần đổi tên cho layer bằng cách nhấp đúp chuột 
vào tên của layer, khi có hộp thoại hiện ra, đổi tên cho layer Background thành layer 0, nhấn OK để 
xác nhận; lúc này bạn đã có thể thực hiện thao tác đổi tầng thứ cho layer này.
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Ẩn - Hiện layer

Bạn có thể làm ẩn một (hoặc nhiều) layer, và làm hiện trở lại chúng. 
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Để làm ẩn một layer, bạn chỉ cần nhấp chuột vào biểu tượng con mắt bên trái của layer đó trong 
layer panel. Khi biểu tượng con mắt bị tắt đi, thì layer đó với toàn bộ các điểm ảnh sẽ tạm thời bị 
ẩn đi, bạn và mọi người không thể thấy các hình ảnh thuộc layer đó. 

Nếu bạn bật trở lại biểu tượng con mắt của layer thì layer đó lại hiển thị lại trên cửa sổ hiển thị 
ảnh.

Bạn có thể tắt biểu tượng con mắt của nhiều layer, thậm chí là toàn bộ layer của bức ảnh.

Đôi khi bạn cần quan sát chi tiết một layer và bạn muốn tạm thời ẩn toàn bộ các layer còn lại; để 
thực hiện việc này, bạn chỉ cần nhấn giữ phím Alt trên bàn phím, đồng thời nhấn chuột vào biểu 
tượng con mắt của layer bạn muốn xem. Lúc này chỉ layer mà bạn vừa thao tác còn hiển thị, tất 
cả các layer còn lại sẽ đồng loạt bị ẩn đi và bạn sẽ dễ dàng quan sát các hình ảnh trên layer đó mà 
không bị ảnh hưởng bởi hình ảnh trên các layer còn lại. 

Nếu muốn khôi phục các layer vừa bị ẩn đi, bạn chỉ cần lặp lại thao tác như khi làm ẩn các layer 
đó, thì toàn bộ các layer vừa bị ẩn sẽ được hiển thị trở lại.

  

Lưu ý, thao tác ẩn hiện nhiều layer này chỉ khôi phục những layer nào bị thao tác ẩn layer đó giấu 
đi mà thôi, các layer đã bị ẩn giấu trước đó không thuộc phạm vi khôi phục của thao tác này.

Nhân bản layer

Nếu bạn muốn nhân bản một layer nào đó, đầu tiên bạn cần chọn layer muốn nhân bản, sau đó 
thực hiện theo một trong các cách sau:

•	 Kéo layer được chọn vào biểu trượng tràn giấy trắng dưới đáy Layer pannel
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•	 Vào menu Layer > New > Layer via Copy
•	 Nhấn tổ hợp phím Ctrl+J trên bàn phím 
•	 Click chuột phải vào layer trong Layer pannel, chọn lệnh Duplicate layer trong menu ngữ 

cảnh, khi hộp thoại Duplicate Layer hiện ra, nhấn OK.
•	 Bấm vào mũi tên đen nhỏ góc trên bên phải của Layer pannel, chọn lệnh Duplicate layer 

trong menu ngữ cảnh, khi hộp thoại Duplicate Layer hiện ra, nhấn OK.

Layer được chọn sẽ được nhân bản, thường thì nó sẽ được tự động đặt tên theo tên của layer gốc, 
ví dụ layer chọn nhân bản có tên là Layer 1 thì layer mới nhân bản sẽ có tên là Layer 1 Copy.

Lưu ý: trước phiên bản Adobe Photoshop 8 (hay còn gọi là Adobe Photoshop CS) thì mỗi lần chỉ có 
thể nhân bản được một layer duy nhất. Từ phiên bản CS, bạn có thể chọn nhiều layer và tiến hành 
thao tác nhân bản chúng trong một lần.

Nhân bản layer từ tài liệu này sang tài liệu khác

Thông thường, khi bạn thực hiện thao tác nhân bản một layer thì nó sẽ được nhân bản ngay trong 
tài liệu mà bạn đang mở; tuy nhiên trong các cách nhân bản vừa nêu trên, thì 2 cách cuối cùng cho 
phép bạn chọn nhân bản layer sang một tài liệu khác.

Thao tác nhân bản giống như hướng dẫn ở phần trên, tuy nhiên khi hộp thoại Duplicate Layer hiện 
ra, thay vì nhấn OK thì bạn hãy để ý tới khu vực Destination bên dưới, xổ danh sách Document ra, 
chọn một Document name trong đó - tức là tên một tài liệu hiện đang cùng mở với tài liệu mà bạn 
đang thao tác trong Photoshop hoặc chon New ở dưới cùng của danh sách. Nếu bạn chọn tên một 
tài liệu đang mở, thì thao tác nhân bản sẽ tạo bản sao của layer được chọn vào cửa sổ tài liệu được 
chọn đó, còn nếu bạn chọn New, thì layer nhân bản sẽ được mở trong một tài liệu mới hoàn toàn.

Tìm hiểu về chế độ hòa trộn - Blending Mode - của layer  

Một tính năng cũng rất độc đáo khác bên cạnh các Filter của Photoshop là các chế độ hoà trộn. Sử 
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dụng sáng tạo những chế độ hoà trộn cũng sẽ tạo được những hình ảnh rất đẹp và quyến rũ. Trong 
hầu hết các thao tác ở Photoshop bạn không thể không dùng đến các chế độ hoà trộn, do vậy nó trở 
thành đặc biệt quan trọng và hữu dụng. Biết và hiểu các tính năng của nó sẽ giúp bạn nhiều hơn 
nữa trong công việc của mình.
 
Layer: 
 
Bạn sử dụng các chế độ hoà trộn để xác định những giá trị pixel của một file ảnh trên một layer 
sẽ hoà trộn như thế nào với những pixel trên một layer khác. Bằng cách áp dụng những chế độ 
hoà trộn cụ thể trên từng layer riêng lẻ bạn có thể tạo ra những hiệu ứng đa dạng và đặc biệt.

Những công cụ và chế độ hoà trộn

Bạn cũng có thể tìm thấy chế độ hoà trộn trên thanh Option của mỗi một công cụ riêng lẻ, nó 
kiểm soát những pixel của một file ảnh sẽ bị ảnh hưởng như thế nào bởi các công cụ. Bạn nên 
hiểu những khái niệm sau đây về màu sắc khi thấy những hiệu ứng của chế độ hoà trộn.
 
+ Màu cơ bản - là màu ban đầu của file ảnh 
+ Màu hoà trộn - là màu được thiết lập bởi các công cụ vẽ hoặc những công cụ chỉnh sửa 
+ Màu kết quả - là kết quả từ những chế độ hoà trộn được sử dụng

Tìm hiểu  về các chế độ hoà trộn:
 
Chế độ hòa trộn là một trong những tính năng thú vị nhất của Photoshop, và cũng là khó nắm 
bắt nhất. 

Chế độ Normal

Đây là chế độ mặc định của Photoshop. Không có một hiệu ứng hoà trộn nào được thiết lập khi ở 
chế độ Normal.

Chế độ Dissolve

Chỉnh sửa hoặc vẽ trên từng pixel để tạo ra màu kết quả. Tuy nhiên, màu kết quả là sự thay đổi 
ngẫu nhiên của các giá trị pixel với màu cơ bản hoặc với màu hoà trộn, phụ thuộc vào mức Opac-
ity tại bất cứ vị trí nào của pixel. Chế độ hoà trộn này kết hợp tốt với các công cụ Paintbrush hoặc 
Airbrush và với kích cỡ lớn.
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Chế độ Behind

Chỉnh sửa hoặc vẽ chỉ trên những phần trong suốt của layer. Chế độ này chỉ làm việc duy nhất với 
chức năng Preserve Transparency được tắt và tương tự để vẽ vào phần sau của những vùng trong 
suốt.

Chế độ Clear

Chỉnh sửa hoặc vẽ trên từng pixel để tạo ra trong suốt. Chế độ này chỉ làm việc với Line tool, Paint 
bucket tool, các lệnh Fill và lệnh stroke. Bạn phải tắt chế độ Preserve Transparency để làm việc với 
chế độ này.

Chế độ Multiply

Nó sẽ tìm những thông tin về màu trên từng kênh và nhân đôi màu cơ bản và màu hoà trộn. Màu 
kết quả luôn luôn là một màu tối hơn. Nhân đôi bất cứ màu nào với màu đen sẽ cho kết quả là đen, 
với màu trắng thì kết quả không đổi. Khi bạn vẽ với một màu nào đó mà không phải là hai màu 
trắng và đen, với những nét vẽ liên tục với công cụ Painting sẽ tạo ra một màu tối hơn. Hiệu ứng 
tương tự như khi vẽ trên một file ảnh với chiếc bút thần kỳ đa chức năng.

 
Chế độ Screen

Với Screen nó sẽ tìm từng kênh thông tin màu và nhân với màu ngược lại của màu hoà trộn và màu 
cơ bản. Màu kết quả sẽ luôn luôn là một màu sáng hơn. Nếu bạn thiết lập chế độ Screen với màu 
đen thì màu sẽ không thay đổi, ngược lại, hoà trộn với màu trắng sẽ cho ra màu trắng. Hiệu ứng 
này giống như kiểu chiếu sáng những tấm phim ảnh chồng lên nhau.
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Chế độ Overlay
Nhân đôi hoặc che chắn màu phụ thuộc vào màu gốc. Khi được thiết lập nó sẽ lấy làm mẫu hoặc 
che phủ những giá trị pixel của ảnh nhưng lại bảo tồn những vùng bóng sáng và bóng đen của màu 
gốc. Màu gốc sẽ không bị thay đổi nhưng được trộn lẫn với màu hoà trộn để phản xạ những vùng 
sáng hoặc vùng tối của màu ban đầu.

Chế độ Soft Light
Làm sáng hoặc làm tối màu phụ thuộc vào màu hoà trộn. Hiệu ứng này tương tự như khi ta chiếu 
sáng bằng một cái đèn rọi tán sắc lên một bức ảnh. Nếu màu trộn (ánh sáng nguồn) nhạt hơn 50% 
xám, file ảnh sẽ được làm sáng, như khi nó được Dodge. Nếu màu trộn tối hơn 50% xám, file ảnh 
sẽ bì làm tối đi như khi nó được Burn. Vẽ với màu trắng hoặc đen tuyệt đối sẽ tạo ra một vùng tối 
hoặc sáng khác biệt nhưng kết quả lại không phải là màu đen hoặc trắng tuyệt đối.

Chế độ Hard Light
Hiệu ứng này sẽ nhân đôi hoặc che chắn màu, phụ thuộc vào màu hoà trộn. Hiệu ứng này tương 
tự như khi ta dùng một đèn rọi cực sáng chiếu vào hình ảnh. Nếu màu hoà trộn (ánh sáng nguồn) 
nhạt hơn 50% xám, hình ảnh sẽ được làm sáng như khi nó được áp dụng hiệu ứng Screen.Điều này 
rất có ích khi ta muốn tạo những vùng phản chiếu cho một file ảnh. Nếu màu hoà trộn đậm hơn 
50% xám, nó sẽ có hiệu ứng như Multiplied. Điều này có ích khi ta muốn thêm những vùng phủ 
bóng cho một file ảnh. Tô vẽ với màu đen và trắng tuyệt đối sẽ cho kết quả là đen và trắng tuyệt đối.

Chế độ Color Dodge
Hiệu ứng này sẽ tìm những thông tin màu trên mỗi kênh và làm sáng màu gốc để phản xạ màu hoà 
trộn. Nếu hoà trộn với màu đen sẽ không tạo ra thay đổi gì.



Giáo trình Adobe Photoshop CC 55Created by GiangPM

www.enterfocus.edu.vn

Chế độ Color Burn
Hiệu ứng này sẽ tìm những thông tin màu trên mỗi kênh và làm tối màu gốc để phản xạ màu hoà 
trộn. Nếu hoà trộn với màu trắng sẽ không tạo ra thay đổi gì.

 

 

Chế độ Darken
Hiệu ứng này tìm những thông tin màu trên mỗi kênh và chọn màu gốc và màu hoà trộn (nó sẽ so 
sánh màu nào nào đậm hơn) để làm ra màu kết quả. Những pixel nào nhạt hơn màu hoà trộn sẽ bị 
thay thế và những pixel nào đậm hơn màu hoà trộn sẽ không bị thay đổi.

 

Chế độ Lighten

Hiệu ứng này tìm những thông tin màu trên mỗi kênh và chọn màu gốc và màu hoà trộn (nó sẽ so 
sánh màu nào nhạt hơn) để làm ra màu kết quả. Những pixel nào đậm hơn màu hoà trộn sẽ bị thay 
thế và những pixel nào nhạt hơn màu hoà trộn sẽ không bị thay đổi.

Chế độ Difference
Nó tìm những thông tin màu trên từng kênh và nó sẽ hoặc là bớt đi ở màu hoà trộn từ màu gốc 
hoặc là bớt đi ở màu gốc từ màu hoà trộn, phụ thuộc vào màu nào có giá trị sáng hơn. Trộn với màu 
trắng sẽ đảo ngược giá trị màu gốc; trộn với màu đen sẽ không tao ra thay đổi gì.
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Chế độ Exclusion
Tạo ra hiệu ứng tương tự như Difference nhưng có độ tương phản thấp hơn chế độ Difference. 
Trộn với màu trắng sẽ đảo ngược giá trị của màu gốc. Trộn với màu đen sẽ không tạo ra thay đổi gì.

Chế độ Hue
Tạo ra màu kết quả với độ chói và độ đậm của màu gốc và màu sắc của màu hoà trộn.

Chế độ Saturation
Tạo ra màu kết quả với độ chói và màu sắc của Màu Gốc và độ đậm của màu Hoà Trộn. Tô vẽ với 
chế độ này trong vùng với độ đậm bằng 0 sẽ không tạo ra thay đổi gì.

Chế độ Color
Tạo ra màu kết quả với độ chói của Màu Gốc, màu và độ đậm của màu Hoà Trộn. Hiệu ứng này bảo 
tồn mức độ xám của hình ảnh và hữu ích để tô màu cho những hình ảnh có tính kim loại (Chrome) 
và dùng để tô màu cho hình ảnh.
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Chế độ Luminosity
Cắt toàn bộ giá trị màu của layer, chỉ để lại các giá trị về sáng tối; khi đặt layer này lên trên một layer 
khác, nó sẽ lấy màu của layer bên dưới lên để làm màu của mình.

Điều khiển độ trong đục - Opacity - của layer 

Layer panel ngoài việc hiển thị các layer cùng các điểm ảnh hiển thị trên layer, còn có một chức 
năng điều khiển độ trong đục của layer. Trường Opacity hiển thị tại góc trên bên phải của Layer 
panel, có thể thay đổi giá trị từ 0 - 100. Ở giá trị 0, mọi điểm ảnh trên layer đều trong suốt và không 
thể nhìn thấy; còn ở trị số 100, thì các điểm ảnh ở trạng thái “đục” và không thể nhìn xuyên qua 
để thấy các điểm ảnh nằm ở layer có tầng thứ thấp hơn. Bạn có thể điều khiển trạng thái trong đục 
của một layer bằng cách chọn layer đó, rồi điều chỉnh giá trị opacity của nó.

Canh hàng giữa các Layers

Chọn Layer muốn canh hàng (Layer được chọn sẽ là Layer chuẩn, cố định vị trí, những Layer được 
liên kết với Layer này sẽ phải gióng hàng theo Layer này).

Liên kết các Layer muốn canh hàng với Layer hiện hành. Menu Layer \ Align Linked (Hoặc chọn 
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công cụ Move, sau đó chọn kiểu gióng hàng trên thanh Options): 

Các kiểu gióng hàng:

•	 Align Top Edges: Canh bằng nhau trên đỉnh
•	 Align Vertical Centers: Canh giữa theo phương dọc
•	 Align Bottom Edges: Canh bằng nhau dưới đáy
•	 Align Left Edges: Canh trái
•	 Align Horizontal Centers: Canh giữa theo phương ngang
•	 Align Right Edges: Canh phải

Phân phối đều khoảng cách giữa các Layers (Distribute):

Liên kết các Layer muốn phân phối đều (đối với lệnh này bắt buộc phải có từ ba Layer trở lên) 
Menu Layer\ Distribute Linked (Hoặc chọn công cụ Move, sau đó chọn kiểu gióng hàng trên 
thanh Options)

Lưu ý: Hai layer ngoài cùng sẽ cố định nếu là phân phối đều theo chiều ngang, Layer trên cùng và 
Layer dưới cùng sẽ cố định nếu phân phối đều theo chiều dọc (Lấy tổng khoảng cách của hai Layer 
ngoài cùng chia đều cho các Layer bên trong được Link với nó).
Các kiểu phân phối đều:

•	 Distribute Top Edges: Phân phối đều theo đỉnh Distribute Vertical Centers: Phân phối đều 
theo tâm (tính theo phương dọc)

•	 Distribute Bottom Edges: Phân phối đều theo đáy
•	 Distribute Left Edges: Phân phối đều theo cạnh trái
•	 Distribute Horizontal Centers: Phân phối đều theo tâm (tính theo phương ngang)
•	 Distribute Right Edges: Phân phối đều theo cạnh phải.

Lồng ghép các layer với nhau

Điều kiện là cần có 2 layer nằm sát nhau trong Layer Panel, thường thì layer phía trên có kích thước 
lớn hơn so với layer bên dưới và khi tiến hành lồng ghép (hay còn gọi là bọc vào nhau) thì layer 
phía trên sẽ bọc lấy layer phía dưới, phần diện tích lớn hơn của layer trên sẽ tạm thời bị ẩn đi, và 
chỉ còn thấy layer trên qua hình dạng và diện tích của layer dưới.

Thao tác thực hiện: 

•	 Chọn 2 layer muốn lồng ghép với nhau tương tự như diến giải ở phần trên.
•	 Click chuột chọn layer nằm trên, vào menu Layer> Create Cliping Mask (Ctrl+Alt+G)
•	 Thao tác bằng chuột, bạn nhấn giữ phím Alt, trỏ chuột vào ranh giới giữa 2 layer và click.
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2 layer sẽ được lồng ghép với nhau, với họa tiết và màu sắc là của layer bên trên, còn vị trí, hình 
dáng, diện tích của layer dưới. Trong Layer Panel, bãn sẽ thấy layer phía trên trong trường hợp 
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này nằm thụt vào phía phải một chút so với các layer khác, đồng thời có dấu hiệu một mũi tên trỏ 
xuống laye ngay bên dưới nó để giải thích nó được lồng ghép - hay bọc vào layer bên dưới.

Gỡ bỏ thao tác lồng ghép layer:

•	 Muốn gỡ bỏ lồng ghép layer, bạn cần chọn layer đã lồng ghép trong Layer Panel, tiếp đó vao 
menu Layer> Release Cliping Mask (Ctrl+Alt+G)

•	 Hoặc thao tác bằng chuột thì bạn chỉ việc giữ Alt, trỏ vào ranh giới giữa 2 layer đã lồng ghép 
và click là 2 layer sẽ gỡ rời ra như ban đầu.

Ví dụ ta cho một layer chứa quả dưa bên trên, bọc vào layer chứa cái mũ bên dưới, sau khi thực hiện 
xong, thì layer chứa quả dưa gần như biến mất, chỉ còn thấy một phần giống như hình layer chứa 
cái mũ bên dưới mà thôi. 

Các trường hợp phát sinh Layers

•	 Khi ta copy một vùng chọn bằng lệnh Edit \ Copy (Ctrl+C) rồi dùng lệnh Edit \ Paste 
(Ctrl+V) thì sẽ xuất hiện một Layer mới.

•	 Khi ta chọn một vùng chọn (trên background hoặc Layer hình ảnh bất kỳ), bấm Ctrl + J à 
Nhân đôi hình ảnh bên trong vùng chọn lên một Layer mới với vị trí tương đối không thay 
đổi.

•	 Khi dùng công cụ Type (T) để nhập văn bản lên một hình ảnh thì trên cửa sổ này sẽ xuất 
hiện một Layer Text mới.

•	 Khi ta dùng lệnh File\Place để đặt một hình ảnh đã được vẽ dưới dạng AI hay EPS lên một 
cửa sổ hình ảnh thì trên cửa sổ này dùng công cụ Move (V) di chuyển vùng chọn hoặc toàn 
bộ hình ảnh từ tập tin A sang tập tin B thì trên tập tin B sẽ xuất hiện một Layer mới.

•	 Khi ta sao chép nội dung sẽ xuất hiện một Layer mới.
•	 Khi sử dụng công cụ shape layer để vẽ đối tượng.
•	 Nhấp vào biểu tượng new Layer trên Palette Layer hoặc vào menu Layer \ New \ Layer 

(Ctrl+ Shift+N)
•	 Nhấn tổ hợp phím nóng (Ctrl+Alt+Shift+N)
•	 Chọn công cụ Move, bấm Alt và Kéo trỏ chuột trực tiếp lên đối tượng…

Các chức năng của menu Palete Layer

•	 New Layer: tạo lớp mới
•	 Duplicate Layer: nhân đôi lớp mới
•	 Delete Layer: xóa lớp
•	 Delete Linked Layers: xóa các lớp được liên kết
•	 Delete Hidden Layers: xóa các lớp đã ẩn
•	 Merge Linked: gộp các lớp đang được liên kết thành một lớp
•	 Merge Down: gộp lớp đang chọn với lớp bên dưới
•	 Merge Visible: gộp tất cả các lớp đang hiển thị
•	 Flatten Image: làm phẳng lớp (Gộp tất cả các lớp lại thành 1 lớp background)
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Quản lý layer theo nhóm Group

Photoshop cung cấp môi trường làm việc theo layer thực sự là một cách làm việc tiện lợi, tuy nhiên 
nếu bức ảnh hay bản thiết kế của bạn chứa quá nhiều layer thì quá trình làm việc cũng có chỗ bất 
tiện do phải kéo lên kéo xuống thanh Scroll của Layer pannel để tìm tới layer bạn cần; do đó Pho-
toshop cung cấp cho bạn một cách thức quản lý và làm việc theo nhóm layer.

Để đưa một số layer được lựa chọn vào một Group, trước hết bạn cần chọn các layer có liên quan 
tới nhau bằng cách nhấn giữ phím Ctrl, sau đó click lần lượt vào các layer cần chọn trong Layer 
pannel. Sau khi chọn được toàn bộ các layer mà bạn muốn, vào menu Layer > Group layer (Ctrl+G) 
để đưa tất cả các layer đó vào trong một Group.

          

          

Sau khi thực hiện lệnhp Grou, các layer được chọn sẽ tự động chui vào trong một Group mới tạo ra 
trong Layer pannel. Rất dễ nhận ra các layer trong Group vì chúng sẽ nằm dưới Group, và tụt vào 
một khoảng so với các layer thông thường khác. 

Với dạng Group này, việc quản lý, phân nhóm chức năng các layer trở nên dễ dàng hơn; muốn tạm 
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ẩn, di chuyển, đổi tầng thứ hay gán các Layer Style cho các layer con trong nhóm Group thì bạn 
chỉ cần thao tác trên Folder Group mà thôi. Để tiện quản lý và thao tác, bạn có thể đổi tên cho các 
Folder Group này bằng cách nhấp đúp vào  tên của Folder Group và đặt tên mới, sao cho biểu hiện 
được chức năng của Group.

Muốn loại bỏ một layer bất kỳ ra khỏi Group, bạn chỉ cần click chọn layer đó, rồi nhấp chuột, kéo 
layer đó ra khỏi Group là layer đó lại trở về là một layer thông thường.

Tự động gióng hàng cho các layer - Auto align Layer

Chế độ gióng hàng tự động được sử dụng để gióng hàng cho các layer khác nhau nhưng có một 
phần hình ảnh giống nhau nhằm kết hợp chúng thành một chỉnh thể hình ảnh hoàn chỉnh. Đây là 
công cụ  Adobe Photoshop cung cấp để bạn ghép các bức ảnh chụp theo kiểu Panorama.

Trong ví dụ sau, tôi sử dụng một số bức ảnh tự chụp từ điện thoại di động, và chụp theo kiểu  
panorama. Trong thư mục có chứa 6 tấm ảnh, bạn hãy chọn và mở cả 6 tấm ảnh trong Photoshop. 
Sử dụng phương pháp nhân bản layer từ tài liệu này sang tài liệu khác để đưa nội dung 5 tấm ảnh 
vào trong tấm ảnh đầu tiên làm thành 5 layer mới trong đó.

Trong Layer Panel, lúc này có 6 layer lần lượt có tên là Background, Background copy, Background 
copy 2, Background copy 3, Background copy 4 và Background copy 5. Chọn toàn bộ các layer này 
bằng cách giữ phím Shift, lần lượt click chọn các layer trong Layer Panel. Sau khi toàn bộ các layer 
đã được chọn, click chọn công cụ Move.

Trên thanh Options, bạn click chọn biểu tượng Auto Align Layers  một hộp thoại sẽ hiện ra, 
bạn hãy chọn lấy một kiểu gióng hàng được cung cấp trong đó. Nhấn OK để Photoshop tự động 
gióng hàng các layer 
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Chế độ Auto:
Photoshop sẽ tự động phân tích ảnh gốc và tự áp dụng một trong hai kiểu kết hợp là Perspective 
hoặc Cylindrical, tùy theo mỗi hình ảnh được chọn.

Chế độ Perspective:
Photoshop sẽ lựa chọn một hình ảnh trong nhóm các layer được chọn làm một hình ảnh chuẩn, 
những hình ảnh trên các layer khác sẽ được biến dạng sao cho khớp với bức ảnh chuẩn được nó 
lựa chọn.
 
Chế độ Cylindrical:
Giúp giảm bớt sự biến dạng trên hình ảnh khi kết hợp với nhau bằng cách thể hiện mỗi bức ảnh 
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riêng lẻ như một dạng hình trụ hơi loe ra, phần chồng lấn lên nhau sẽ khớp với nhau. Bức ảnh 
được cọn làm chuẩn sẽ đặt giữa khung hình. Đây là sự lựa chọn tốt nhất cho việc ghép thành một 
bức ảnh Panorama.

Chế độ Reposition Only: 
Cho phép kết nối các phần hình ảnh trên các layer thành một bức hình hoàn chỉnh bằng cách di 
chuyển vị trí thích hợp cho các layer mà không áp dụng bất cứ phép biến đổi nào.

Sau khi được gióng hàng tạo thành một khung hình Panorama, việc cuối cùng của bạn là cắt cúp và 
ép các layer thành một layer duy nhất bằng cách tạo vùng chọn cho khung hình, vào menu Image> 
Crop để xén bức ảnh thành khung hình vuông vắn rồi nhấn tổ hợp Ctrl+Shift+E để ép các layer 
thành một layer duy nhất.

Tất nhiên nếu muốn cho hình ảnh trở nên hoàn hảo, bạn còn cần sử dụng thêm các công cụ và lệnh 
chỉnh màu sắc, độ sáng ... thêm nữa.

Tự động gióng hàng cho các layer bằng lệnh Photomerge

Với cách vừa trao đổi, người sử dụng đã có thể ghép ảnh panorama, tuy nhiên, đây chưa phải là 
cách tốt nhất mà Photoshop cung cấp. Bạn có thể sử dụng một phương pháp có tính tự động cao 
hơn và kết quả cũng tốt hơn bằng cách sử dụng lệnh như sau: File> Automate> Photomerge

Sau khi chọn lệnh, hộp thoại Photomerge mở ra, trong trường Use, chọn File; tiếp theo nhấn vào 
nút Browse để mở danh sách và chọn ảnh muốn ghép, nhấn OK sau khi chọn xong. Chọn một 
trong các chế độ Auto,  Perspective, Cylindrical ... tương tự như trong hướng dẫn trước nếu muốn. 
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Lưu ý trong hộp thoại này có một checkbox được đánh dấu sẵn là Blend Image Together, chế độ này 
sẽ giúp hòa trộn và xử lý sự khác biệt về ánh sáng, màu sắc ở các tấm ảnh khác nhau khi ghép cùng 
nhau (vùng đánh dấu đỏ trong ảnh). Photoshop đã sử dụng kỹ thuật che chắn ảnh bằng Mặt nạ để 
ghép các biên ảnh với nhau, kỹ thuật này chúng ta sẽ đề cập cụ thể trong phần Mặt nạ. Cuối cùng 
nhấn OK và để Photoshop tự động xử lý và trả kết quả, việc của bạn chỉ là Crop ảnh cho vuông vắn.

 
Gán hiệu ứng Layer style cho layer
 
Photoshop cung cấp cho bạn một dạng hiệu ứng gọi là Layer Style để gán cho layer nhằm làm tăng 
hiệu quả thể hiện của layer.
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Layer Style rất dễ sử dụng, dễ chỉnh sửa, có thể gán nhiều Layer Style khác nhau cho một layer, có 
thể ẩn hay hiện Layer Style của một layer, có thể copy Layer Style của layer này rồi paste cho layer 
khác, có thể tách Layer Style của một layer ra thành dạng các layer độc lập. 

Đặc biệt, nếu bạn làm việc với dạng Group trên Layer Panel thì toàn bộ các layer con thuộc Group 
sẽ cùng được gán chung một Layer Style nếu Layer Style đó được gán cho Group.

Ngoài ra Layer Style còn khả dụng khi được gán cho một số dạng thức layer đặc biệt như Smart 
Object hay Shape Layer, hoặc Text Layer.

Thao tác thực hiện: Có nhiều cách mở bảng Layer Style

•	 Nhấp hai lần vào Layer muốn tạo hiệu ứng
•	 Kích phải mouse lên Layer muốn tạo hiệu ứng\ Blending Options
•	 Kích biểu tượng  ở góc dưới trái của palette Layer\ Chọn kiểu hiệu ứng
•	 Menu Layer\ Layer Style\ Blending Options…

Hiệu ứng tạo bóng đổ - Drop shadow

•	 Mode: các chế độ hòa trộn của hiệu ứng
•	 Opacity: độ trong suốt của hiệu ứng
•	 Use Global Angle: ta chỉ cần thay đổi góc xoay của một hiệu ứng thì tất cả góc quay của hiệu 

ứng khác cũng thay đổi theo, khi tùy chọn này được chọn
•	 Distance: khoảng cách của hiệu ứng đối với vật thể
•	 Spread: độ thắt (căng) của bóng
•	 Size: độ lớn của bóng, bóng càng lớn thì càng nhòe và có độ chuyển mềm
•	 Contour: kiểu viền của bóng
•	 Noise: tạo nhiễu hạt
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Chưa có hiệu ứng Sử dụng hiệu ứng Drop Shadows

Chưa có hiệu ứng Sử dụng hiệu ứng Inner Shadows
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Outer Glow  

Hiệu ứng bóng quầng màu bên ngoài

Chưa có hiệu ứng Sử dụng hiệu ứng Outer Glow

 

Blend Mode:
•	 Nếu chọn màu tối thì Blend Mode nên chọn Multiply mới thấy rõ
•	 Ngược lại nếu chọn màu sáng thì Blend Mode nên chọn Screen hoặc Highlight thì sẽ thấy rõ hơn.
•	 Opacity: độ đậm nhạt của ánh sáng
•	 Noise: nhiễu hạt, khuyếch tán

  Màu của quầng sáng (Màu đồng nhất)

  Quầng sáng màu chuyển sắc.
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Technique:

•	 Softer: dịu, lan tỏa
•	 Precise: chính xác
•	 Spread: độ căng của quầng sáng
•	 Size: độ lan tỏa của quầng sáng

 

•	 Contour: kiểu viền của quầng sáng 
•	 Range: phạm vi lan tỏa
•	 Jitter: có hiệu quả với kiểu phát sáng màu Gradient

Inner Glow 
Hiệu ứng bóng quầng màu bên trong

Chưa có hiệu ứng Sử dụng hiệu ứng Inner Glow

Bevel and Emboss 
Hiệu ứng chạm nổi và vát cạnh.
 
Style:

•	 Outer Bevel: hiệu ứng cạnh xiên bên ngoài
•	 Inner Bevel: hiệu ứng cạnh xiên bên trong
•	 Emboss: hiệu ứng chạm nổi 
•	 Pillow Emboss: hiệu ứng chạm nổi khắc xuống
•	 Stroke Emboss: chạm nổi cho đường viền (phải đánh dấu vào checkbox Stroke mới thấy được kiểu này)

Technique:

•	 Smooth: khối không sắc cạnh, trơn, nhẵn.
•	 Chisel Hard: khối gắt cạnh 1 chiều
•	 Chisel Soft: khối gắt cạnh hai chiều 
•	 Depth: độ sâu của khối
•	 Direction: hướng của khối

		  - Up: lên
		  - Down: xuống
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•	 Size: độ lớn của khối
•	 Soften: độ mềm mại của khối, khối bo tròn.
•	 Angle: hướng của khối
•	 Gloss Contour: kiểu bóng của khối
•	 Higlight:

-	 Mode: các chế độ hòa trộn của highlight (phần sáng)
-	 Opacity: độ trong suốt của highlight

•	 Shadow:
-	 Mode: các chế độ hòa trộn của bóng
-	 Opacity: độ trong suốt của bóng

 

Contour: viền cho khối

Texture: Chất liệu lồng bên trong hiệu ứng
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Chưa có hiệu ứng
 

Bevel and Emboss
Style: Inner Bevel
Depth =100
Size = 11
Soften = 4
Angle = 90
Altitude = 67

Bevel and Emboss 
Color Overlay (đỏ)

Bevel and Emboss 
Color Overlay (đỏ)
Drop shadows

Bevel and Emboss 
Color Overlay (đỏ)
Drop shadows
Inner Shadows

Bevel and Emboss 
Color Overlay (đỏ)
Drop shadows
Inner Shadows
Outer Glow

Bevel and Emboss 
Color Overlay (đỏ)
Drop shadows
Inner Shadows
Outer Glow
Inner Glow

Satin: 

Hiệu ứng tạo độ trơn láng, bóng nước
•	 Opacity: độ đậm màu sáng
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•	 Angle: góc xoay hướng
•	 Distance: khoảng cách màu Satin đến đối tượng 
•	 Size: độ lớn của bóng
•	 Contour: chọn kiểu bóng

 

Ví dụ 1:

Chưa có hiệu ứng

Drop Shadows

-  Drop Shadows
- Bevel and Emboss (Inner Bevel + 
Gloss contour = Ring – Double)
-  Drop Shadows
- Bevel and Emboss (Inner Bevel + 
Gloss contour = Ring – Double)
-  Satin: 
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Ví dụ 2:

Chưa có hiệu ứng

Bevel and Emboss

Bevel and Emboss Satin:

Color Overlay: 
Hiệu ứng phủ một lớp màu lên đối tượng

 

•	 Chọn màu để hòa trộn
•	 Opacity: độ trong suốt của màu phủ.

Gradient Overlay: 

Hiệu ứng phủ một lớp Gradient lên đối tượng 

Style: kiểu hòa trộn

•	 Linear: hòa trộn trực tiếp (thẳng)
•	 Radial: tỏa tròn
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•	 Angle: tỏa tròn kiểu hình nón
•	 Reflected: phản chiếu
•	 Diamond: tỏa vuông như ánh kim cương

-	 Angle: góc xoay hướng tô
-	 Scale: co giãn vùng màu chuyển

Ví dụ 1:

Chưa có hiệu ứng

Gradient Overlay

Gradient Overlay
Drop Shadow

Gradient Overlay
Drop Shadow
Stroke

Gradient Overlay
Drop Shadow
Stroke
Inner shadow

Ví dụ 2:

Chưa có hiệu ứng

Gradient Overlay

Gradient Overlay
Bevel and Emboss (Inner Bevel, gloss 
contour = ring – double)

Gradient Overlay
Bevel and Emboss (Inner Bevel, gloss 
contour = ring – double)
Stroke:
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Pattern Overlay: 
Hiệu ứng phủ một lớp Pattern lên đối tượng

•	 Chọn mẫu Pattern
•	 Snap To Origin: đúng vật liệu gốc
•	 Scale: co giãn vật liệu

Chưa có hiệu ứng

Pattern Overlay

Pattern Overlay
Drop Shadows

Pattern Overlay
Drop Shadows
Bevel and Emboss

Stroke
Hiệu ứng tạo viền cho đối tượng trên layer

•	 Size: Kích thước đường viền
•	 Position:

-	 Outsize: đường viền hướng bên ngoài đối tượng
-	 Insize: đường viền hướng bên trong đối tượng
-	 Center: đường viền phát triển từ giữa biên đối tượng

•	 Opacity:  độ trong suốt của đường viền
•	 Fill Type: các kiểu tô đường viền

-	 Color: Màu thuần
-	 Gradient: Màu chuyển sắc
-	 Pattern: Mẫu tô chất liệu
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Chưa có hiệu ứng
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Làm việc với Style Panel

Adobe Photoshop cung cấp cho người dùng một cách tiếp cận nhanh với Layer Style bằng Style 
Panel.
Style Panel là một dạng khuôn mẫu tạo sẵn, giúp người dùng có thể áp dụng nhanh các Layer Style cho các 
layer hay các dạng đối tượng đặc biệt như Text, Shape Layer, hoặc Smart Object. Khi sử dụng, bạn chỉ việc 
gọi Style Panel bằng cách vào menu Window > Style, khi Style Panel mở ra, bạn chọn một layer hoặc một 
đối tượng muốn gán Style rồi nhấn vào một trong các biểu tượng trong Style Panel là xong.

Style thực chất là Layer Style đã được áp dụng cho một thiết kế, có thể là một Layer Style đơn giản, 
cũng có khi là một tổ hợp phức tạp nhiều Layer Style được ghi lại vào Style Panel giúp cho ngwwoif 
sử dụng dễ dàng tái sử dụng các hiệu ứng đã sử dụng của các phiên làm việc trước đó; hoặc giúp 
cho người chưa có nhiều kiến thức cũng có thể thực hiện được những hiệu ứng phức tạp bằng cách 
áp dụng các Style do người khác tạo sẵn.

 
Để tạo mới một Style trong Style Panel, bạn cần chọn một layer hay đối tượng đã được gán Layer 
Style, vào menu Window mở cửa sổ Style, nhấp vào biểu tượng Create new style và đặt tên cho style 
mới , sau đó nhấn OK. Một Style mới đã được tạo.

Style vừa được tạo sẽ nằm trong Style Panel hiện hành và nằm ở vị trí cuối cùng.

Style được chia ra nhiều mục khác nhau tương ứng với nhiều mục đích như áp dụng cho Text, cho 
Image, cho Photo... chứa trong các thư viện Style. 

Để gọi một thư viện Style, bạn nhấn vào mũi tên nhỏ trên góc phải của Style Panel, khi danh sách 
xổ ra, chọn lấy một thư viện và click vào để gọi nó.
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Minh họa về gán Style

Đối tượng text trước khi được gán Style

Đối tượng text sau khi được gán Style
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TÌM HIỂU VÀ LÀM VIỆC VỚI SMART OBJECT

Smart Object là một dạng thức layer đặc biệt, xuất hiện từ các phiên bản Adobe Photoshop CS, 
dạng thức này không có ở các phiên bản Adobe Photoshop 7 về trước. Trường hợp một file ảnh 
PSD có chứa dạng thức layer Smart Object được mở bằng các phiên bản Adobe Photoshop 7 trở về 
trước thì layer dạng Smart Object này sẽ tự động được Rasterize thành layer dạng điểm ảnh.

Smart Objects là một dạng Layer đặc biệt, chứa dữ liệu hình ảnh dạng Raster hay dạng Vector, chẳng 
hạn như các tập tin Photoshop hay Illustrator. Smart Objects bảo tồn nguồn nội dung của hình 
ảnh với tất cả các đặc điểm ban đầu của nó, cho phép bạn thực hiện những chỉnh sửa không phá 
hủy lớp.

Bạn có thể tạo các Smart Objects bằng cách sử dụng một số phương pháp như cách sử dụng lệnh 
Open As Smart Object, lệnh Place, Paste dữ liệu từ Illustrator, hoặc chuyển đổi một hoặc nhiều  
layer Photoshop thành Smart Objects.

Chọn layer muốn Convert thành 
dạng Smart Object

Click chuột phải vào layer, khi 
menu ngữ cảnh hiện ra,  

chọn Convert to Smart Object

Layer được chọn sẽ chuyển thành 
dạng Smart Object (chú ý dấu 
hiệu phía dưới bên phải của 

thumbnail)
Với các Smart Objects, bạn có thể: 

Thực hiện các biến đổi không phá hủy. Bạn có thể thay đổi kích thước - resize, xoay - rotation, kéo 
xiên - skew, bóp méo - distort, biến đổi theo phối cảnh - perspective transform, hoặc làm biến 
dạng cong một lớp - warp a layer mà không làm mất dữ liệu hình ảnh bản gốc hoặc chất lượng bởi 
vì các biến đổi không ảnh hưởng đến dữ liệu gốc.

Điểm dễ thấy nhất của Smart Object chính là bạn có thể phóng to thu nhỏ, thay đổi kích thước của 
một layer dạng Smart Object một cách thoải mái mà không sợ bị suy giảm chất lượng hình ảnh.
Chúng ta cùng là một ví dụ để chứng minh tính ưu việt của Smart Object so với layer điểm ảnh 
thông thường trong thao tác resize layer.
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Mở bức ảnh FreeTransform.psd. Bức ảnh này có 2 layer, một là Background, một là Jump! 

Chọn layer Jump. Nhấn Ctrl+J để nhân bản nó thành layer Jump! copy
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Trong Layer Panel (nếu chưa mở thì bạn nhấn F7 để gọi), nhấp chuột phải chọn layer Jump Copy, khi menu 
ngữ cảnh mở ra, bạn chọn lệnh Convert to Smart Object để biển layer Jump Copy thành dạng Smart Object.

Giữ Ctrl và nhấn chọn cả 2 layer Jump! và Jump! copy, sau đó nhấn Ctrl+T để gọi lệnh Free Transform
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Giữ phím Shift, đặt trỏ chuột vào 1 trong 4 góc của Handle điều khiển rồi rồi kéo vào tâm để thu nhỏ cả hai 
layer lại, càng nhỏ càng tốt. Nhả phím chuột để hoàn thành thao tác này.

Tiếp theo lại nhấn Ctrl+T lần nữa và thao tác ngược lại so với bước trước, có nghĩa là kéo và phóng to trở lại 
cả 2 layer Jump! và Jump! copy
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Sau khi đã phóng to trở lại cả 2 layer, bạn nhấn chuột vào vùng trống màu xám bất kỳ trong Layer Panel để bỏ 
chọn cả 2 layer. Chọn layer Jum!copy rồi từ từ  kéo nó chuyển dịch để có thể nhìn thấy layer Jump! bên dưới.  

Lúc này chúng ta đã thấy rõ ràng layer điểm ảnh sau khi bị thu nhỏ lại rồi lại bị phóng to lên thì suy giảm 
chất lượng một cách rõ rệt, còn layer dạng Smart Object thì vẫn rõ ràng như cũ.
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Bạn đưa bất cứ công cụ gì lên trên một layer dạng Smart Object thì công cụ đó đều hiện lên biển 
cấm không cho thao tác giống như trên một layer dạng điểm điểm ảnh.

Các công cụ không thể thao tác bình thường trên Smart Object
Nếu bạn vẫn muốn chỉnh sửa một Smart Object, bạn cần thực hiện theo các bước sau:

•	 Click chuột phải vào Layer Smart Object trên Layer Panel, khi menu ngữ cảnh hiện ra, chọn 
Edit content 
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•	 Sẽ có một hộp thoại hiện ra, nhắc nhở sau khi thực hiện việc chỉnh sửa, chọn File > Save để 
cập nhật các chỉnh sửa vào Smart Object. Nếu bạn không muốn hộp thoại này hiện lên nữa, 
click chọn vào checkbox Don’t show again ở phía dưới, bên trái của hộp thoại. Nhấn OK để 
đóng hộp thoại này lại. 

•	 Một cửa sổ ảnh mới được mở ra, chứa nội dung của layer Smart Object. Lưu ý tên của tài 
liệu này là dạng.psb - một dạng trích xuất  từ Smart Object.

•	 Tại cửa sổ mới mở này, bạn có thể thực hiện mọi thao tác cũng như sử dụng mọi công cụ để 
chỉnh sửa như trong một layer điểm ảnh thông thường. 

•	 Sau khi bạn tiến hành chỉnh sửa, đóng cửa sổ  mới lại, sẽ có một hộp thoại mở ra hỏi bạn có 
muốn lưu các thay đổi không, chọn Yes.

Tại cửa số gốc, layer Smart Object sẽ cập nhật đầy đủ các thao tác chỉnh sửa bạn vừa thực hiện.

Để xuất đối tượng Smart Object thành một tài liệu mới, bạn click chuột phải vào đối tượng Smart 
Object, khi menu ngữ cảnh mở ra, chọn Export Contents. Đối tượng dạng Smart Object sẽ được 
xuất thành một tài liệu có dạng đuôi là .psb tài liệu này có thể mở dễ dàng trong Photoshop từ 
phiên bản CS2 tới phiên bản hiện tại là CC.

Dạng tài liệu xuất ra từ Smart Object sẽ có đuôi là dạng .psb thay vì .psd thông thường



Giáo trình Adobe Photoshop CC 87Created by GiangPM

www.enterfocus.edu.vn

Bạn còn có thể thay thể nội dung của Smart Object bằng cách chọn lệnh Replace Content trong 
menu ngữ cảnh. Khi hộp thoại mở ra, hãy chọn 1 ảnh muốn dùng để thay thế, nhấn OK. Nội dung 
của bức ảnh mới sẽ chui vào thay thế cho nội dung của Smart Object mà bạn đang chọn.

Để đưa một Smart Object về thành dạng layer điểm ảnh thông thường, bạn click chuột phải vào nó, 
chọn lệnh Rasterize Layer để biến Smart Object thành layer điểm ảnh thông thường.



Giáo trình Adobe Photoshop CC 88 Created by GiangPM

www.enterfocus.edu.vn

CHƯƠNG III: CÁC CÔNG CỤ - LỆNH CHỈNH SỬA ẢNH

Nhóm công cụ thứ 2 trong hộp công cụ gồm các công cụ chuyên sử dụng để tô vẽ và chỉnh sửa ảnh. 
Nhóm này bao gồm các công cụ sau:

Hộp thoại Brush

Hộp thoại Brush (trên thanh Option) là nơi thể hiện kích thước và các dạng đầu Brush khác nhau 
cho các công cụ vẽ và chỉnh sửa như Brush, Eraser, CloneStamp, Healing Brush, Smudge…

Các dạng Brush mặc định 

Mặc định cho hộp Brush Brush là một số các dạng Brush vẽ có kích cỡ và nét Brush cứng, mềm 
khác nhau.
 
Thư viện lưu trữ các Brush vẽ 

Ngoài các dạng Brush vẽ mặc định, Photoshop còn có một số thư viện Brush khác. Để tải các Brush 
vẽ này, ta chọn Menu Brush palette chọn lệnh Load Brush và theo đường dẫn sau:
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•	 C > Program file > Adobe > Photoshop CS5 > Preset. Brush > *.ABR.
•	 Hoặc chỉ cần vào Menu Brush palette và chọn thư viện Brush muốn load ở phần cuối của 

bảng (Assorted Brushes …Wet Media Brushes). Khi chọn một trong các thư viện Brush này 
các bạn sẽ thấy xuất hiện một câu thông báo:

•	 OK: Thư viện Brush mới sẽ thay thế thư viện Brush mặc định. 
•	 Append: Vẫn giữ lại hộp Brush hiện hành, thư viện Brush mới sẽ được ghi nối vào phía sau 

thư viện hiện hành.

Tự tạo Brush mới:

Dùng công cụ chọn vùng hình chữ nhật (Feather=0) và rê chọn một vùng hình ảnh muốn tạo Brush 

Chọn Menu Edit\ Define Brush. Đặt tên Brush và nhấp Ok, Brush mới sẽ được cập nhật vào cuối 
thư viện Brush hiện hành.

Các lệnh trong Menu Brush Palette 

•	 New Brush Preset: tạo một Brush vẽ mới 
•	 Rename Brush: đổi tên cũ của Brush đang chọn sang tên mới
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•	 Delete Brushes: xóa bỏ Brush vẽ đang chọn.
•	 Reset Brushes: trả lại chế độ mặc định cho hộp Brushes
•	 Load Brushes: nhập Brush vẽ khác
•	 Save Brushes: lưu các Brush hiện hành thành file *.ABR
•	 Replace Brushes: thay nét Brush hiện hành có trong Brushes thành dạng Brush khác

Ngoài ra, ta còn có thể xác lập một số tùy chọn khác cho từng nét Brush bằng cách kích biểu tượng 

Toggle the Brushes Palette  (ở trên bảng Options) để thay đổi các hiệu ứng trên nét Brush.

•	 Brush Tip shape: ấn định tùy chọn cho Brush vẽ:

-	 Master Diameter: kích cỡ Brush vẽ
-	 Use sample Size: sử dụng lại nét Brush vẽ ban đầu.
-	 Angle: góc lệch so với phương ngang của độ dài Brush vẽ hình Ellip
-	 Roundness: độ bo tròn của đầu Brush (100%: tròn, <100%: ellip)
-	 Hardness: độ sắc nét của nét Brush.
-	 Spacing: khoảng cách giữa các đầu Brush trong một nét vẽ.

•	 Shape Dynamics: các kiểu tùy chọn khác của nét Brush (Control: Fade, Pen pressure,…) 
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•	 Scattering: xác định độ phân tán, chi phối số lượng và vị trí hạt phun trên nét vẽ.
•	 Texture: áp dụng mẫu họa tiết kết cấu vào nét vẽ
•	 Dual Brush: sử dụng hai đầu Brush để tạo ra những nét vẽ. Ta xác định những tùy chọn cho 

đầu Brush thứ nhất với “Brush Tip Shape” và xác định cho đầu Brush thứ hai bắng “Dual 
brush”.

•	 Color Dynamics: quản lý việc thay đổi màu sắc trên đường đi của nét vẽ.
•	 Other Dynamics: dùng để tô màu trên đường đi của nét vẽ.
•	 Noise: tạo hiệu ứng hạt xung quanh nét Brush mềm biên.
•	 Wet Edges: sử dụng đường viền nét vẽ màu nước.
•	 Shape Dynamics: thay đổi hình dáng nét Brush vẽ.
•	 Airbrush: tạo hiệu ứng màu phun
•	 Smoothing: tạo ra nét vẽ trơn
•	 Protect texture: áp đặt cùng một loại họa tiết cho các đầu Brush khác nhau để đảm bảo tính 

đồng nhất.

Nhóm Công cụ Brush

Công cụ Brush   

Là công cụ tô vẽ bằng màu Foreground với nét Brush mờ dịu (hoặc nét Brush cứng).

•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau (thư viện nét Brush)
•	 Mode: các chế độ hoà trộn của Brush Brush
•	 Opacity: độ trong suốt màu của Brush vẽ
•	 Flow: áp lực phun màu của công cụ (giá trị càng lớn màu phun ra càng nhiều). 

Muốn vẽ đoạn thẳng: Kích xác định điểm thứ nhất, nhả mouse, bấm giữ Shift và tiếp tục kích xác 
định điểm thứ hai.

Một số nét Brush Brush tiêu biểu:

Đầu Brush mền (nhòe biên)

Đầu Brush cứng (sắc biên)

Đầu Brush vuông (Spacing lớn)

Đầu Brush mền (kết hợp Fade)

Đầu Brush đặc biệt (special effects)
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Công cụ Pencil  

Dùng để vẽ nét sắc, mảnh

•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau (chỉ sử dụng đầu Brush cứng).
•	 Mode: các chế độ hòa trộn 
•	 Opacity: xác định độ trong suốt của Brush
•	 Auto Erase: nếu vẽ trên vùng có cùng màu với màu Foreground thì nét vẽ sẽ có màu cùng 

với màu Background. Nếu vẽ trên vùng không cùng màu với hộp Foreground thì nét vẽ có 
màu của Foreground.

Nhóm công cụ Eraser  
Dùng để tẩy xóa các vùng hình ảnh mà bạn không muốn tồn tại trên bức ảnh.

Thao tác thực hiện:

Công cụ Eraser 
Chọn công cụ Eraser, kích và rê chuột tự do lên vùng hình ảnh mà bạn muốn xóa bỏ. 

Lưu ý, khi bạn tẩy trên Background layer, thì thay vì xóa bỏ các điểm ảnh, Erase tool sẽ dùng màu 
trong ô Background để phủ lên vùng mà bạn tẩy. 

Muốn tẩy mất hoàn toàn các điểm ảnh trong trường hợp này, bạn cần đổi tên Background layer 
thành Layer 0. (Xem lại thao tác trong phần Thay đổi tầng thứ cho Layer) 

 
Các Options của công cụ Erase:

•	 Mode: lựa chọn kiểu tẩy theo 3 dạng:
-	 Brush: tẩy xóa hình ảnh với biên vùng xóa mềm hoặc sắc cạnh.
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-	 Pencil: tẩy xóa hình ảnh với con trỏ hình tròn, biên vùng xóa sắc cạnh.

-	 Block: tẩy xóa hình ảnh với con trỏ hình vuông, biên vùng xóa sắc cạnh.

•	 Opacity: Cường độ vết tẩy 
•	 Eraser to History: Lấy lại điểm ảnh gốc ban đầu. 

Công cụ Background Eraser Tool 

Chuyên dùng trong trường hợp hậu cảnh có hình và màu phức tạp, đan xen liên tục vào nhau. Khi 
gặp trường hợp này, bạn cần tới sự trợ giúp của công cụ tẩy nền Background Erase vì công cụ này 
có một hình chữ thập nằm ở tâm của đầu tẩy, khi click chuột vào vùng ảnh cần xóa bỏ nền, nó chỉ 
xóa những vùng điểm ảnh có giá trị màu giống như điểm ảnh nằm ở tâm chữ thập của đầu tẩy; các 
điểm ảnh khác mặc dù vẫn nằm trong vùng diện tích đầu tẩy, nhưng có giá trị màu khác biệt thì 
không hề bị xóa.

Quan sát thanh Option
•	 Sampling:

-	 Continous: xóa tất cả các pixel màu kế cận khi kéo trỏ chuột

-	 One: xóa các pixel giống màu được click đầu tiên

		  -     Background Swatch: Xóa các pixel giống màu Background

Limits: có 3 chế độ lựa chọn tẩy
•	 Dicontiguous
•	 Contiguous: tẩy có giới hạn, khi gặp một biên khác màu thì dù đầu tẩy 
•	 Find Edge

Công cụ Magic Eraser Tool 

Tẩy xóa nền theo vùng màu tương đồng. Bạn chỉ cần click chuột vào vùng màu bạn muốn xóa, 
công cụ chiếu theo tham số Tolenrance trên thanh Options, tìm kiếm các điểm ảnh có giá trị tương 
đồng với điểm ảnh tại vị trí bạn click chuột, đồng thời xóa ngay toàn bộ các điểm ảnh được chọn 
đó. Vùng điểm ảnh được xóa lớn hay nhỏ, là do tham số trong trường Tolerance quyết định, đồng 
thời có giới hạn đường biên hay không giới hạn, xóa trên layer hiện hành hay xóa trên toàn bộ các 
layer trong cửa sổ ảnh... sẽ do bạn quyết định và check vào các checkbox Contiguous và Sample All 
Layer trên thanh Options.
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Công cụ History Brush  
Phục hồi hình ảnh trở về trạng thái ban đầu.
Thao tác thực hiện:

•	  Chọn công cụ History Brush.
•	  Nhấp giữ phím chuột và rê trên vùng hình ảnh mà bạn muốn khôi phục trạng thái ban đầu.

Kết quả: xóa bỏ những bước đã thao tác tại vùng hình ảnh được rê chuột, và khôi phục các điểm 
ảnh tại vùng đó về trạng thái như khi bức ảnh vừa mới mở ra.

Sử dụng History Palete (Menu Window\ History):

Lưu giữ các lệnh mà ta thực hiện lên hình ảnh từ lúc tập tin được mở. History Palete biểu hiện từng 
thao tác đã thực hiện theo dòng thời gian. Mặc định của Photoshop, có thể lưu trữ 20 hành động đã 
thực hiện, trường hợp có nhiều hơn 20 bước thì các bước thao tác đầu tiên sẽ bị tự động xóa đi để 
giải phóng bộ nhớ. Tuy nhiên, nếu muốn ta vẫn có thể tăng, giảm số lần lưu trong palette History. 

Để tăng giảm số bước lưu giữ trong History Palete, thực hiện theo các thao tác sau: 

•	 Menu Edit\ References\ General
•	 Nhập giá trị mới vào hộp số History States
•	 Lưu ý: giá trị History State càng lớn thì càng chiếm nhiều bộ nhớ.

- A: Create new document from current state: tạo một tập tin mới từ 
trạng thái hiện tại.

- B: Create new Snapshot: giữ lại trạng thái hiện tại với một snapshot 
xuất hiện ở phía trên cùng của bảng History. Chức năng này rất hữu 
ích khi phục chế hình ảnh.
		
- C: Delete Current State: xóa bỏ trạng thái hiện tại. 

                        A    B   C

Công cụ Art History 
Brush vẽ nghệ thuật
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Chọn một trong các dạng Brush vẽ nghệ thuật trong danh sách Style và rê vẽ trực tiếp lên ảnh.

----------------------------------------------------------------------

CÁC PHƯƠNG PHÁP VÀ CÔNG CỤ TÔ MÀU - LỆNH FILL

Làm việc với Bảng Swatches palette

Swatches Palette là nơi chứa các mẫu màu, mặc định là 128 màu nhưng ta có thể thêm hoặc bớt 
những màu trên đó.

•	 Mở đóng Swatches Palette: vào menu Window\ Swatches
•	 Create New Swatches: tạo mẫu màu mới vào swatches.
•	 Delete Swatches: xóa mẫu màu
•	 Khi click chọn mẫu màu, màu sẽ xuất hiện ở ô màu foreground.

Làm việc với Bảng Color palette 
Có thể thay đổi màu trong hệ RGB, CMYK, HSB để pha màu theo màu chỉ định.

•	 Mở đóng Color Palette: vào menu Window\ Color
•	 Di chuyển thanh trượt ở các dãy màu hay nhập thông số vào ô để chọn màu thích hợp
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Chọn lựa màu Foreground, Background 

Quan sát trên hộp công cụ ta sẽ thấy có biểu tượng hai ô màu, ô nằm trên là ô màu Foreground 
(tiền cảnh) và ô nằm dưới là ô màu Background (hậu cảnh).

 

•	 Foreground: màu tiền cảnh
•	 Switch foreground to background colors: hoán đổi giữa màu tiền cảnh và màu nền (X)
•	 Background: màu hậu cảnh (nền)
•	 Default color: tái lập mặc định màu đen trắng (D)

Tô màu cho vùng chọn bằng màu Foreground: nhấn phím Alt + Del.

Tô màu cho vùng chọn bằng màu Background: nhấn phím Ctrl + Del.

CÁC CÔNG CỤ TÔ MÀU 

Công cụ Paint Bucket 
Dùng để tô đầy một màu đồng nhất hoặc một mẫu họa tiết (Pattern) vào những Pixel liền kề có giá 
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trị màu tương tự với pixel vừa nhấp.

Thao tác thực hiện:

•	 Chọn công cụ Paint Bucket
•	 Chọn màu muốn tô trong ô màu Foreground.
•	 Kích vào vùng chọn.
•	 Hoặc nếu muốn tô bằng họa tiết thì chọn chế độ Pattern trong hộp Fill trên thanh Options.

Công cụ Gradient 

 

Dùng để tô màu chuyển sắc.

Linear Gradient: 

Màu biến thiên từ điểm đầu đến điểm cuối theo đường thẳng.

Thao tác thực hiện: 

•	 Chọn công cụ Linear Gradient.
•	 Kích điểm đầu và rê chuột tới một điểm cuối bất kỳ (Bấm giữ Shift trong khi rê mouse nếu 

muốn tô theo 1 đường thẳng).
 
Radial Gradient:

Màu biến thiên từ điểm đầu đến điểm cuối theo dạng tỏa tròn.

Angle Gradient:

Màu biến thiên nghịch chiều kim đồng hồ xung quanh điểm bắt đầu (giống hình chóp hay hình 
nón).

Reflect Gradient:

Màu biến thiên dựa trên mẫu gradient tuyến tính đối xứng ở một bên điểm bắt đầu.

Diamond Gradient:

Màu biến thiên từ điểm bắt đầu hướng ra ngoài theo dạng hình thoi. Điểm cuối quyết định một 
góc của hình thoi.

Mặt khác, ta có thể tùy chọn cách chuyển sắc trong bảng Gradient Options
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•	 Blending mode: các chế độ hòa trộn
•	 Opacity: độ trong suốt
•	 Gradient: các lựa chọn gradient khác nhau
•	 Transparency: cho phép tô kiểu Gradient trong suốt
•	 Dither: tạo mẫu hòa trộn mịn hơn, ít sọc hơn. Ở chế độ mặc định (tự động mô phỏng những 

màu không thể hiển thị được trên máy).
•	 Reverse: với tùy chọn này, màu Gradient được tạo ra sẽ bị đảo ngược vị trí so với màu đã chọn.

•	 Click to Edit the Gradient  : nhấp vào nút này để mở Gradient Editor, dùng 
để chỉnh sửa tính chất của màu Gradient đang được chọn.

Sử dụng bảng Gradient Editor để thay đổi màu tô chuyển theo những góc độ khác nhau.

•	 Thêm một nút màu trên dãy chuyển sắc: kích 1 lần vào 1 điểm bất kỳ ngang hàng với các nút 
Color Stop

•	 Đổi màu: double click lên nút màu cần đổi
•	 Xóa nút màu: chọn nút màu cần xóa à kích nút Delete phía dưới bảng Gradient Editor hay chỉ 

cần kéo drag nút màu xuống dưới khỏi thanh màu.
•	 Load thư viện gradient: kích vào menu palette Gradient Editor > chọn thư viện cần Load.
•	 Lấy lại thư viện mặc định: kích vào menu palette Gradient Editor > Preset Gradients…

Công cụ Eyedropper 

Dùng để lấy màu mặt (Foreground) hoặc màu nền (Background) trên hình ảnh.
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Thao tác thực hiện: 

•	 Chọn công cụ Eyedropper, chọn một trong ba kiểu hút màu trên thanh Options.
•	 Point Sample: hút màu tại một pixel được chọn
•	 3 by 3 Average: lấy màu trung bình của 3*3 Pixel kế cận nhau.
•	 5 by 5 Average: lấy màu trung bình của 5*5 Pixel kế cận nhau.
•	 Di chuyển con trỏ và kích vào một màu trên hình ảnh. Kết quả: màu lấy được sẽ hiển thị 

trong ô màu Foreground.
•	 Bấm giữ phím Alt và kích vào một màu trên hình ảnh. Kết quả: màu lấy được sẽ hiển thị 

trong ô màu background.

Ngoài ra, khi đang làm việc với một công cụ tô vẽ bất kỳ, ta có thể bấm Alt để chuyển tạm thời về 
công cụ EyeDropper.

Công cụ Color Sampler Tool  

Đo thông số màu. Cho xem tối đa là bốn thông số và các thông số này được hiển thị trên palette 
Info với số thứ tự tương ứng (#1, #2, #3, #4).

Muốn xóa các điểm đã tạo ra bằng công cụ Color Sampler Tool: kích phải mouse tại điểm cần xóa 
và chọn Delete hoặc kích lệnh Clear (Clear All) trên thanh Options.

Công cụ Ruler Tool  

Xác định tọa độ, góc, độ dài của một đối tượng.
Thao tác thực hiện: 

•	 Chọn công cụ Ruler.
•	 Kích xác định một điểm trên hình ảnh và kéo trỏ chuột sang vị trí thứ hai.
•	 Quan sát trên Info Panel hoặc thanh Options, ta sẽ thấy kết quả thông qua sự thay đổi của 

các chỉ số.
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Một ứng dụng khác của công cụ Measure là canh chỉnh hình ảnh bị nghiêng trở về dạng thẳng: 
Dùng công cụ Measure kéo dọc theo chiều nghiêng của hình ảnh,  vào Menu Image\ Image Rota-
tion\ Arbitrary và nhấn OK. 

Một cách nhanh hơn là sau khi kéo thước nghiêng theo chiều nghiêng của ảnh, nhấn vào nút 
Straighten Layer trên thanh Option là ảnh sẽ được xoay thẳng lại. 

LỆNH FILL

Lệnh Fill cung cấp cho bạn các tùy chọn để tô vào một layer hay vào trong một vùng chọn bằng 
màu, bằng mẫu tô hay giúp khắc phục một vùng chi tiết hình ảnh không được như mong muốn.

Để tô, bạn chọn menu Fill> Edit, khi hộp thoại mở ra, xổ danh sách và chọn một kiểu tô trong đó 
để áp dụng.

Danh sách các kiểu Fill bao gồm

•	 Foreground
•	 Background
•	 Color
•	 Content-Aware
•	 History
•	 Pattern
•	 Black
•	 White
•	 50% Grey

Với Foreground bạn sẽ sử dụng màu hiện có trong ô Foreground tô vào trong vùng chọn

Với Background, bạn sẽ sử dụng màu hiện có trong ô Background để tô vào trong vùng chọn

Khi màu trong ô Foreground và Background đều không làm bạn hài lòng thì hãy chọn Color, lúc đó 
sẽ có một cửa sổ Color Picker hiện ra cho phép bạn click chọn màu trong đó, hoặc nhập trực tiếp 
giá trị màu bạn muốn vào các trường giá trị màu. Sau khi nhập giá trị hoặc click chọn và OK bạn  
sẽ quay trở về hộp thoại Fill, nhấp chọn OK thêm lần nữa để tô màu bạn vừa chọn vào vùng chọn.

Tô màu theo mẫu tô Pattern

Cách tạo mẫu tô Pattern 
Thao tác thực hiện:

•	 Tạo đối tượng dùng để tạo mẫu tô
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•	 Nhấn Ctrl + A (chọn hết ảnh) hoặc chọn một vùng chọn bất kỳ trên mẫu
•	 Chọn Edit \ Define Pattern (đặt tên mẫu tô -> OK)

Tô màu theo mẫu tô

Thao tác thực hiện:

•	 Mở một tập mới
•	 Chọn Edit \ Fill
•	 Chọn các chức năng trong hộp thoại Fill

-	 Use: Chọn Pattern

-	 Custom Pattern: Chọn kiểu mẫu tô 

-	 Mode: Chế độ hòa trộn (Normal)

-	 Opacity: Độ mờ

•	 Nhấp OK
•	 Mẫu tô sẽ được tô trên tập tin

Với Pattern, bạn có thể tô vào cả layer hay các điểm ảnh trong vùng chọn bằng mẫu tô kết cấu cho 
sẵn trong thư viện Pattern của Adobe Photoshop. Để thực hiện, bạn cần vào menu Edit> Fill, chọn 
Pattern khi danh sách kiểu tô xổ ra, sau đó chọn lấy một mẫu tô Pattern trong thư viện bên dưới, 
nhấn OK để thực hiện phép tô. Trường hợp bạn không hài lòng với mẫu tô hiện có trong thư viện, 
nhấn vào mũi tên tam giác nhỏ bên cạnh phải phía trên danh sách mẫu tôt, mở ra thư viện mẫu tô 
của Adobe Photoshop, click chọn lấy thư viện mới, nhấn OK nếu chấp nhận thay thế thư viện hiện 
tại bằng thư viện mới, Apperance nếu vẫn muốn giữ các mẫu tô hiện tại, đồng thời tải mới các mẫu 
trong thư viện mẫu tô mới đang được chọn, Cancel nếu hủy bỏ chọn.
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Nếu muốn tải mẫu tô mới bên ngoài (ví dụ tải xuống từ Internet), bạn cũng thao tác tương tự, 
nhưng khi menu ngữ cảnh mở ra, bạn hãy chọn lệnh Load Pattern rồi trỏ tới nơi chứa mẫu Pattern 
được lưu, chọn Pattern, nhấn OK. Mẫu Pattern sẽ được nạp vào Adobe Photoshop, nằm cuối cùng 
trong thư viện mẫu Pattern đang được bạn sử dụng.

Muốn khôi phục trở về trạng thái mặc định, bạn thao tác tương tự nhưng chọn Reset Default.

Tô với lệnh Content-Aware

Với Content-Aware, tính năng mới được bổ sung từ phiên bản Adobe Photoshop CS5, bạn cần có 
một vùng chọn đang hiện hành trong cửa sổ ảnh thì tùy chọn này mới hiển thị trong hộp thoại 
Fill. Bạn sẽ tô đầy vào vùng chọn bằng các điểm ảnh được lựa chọn từ các vùng điểm ảnh lân cận, 
bao xung quanh vùng chọn hiện hành. Tùy chọn này đặc biệt thích hợp với việc xóa bỏ một chi tiết 
không mong muốn nào đó trong bức ảnh. 
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Tô với History

Với History, bạn có thể đưa cả bức ảnh, hay các điểm ảnh nằm trong vùng chọn trở về trạng thái 
được chỉ định, mặc định là trậng thái của lần Save gần nhất. Nếu bạn mở cửa sổ History và đánh 
dấu vào một bước cụ thể nào đó thì thao tác tô History sẽ tô vào vùng chọn hay cả layer hoặc bức 
ảnh về bước History được chỉ định. Lệnh Fill History có ưu điểm là không phụ thuộc thứ tự cứng 
nhắc như thao tác Undo (Ctrl+Alr+Z) hay nhấn vào cửa sổ History.

Với Black, bạn tô màu đen vào vùng được chọn; 50% Grey, bạn tô bằng màu xám , còn với White 
bạn tô bằng màu trắng vào vùng được chọn.

CÁC LỆNH LIÊN QUAN TỚI HIỆU CHỈNH ẢNH 

Menu Image, lệnh Mode

Menu này chứa các lệnh để chuyển đổi lựa chọn định dạng ảnh dành cho các loại công việc khác 
nhau.  Chúng ta có thể chia nhanh ra 2 loại là ảnh để in trên máy in Offset công nghiệp và ảnh để 
thể hiện trên màn hình, rửa ảnh kỹ thuật số. Ảnh để in Offset cần để ở chế độ CMYK, còn ảnh cho 
việc trình abyf trên màn hình - bao gồm cả Internet thì ở dạng RGB. 

Ảnh Greyscale là ảnh dạng thang độ xám hay còn gọi là ảnh đen trắng. Dạng này sử dụng được ở 



Giáo trình Adobe Photoshop CC 105Created by GiangPM

www.enterfocus.edu.vn

cả 2 môi trường in ấn và trình bày màn hình.

Ảnh Doutone là dạng ảnh dùng để in, nhưng chỉ có 2 màu, một là đen và một là màu bạn chọn 
thêm. Để đưa một ảnh từ màu về Doutone, bạn cần đưa nó về Greyscale, sau đó chọn Doutone. Khi 
đã mở  hộp thoại, bạn chọn thêm 1 màu mà bạn muốn, OK.

Menu Image> Image Size

Lệnh này giúp bạn điều chỉnh kích thước ảnh. Tùy vào nhu cầu, nếu để trình bày màn hình bạn cần 
quan tâm tới Pixel Dimensions là chiều dài chiều rộng tấm ảnh tính theo số lượng pixels. Còn nếu 
bạn in Offset, bạn cần quan tâm tới Document Size trình bày chiều dài chiều rộng ảnh theo đơn vị 
đo vật lý  là mm, cm hay inch. 

Muốn chỉnh kích thước, bạn chọn trường phù họp rồi nhập kích thước yêu cầu vào.

Lưu ý tới trường Resolution, độ phân giải ảnh; nếu trình bày màn hình bạn chỉ cần ảnh có độ phân 
giải là 72 pixel/ inch; còn nếu muốn in Offset thì độ phân giả cần có là 300 pixel/ inch.

Menu Image > Adjustments > 

Lệnh Levels 

Dùng để chỉnh sửa khoảng tông và độ cân bằng màu của hình ảnh bằng cách điều chỉnh các mức 
cường độ của vùng tối, vùng giữa tông và vùng sáng trong ảnh.

•	 Nút tam giác màu đen: đại diện cho tông màu tối Shadow.
•	 Nút tam giác màu trắng: đại diện cho tông màu sáng Highlight.
•	 Nút tam giác màu xám: đại diện cho tông màu trung bình Midtone.
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Thao tác thực hiện:

•	 Chọn lệnh Levels, hộp thoại xuất hiện.
•	 Kích và di chuyển nốt tam giác nằm ở giữa trong ba nốt trong biểu đồ Input Levels. Nếu di 

chuyển về phía bên phải hình ảnh sẽ tối hơn. Ngược lại nếu di chuyển về phía bên trái của 
hộp thoại, hình ảnh sẽ sáng hơn.

•	 Kích vào nút OK.

Lưu ý: Bạn có thể sử dụng công cụ Eyedropper để thiết lập giá trị cho các điểm đen và điểm trắng 
tuyệt đối để cải thiện tông màu cho hình ảnh.

Lệnh Auto Level 

Tự động hiệu chỉnh mức xám trung bình (Gamma).
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Lệnh Auto Contrast 

Tự động hiệu chỉnh cường độ tương phản trong hình ảnh.
 
Lệnh Curves 
Hiệu chỉnh đồng bộ các mức sáng – tối – trung bình.

Thao tác thực hiện:

•	 Chọn lệnh Curves
•	 Di chuyển con trỏ và kích lên đường đồ thị (đường xiên từ góc dưới trái đến góc trái phải), 

sẽ xuất hiện một nốt vuông trên đường đồ thị đó.
•	 Kích vào nốt vuông và rê chuột theo hướng trên trái là tăng sắc độ sáng. Ngược lại, kích vào 

một nốt vuông và chuột theo hướng dưới phải là tăng sắc độ tối – OK

Lệnh Brightness Contrast

Hiệu chỉnh sắc độ sáng tối và cường độ tương phản trong hình ảnh.

Thao tác thực hiện:

•	 Chọn lệnh Brightness > Contrast
•	 Di chuyển con trượt của thanh Brightness, nếu sang bên trái làm tối hình ảnh. Ngược lại, 
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sang bên phải làm sáng hình ảnh.
•	 Di chuyển con trượt của thanh Contrast, nếu sang trái là giảm độ tương phản. Ngược lại, 

sang bên phải sẽ làm tăng độ tương phản trong hình ảnh.
•	 Kích nút OK.

Lệnh Color Balance 
Dùng để cân bằng màu sắc.

Thao tác thực hiện:

•	 Kiểm nhận một trong ba giá trị ở khu vực Tone Balance.
-	 Shadows: tập trung thay đổi những vùng hình ảnh có sắc độ tối. 
-	 Midtones: tập trung thay đổi những vùng hình ảnh có sắc độ trung bình
-	 Highlights: tập trung thay đổi những vùng hình ảnh có sắc độ sáng.
-	 Preserve Luminosity: tùy chọn này cho phép duy trì độ sáng trong hình ảnh.

•	 Di chuyển ba thanh trượt trong khu vực Color Balance.
-	 Cyan: màu xanh da trời
-	 Red: màu đỏ
-	 Magenta: màu tím sen
-	 Green: màu xanh lục
-	 Yellow: màu vàng
-	 Blue: màu xanh dương.

•	 Kéo con trượt đến màu cần tăng trong hình ảnh và ra xa màu cần giảm trong hình ảnh.
•	 Kích nút OK.
•	

Lệnh Hue\Saturation 

Dùng để hiệu chỉnh sắc độ, độ bão hòa màu và mức độ sáng tối cho hình ảnh.
•	 Hue: là màu phản xạ lại mắt người khi ánh sáng chiếu trên một đối tượng, một phần  được  

hấp  thu  và  một  phần  được  phản  xạ  lại.  Hue  được tính  toán  bằng cách xác định vị trí 
trên bánh xe màu chuẩn (color whell) theo độ từ 0 -> 360 độ. Hue được nhận biết bởi tên 
của màu như, màu đỏ, cam hoặc xanh

•	 Saturation (chroma) là độ bão hòa (độ đậm đặc) cường độ màu Saturation mô tả sự tươi 
hoặc nhạt của Hue, nó được tính toán theo phần trăm 0% -> 100%
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•	 Brightness : ảnh hưởng độ sáng (Lightness) hoặc độ đậm (drakness) của màu, được đo bằng 
phần trăm 0% (đen) đến 100% (trắng). Photoshop giúp bạn chỉnh sửa ảnh, một công việc 
mà trước đây chỉ dành riêng cho các chuyên gia về lĩnh vực này. Bạn sẽ chụp ảnh và quét ảnh 
vào máy tính và có thể chỉnh sửa màu sắc, sắc độ đậm nhạt cho ảnh, sự hòa trộn giữa ảnh và 
một bức ảnh ghép khác, để tạo nên sự hoàn mỹ cho tác phẩm của bạn.

Thao tác thực hiện:

•	 Di chuyển các thanh trượt trong bảng Hue\Saturation
-	 Hue: hiệu chỉnh sắc độ màu
-	 Saturation: hiệu chỉnh độ bão hòa
-	 Lightness: hiệu chỉnh độ sáng tối. 

•	 Colorize: Hình ảnh được chuyển sang sắc độ của màu Foreground hiện hành và vẫn bảo 
toàn độ sáng cho mỗi pixel.

Lưu ý: Trong trình đơn sổ xuống của Edit, ta chọn một màu bất kỳ, chẳng hạn như Red (đỏ). Khi 
hiệu chỉnh, ta tác động lên nhóm màu thuộc tông màu đỏ. Tất cả màu còn lại vẫn giữ nguyên trạng 
thái ban đầu.
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Auto color: 

Tự động tinh chỉnh độ cân bằng màu trong hình ảnh.

Lệnh Desaturate 

Chuyển đổi toàn bộ màu sắc của hình ảnh sang thang độ xám nhưng vẫn giữ nguyên hệ màu ban 
đầu, và nó chỉ ảnh hưởng đến hình ảnh trên Layer hiện hành.

Thao tác đơn giản: ta chỉ chọn lớp hình ảnh à Menu Image\ Adjustments\ Desaturate.

Lệnh Replace Color 

Thay thế màu hiện hành được chỉ định bằng các giá trị màu mới.

•	 Fuzziness: xác định phạm vi dải màu sẽ được chọn để thay thế.
•	 Hình vuông màu đen: hiển thị vùng chọn hiện hành. Vùng màu trắng trong hình vuông màu 

đen: hiển thị vùng màu sẽ được thay thế
•	 Hue: điều chỉnh tông màu
•	 Saturation: điều chỉnh cường độ màu
•	 Lightness: điều chỉnh độ sáng tối của màu
•	 Ba công cụ Eyedroper: dùng để xác định mẫu màu nào cần được thay thế

-	 Eyedropper (+): dùng để chọn thêm mẫu màu
-	 Eyedropper (-) dùng để loại bớt mẫu màu không cần thiết ra khỏi mẫu màu đã chọn.
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Lệnh Selective Color 

Hiệu chỉnh màu theo tông màu định chọn.

Thao tác thực hiện:

•	 Chọn tông màu trong menu sổ của nhãn lệnh Color.
•	 Di chuyển các nốt tam giác của bốn thanh trượt: Cyan – Magenta – Yellow – Black. OK

	
Lệnh Channel Mixer 

Nhuộm ba màu theo từng kênh đơn (Red – Green – Blue) lên hình ảnh.
	
Thao tác thực hiện:

•	 Chọn một kênh màu đơn trong trình đơn Output Channel.
•	 Di chuyển nốt tam giác của ba thanh trượt Red, Green, Blue trong khu vực Source Channel 

để hiệu chỉnh màu nhuộm.
•	 Monochrome: sử dụng các mức xám.
•	 Di chuyển nốt tam giác trên thanh trượt Contrast: để tăng hoặc giảm bớt độ dày đặc của 

kênh màu được chọn.
•	 Kích nút OK.

Muốn lưu giữ những hiệu chỉnh trong hộp thoại Channel Mixer ta kích nút Save. Khi cần sử dụng 
lại, ta kích nút Load.
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Lệnh Gradient Map: 

Lệnh Gradient Map ánh xạ khoảng biến thiên thang độ xám tương đương của hình ảnh theo màu 
của mẫu tô gradient xác định. Vùng tối trong hình ảnh ánh xạ đến màu ở một đầu mẫu tô (bên 
trái), vùng sáng ánh xạ đến màu ở đầu còn lại (bên phải).

Thao tác: 

•	 Mở hộp thoại Gradient Map
•	 Định rõ mẫu tô gradient sẽ áp dụng
•	 Chọn các tùy chọn thích hợp:

-	 Dither: Làm mịn màu mẫu tô và giảm bớt hiệu ứng sọc

-	 Reverse: Đổi hướng biến thiên của mẫu tô Gradient, nghịch đảo hướng ánh 
xạ.

•	 Nhấn OK
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Lệnh Invert 

Tạo âm bản cho hình ảnh.

Thao tác thực hiện: chỉ việc chọn lệnh Invert.

Ảnh gốc dương bản Ảnh âm bản sau khi Invert

Lệnh Equalize 

Phân bố đều giá trị sáng trung bình.

Thao tác thực hiện: chọn một vùng hình ảnh à chọn lệnh Equalize. Xuất hiện một hộp thoại:

•	 Equalize selected area only: chỉ bên trong vùng chọn.
•	 Equalize entire image base on selected area: phân bố đều đặn tất cả những pixel dựa trên 

những pixel bên trong vùng chọn.

Sử dụng Equalize khi ảnh quét tối hơn so với ảnh gốc nhưng muốn cân bằng các giá trị nhằm tạo 
hình ảnh sáng hơn.

Nhóm công cụ chỉnh sửa hình ảnh 

Công cụ Clone Stamp  

Dùng để sao chép điểm ảnh
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Thao tác thực hiện:

•	 Chọn công cụ Clone Stamp.
•	 Chọn Brush vẽ và ấn định các tùy chọn Brush vẽ.
•	 Định rõ chế độ hòa trộn (Mode), độ mờ đục (Opacity) và diễn tiến nét vẽ.
•	 Quyết định cách canh chỉnh pixel mẫu: 
•	 Nếu kiểm nhận mục Align: điểm nguồn sẽ luôn luôn được gióng với một khoảng cách cố 

định so với điểm đích (khi di chuyển điểm đích ra xa thì điểm nguồn cũng sẽ di chuyển theo 
với một khoảng cách đã được xác định từ ban đầu).

•	 Nếu không kiểm nhận mục Align thì điểm nguồn sẽ luôn luôn cố định tại một vị trí.
•	 Use all Layer: lấy mẫu dữ liệu từ mọi lớp
•	 Bấm giữ phím Alt và kích lên hình ảnh để chọn điểm nguồn. (Nếu sử dụng công cụ này để 

xóa vết dơ thì ta nên xác định điểm nguồn là phần ảnh sạch gần với vùng ảnh dơ nhất).
•	 Di chuyển con trỏ sang vị trí thứ hai (vùng ảnh dơ) rồi kích từng điểm một… (hãy xác định 

lại điểm nguồn khác nếu điểm nguồn cũ không còn thích hợp nữa). 
•	 Kết quả: sẽ sao chép vùng ảnh tại vị trí điểm nguồn sang điểm đích.

Lưu ý: Nếu lấy mẫu từ một hình ảnh và áp dụng cho một hình ảnh khác thì cả hai ảnh phải thuộc 
cùng chế độ màu.

Công cụ Healing Brush 

Cho phép chấm sửa những chỗ chưa hoàn chỉnh. Tô vẽ bằng những pixel mẫu được chiết xuất từ 
hình ảnh hoặc họa tiết. Ngoài ra, công cụ này còn có thể so khớp mẫu kết cấu, độ sáng lẫn sắc thái 
của điểm ảnh mẫu so với điểm ảnh nguồn.

Kết quả: Các pixel chỉnh sửa hòa trộn liền lạc với phần ảnh còn lại.
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•	 Sampled: cho phép sử dụng Pixel từ hình ảnh hiện hành
•	 Pattern: chọn Pixel từ mẫu họa tiết.
•	 Quyết định cách canh chỉnh pixel mẫu
•	 Bấm giữ phím Alt và kích lên hình ảnh để chọn điểm nguồn. (Nếu sử dụng công cụ này để 

xóa vết dơ thì ta nên xác định điểm nguồn là phần ảnh sạch gần với vùng ảnh dơ nhất).
•	 Di chuyển con trỏ sang vị trí thứ hai (vùng ảnh dơ) rồi kích từng điểm một… (hãy xác định 

lại điểm nguồn khác nếu điểm nguồn cũ không còn thích hợp nữa). 

Lưu ý: Nếu lấy mẫu từ một hình ảnh và áp dụng cho một hình ảnh khác thì cả hai ảnh phải thuộc 
cùng chế độ màu. (trừ trường hợp một trong số đó là ảnh Grayscale)

Nếu cần đảm bảo độ tương phản giữa các rìa nét vẽ của vùng đang chỉnh sửa, hãy chọn vùng trước 
khi áp dụng công cụ Healing Brush (để ngăn không cho màu tràn ra ngoài).

Công cụ Patch 

Chấm sửa vùng ảnh được chọn bằng những Pixel lấy từ hình ảnh khác hay từ họa tiết nào đó. Tương tự như 
Healing Brush, Patch tool cũng cho phép so khớp mẫu kết cấu, ánh sáng và sắc thái của pixel mẫu so với 
pixel nguồn.

Khi chấm sửa ảnh, nên chọn từng vùng ảnh nhỏ để ra kết quả chính xác hơn.

•	 Source: Drag chọn một vùng ảnh dơ và đặt trỏ vào bên trong vùng chọn drag sang vùng ảnh 
sạch gần nhất.

•	 Destination: Drag chọn một vùng ảnh sạch gần vùng ảnh dơ nhất và đặt trỏ vào bên trong 
vùng chọn à drag đắp sang vùng ảnh dơ kề bên.

•	 Ta có thể chỉnh sửa vùng chọn tương tự như thao tác với công cụ Lasso (bấm Shift để cộng 
thêm vùng chọn, bấm Alt để trừ bớt vùng chọn).
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Công cụ Spot Healing Brush 

Là công cụ để xóa nhanh các vết lỗi, khuyết điểm nhỏ trên ảnh ví dụ như tấy đi một nốt ruồi, hay 
xóa bỏ nhanh một chi tiết thừa trong bức ảnh bằng cách tự động lấy các vùng điểm ảnh xung 
quanh vùng  bị lỗi, hay xung quanh chi tiết mà bạn muốn loại bỏ để tự động lấp đầy vào vùng mà 
diện tích đầu bút  đang tác động.

Thao tác: chọn công cụ Spot Healing Brush, chỉnh kích thước đầu bút sao cho phù hợp với diện tích 
vùng muốn chỉnh sửa, đưa đầu bút vào vùng muốn chỉnh sửa và click chuột, hoặc nhấn giữ phím 
chuột và kéo rê đầu công cụ trên vùng ảnh muốn chỉnh sửa. Sử dung công cụ này, bạn không cần 
chọn nguồn như các công cụ chỉnh sửa khác.

Trên thanh Spot Healing Brush Options có mấy tùy chọn như sau:

•	 Proximity Match: Tự tập hợp những pixel màu xung quanh để che lấp khuyết điểm ở vùng 
tâm của đầu bút đang thao tác

•	 Create Texture: Tập hợp tất cả các pixel bên trong vùng chọn để tạo thành chất liệu hiệu 
chỉnh những khuyết điểm bên trong vùng chọn

•	 Content - Aware: Vá lấp vùng ảnh có khuyết điểm tương tự như phương pháp Fill Content - 
Aware.
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Trước Sau

Công cụ Red Eye 

Trước Sau

Công cụ giúp khử hiệu ứng mắt dỏ khi chụp ảnh với đèn Flash.

Thao tác: 

Chọn công cụ Red Eye, nhấp và kéo rê trên vùng mắt bị đỏ để tạo thành một vùng chọn tương tự 
như một vùng marquee, các vùng màu đỏ trong phạm vi vùng chọn sẽ được Photoshop tự động 
xử lý.
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Đây là một công cụ xử lý nhanh, dễ sử dụng nhưng hiệu quả không thực sự hoàn hảo vì vùng xử lý 
thường hơi bị đen hơn so với vùng mắt xung quanh, nhất là khi xử lý mắt xanh.

Công cụ Content-Aware Move 
Công cụ Content-Aware Move là công cụ mới được bổ sung ở phiên bản CS5, đây là một công cụ 
mạnh giúp di chuyển một vùng điểm ảnh sang vị trí mới. Có 2 lựa chọn cho người sử dụng: di 
chuyển vùng ảnh và xóa bỏ điểm ảnh gốc, và di chuyển nhân bản vùng điểm ảnh nhưng vẫn giữ 
lại vùng điểm ảnh gốc.

Để chọn chế độ làm việc, bạn cần xổ danh sách ở trường Mode trên thanh Option và chọn một 
trong 2 chế độ: 

•	 Move: Dịch chuyển điểm ảnh và xóa điểm ảnh gốc
•	 Extend: Dịch chuyển và nhân bản điểm ảnh trong lúc vẫn giữ lại điểm ảnh gốc.

Với tùy chọn nào thì sau khi dịch chuyển điểm ảnh tới vị trí mới, Photoshop cũng tự xử lý để điểm 
ảnh được di chuyển hòa trộn một cách tự nhiên với các điểm ảnh ở xung quanh. Trường hợp Move 
thì Photoshop còn xử lý cả vùng điểm ảnh gốc như chưa hề có các điểm ảnh cũ tại điểm gốc .

Ví dụ dịch chuyển điểm ảnh
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Ví dụ dịch chuyển và nhân bản điểm ảnh 
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Công cụ Blur  
Dùng để làm mờ các rìa hoặc vùng sắc nét trong hình ảnh để giảm bớt chi tiết.

•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau.
•	 Mode: các chế độ hòa trộn của công cụ
•	 Strength: áp lực phun của công cụ
•	 Use All Layers: làm mờ hình ảnh được chứa trong các Layer đang hiển thị.

Thao tác thực hiện: 

•	 Chọn công cụ Blur
•	 Xác lập các chế độ cần thiết trên thanh thuộc tính.
•	 Kích và rê chuột liên tục lên hình ảnh.
•	 Kết quả: hình ảnh sẽ bị mờ dần.

Công cụ Sharpen 
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Tập trung vào rìa mờ nhằm tăng độ sắc nét, dựa trên nguyên tắc làm tăng độ tương phản giữa các 
pixel nằm cạnh nhau.

•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau.
•	 Mode: các chế độ hòa trộn của công cụ
•	 Strength: áp lực phun của công cụ 
•	 Use All Layers: làm rõ nét hình ảnh được chứa trong các Layer đang hiển thị.

Thao tác thực hiện: 

•	 Chọn công cụ Sharpen
•	 Xác lập các tùy chọn thích hợp trên thanh options
•	 Kích và rê chuột liên tục lên hình ảnh
•	 Kết quả: hình ảnh sẽ rõ nét ở các biên.
•	 Tuy nhiên, không nên sử dụng quá nhiều công cụ này.

Công cụ Smudge 

Mô tả hành động miết ngón tay qua vùng sơn ướt. Công cụ này lấy màu ở vị trí bắt đầu và đẩy nó 
theo hướng kéo trỏ chuột.

•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau
•	 Mode: các chế độ hòa trộn của công cụ
•	 Strength: áp lực làm nhòe của công cụ 
•	 Use All Layers: ảnh hưởng đến các Layer đang hiển thị.

Thao tác thực hiện:

•	 Chọn công cụ Smudge
•	 Kích và rê chuột trực tiếp lên hình ảnh theo hướng thích hợp.

Nếu kiểm nhận tùy chọn mục Finger Painting: quệt nhòe bằng màu foreground tại nơi bắt đầu từng 
điểm vẽ.

Công cụ Dodge 

Dùng để làm tăng độ sáng cho hình ảnh.
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•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau
•	 Range: Giới hạn vùng ảnh hưởng: Shadows: vùng tối; Midtones: vùng giữa tông; Highlights: 

vùng sáng.
•	 Exposure: xác định độ sáng, giá trị càng lớn hiệu ứng càng mạnh.

Thao tác thực hiện:

•	 Chọn công cụ Dodge
•	 Xác lập các giá trị cần thiết trên thanh Options.
•	 Kích và rê chuột lên trên hình ảnh
•	 Kết quả: hình ảnh sẽ sáng dần trên vùng kích chuột.

Công cụ Burn 

Làm tối hình ảnh

•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau
•	 Range: Giới hạn vùng ảnh hưởng: Shadows: vùng tối; Midtones: trung bình; Highlights: 

vùng sáng.
•	 Exposure: xác định độ sáng, giá trị càng lớn hiệu ứng càng mạnh.

Thao tác thực hiện:

•	 Chọn công cụ Burn
•	 Xác lập các giá trị cần thiết trên thanh Options.
•	 Kích và rê chuột lên trên hình ảnh

Kết quả: hình ảnh sẽ tối dần trên vùng kích chuột.

Công cụ Sponge  

Dùng để làm cho màu sắc của hình ảnh bão hòa hơn hoặc rực rỡ hơn.

•	 Brush: nơi chứa các loại Brush và kiểu Brush khác nhau
•	 Mode: 

-	 Desaturate: làm giảm cường độ màu. (màu sắc chuyển dần qua xám).

-	 Saturate: làm tăng cường độ màu (màu sắc rực rỡ).

Kết quả: hình ảnh sẽ thay đổi màu sắc khi rê chuột trên vùng hình ảnh.
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CHƯƠNG IV: LÀM VIỆC VỚI TEXT
Text là một thành phần không thể thiếu trong thiết kế.  Adobe Photoshop cho phép nhập text vào 
bản thiết kế bằng nhóm công cụ Text Tool (T) trong hộp công cụ, bao gồm 4 công cụ
 

•	 Horizontal Type Tool
•	 Vectical Type Tool
•	 Horizontal Type Mask Tool
•	 Vectical Type Mask Tool

Các loại text và phương pháp nhập text 

Adobe Photoshop cho phép tạo 2 loại text là Text thường và Paragraph Text. 

Text thường là loại text mà nếu bạn không nhấn Enter thì mãi mãi không xuống dòng mà cứ dài 
mãi theo nội dung được nhập; còn Paragraph Text là khối nội dung text được chứa trong một hộp 
chứa text (Text Box), khi chiều dài đoạn text lớn hơn chiều ngang của hộp chứa thì khối text sẽ bị 
xuống dòng bắt buộc.

Để nhập một đoạn text thường, bạn chọn công cụ Text  trong hộp công cụ, đưa trỏ chuột vào 
vùng ảnh mà bạn muốn nhập text, Click chuột trái và chờ tới khi có dấu nhắc nhấp nháy hiện ra 
tại điểm bạn đã click chuột, lúc này bạn có thể nhập nội dung đoạn text mong muốn vào bức ảnh.

Để nhập một Paragraph text, bạn chọn công cụ Text trong hộp công cụ, đưa trỏ chuột vào vùng 
ảnh mà bạn muốn nhập text, click và giữ phím trái chuột, đồng thời kéo rê chuột một đoạn để tạo 
ra một hộp chứa text (Text box), độ lớn nhỏ của hộp chứa phụ thuộc ý muốn của bạn, khi thấy hợp 
lý, nhả phím chuột ra. Lúc này, hộp chứa text đã được tạo, với hình dạng là một hình chữ nhật có 
đường viền đứt đoạn, có 8 điểm điều khiển hình vuông màu trắng bao quanh tại 4 góc và điểm giữa 
của 4 cạnh, cùng một dấu nhắc nhấp nháy trong hộp text, thoogn thường là ở góc trên bên trái của 
hộp; bạn có thể nhập nội dung text mà mình muốn vào trong hộp. 

Nội dung đoạn text thường hay khối Paragraph text được nhập vào sẽ thành một Text Layer và 
hiển thị trong Layer Panel với biểu tượng Thumbnail là một chữ T, đồng thời tên của layer sẽ không 
được đặt là Layer 1, Layer 2 như các layer chứa điểm ảnh thông thường khác, mà sẽ hiển thị đoạn 
đầu của nội dung vừa nhập.

Về định dạng của nội dung text được nhập như Font, Style, Size, Anti aliasing Method, Align, 
Color… sẽ theo mặc định hiện có trên thanh Options.

Nếu muốn thiết lập định dạng khác cho nội dung text, cần tiến hành lựa chọn và thiết lập các thông 
số mới trong các trường trên thanh Options trước khi nhập nội dung text.

Chỉnh sửa, định dạng nội dung text

Text là một dạng nội dung đặc biệt trong Adobe Photoshop, nó vừa text, có thể định dạng theo 
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kiểu text, vừa có thể áp dụng  một số thao tác chỉnh sửa như một layer điểm ảnh như transform, 
gán Layer style…

Chỉnh sửa theo kiểu Text

Để thực hiện định dạng hay chỉnh sửa nội dung theo kiểu text, ta cần chọn Text layer muốn chỉnh 
sửa, chọn công cụ Text trong hộp công cụ rồi nhấp chọn, bôi đen đoạn nội dung text cần chỉnh 
sửa. Lúc này thanh Options đã biến đổi để phù hợp với thao tác text, bạn có thể chọn lại Font, thiết 
lập các kiểu Style như Regular, Bold, Italic…, chọn lại Size, chọn hiệu ứng khử răng cưa cho text, 
gióng hàng cho text trái, phải, giữa hay chọn lại mầu cho text. Thao tác định dạng và chỉnh sửa này 
áp dụng chung cho cả 2 định dạng text thường và Paragraph text.

Nếu muốn chỉnh sửa và định dạng chi tiết hơn, bạn có thể sử dụng hộp thoại Character và  
Paragraph. Trong Adobe Photoshop, vào menu Window> Character, hộp thoại Character mở ra sẽ 
giúp bạn định dạng chi tiết hơn cho đoạn text.

Nếu bạn chỉ sửa một phần trong đoạn text được chọn thì bạn cần chọn text layer muốn sửa, sau đó 
chọn công cụ Text từ hộp công cụ, tiếp đó nhấp chuột vào vị trí bắt đầu của đoạn bạn muốn sửa và 
nhấn giữ phím chuột bôi đen đoạn đó, chọn và thiết lập các tham số mới cho đoạn text trong hộp 
Character. 

Nếu muốn thay đổi định dạng cho toàn bộ nội dung đoạn text hay toàn bộ khối Paragraph text, thì 
bạn chỉ cần nhấn chọn Text layer trong cửa sổ Layer, rồi lựa chọn và thay đổi các thông số trong 
hộp Character mà không cần phải làm thao tác bôi đen, chọn đoạn văn bản cần sửa.

Chỉnh sửa Text theo kiểu layer điểm ảnh

Trong Adobe Photoshop, Text layer được coi là dạng layer đặc biệt, nó không chấp nhận làm việc 
với vùng chọn như các layer điểm ảnh thông thường, và hầu như các công cụ trong hộp công cụ 
khi muốn sử dụng trên text layer đều hiện biển cấm, không thể làm việc.
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Text layer mặc dù là một dạng layer đặc biệt, nhưng bạn cũng có thể thực hiện một số thao tác 
giống như với một layer điểm ảnh thông thường ví dụ như bạn có thể thực hiện Transform, xóa 
layer, gán Layer Style cho text layer.

Bạn có thể chọn Text layer trong cửa sổ Layer, rồi nhấn Ctrl+T để transform cho text layer đó, hoặc 
vào menu Edit> Transform rồi chọn một lệnh cụ thể để điều chỉnh cho text layer đó giống như đối 
với một layer điểm ảnh thông thường.

Text (văn bản) 
Ta có thể dùng công cụ Text để tạo một nội dung văn bản, khi tạo xong, bạn sẽ dùng những hiệu 
ứng trên chữ nhằm tạo ra nét viền, tạo độ nổi, gán kết cấu Gradient... với nhiều hình thức đa dạng.

Nhóm công cụ Text:

Công cụ Horizontal Type Tool 

Công cụ tạo văn bản theo chiều ngang.

Thao tác thực hiện: 

•	 Chọn công cụ Horizontal Type Tool
•	 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) à Kích vào vị trí bất kỳ trên 

hình ảnh, nhập văn bản.
•	 Nội dung văn bản sẽ được đặt tại Layer mới

Công cụ Vertical Type Tool 

Công cụ tạo văn bản theo chiều dọc.

Thao tác thực hiện: 

•	 Chọn công cụ Type
•	 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) à Kích vào vị trí bất kỳ trên 

hình ảnh, nhập văn bản.

Các chức năng trên thanh Options:
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Toggle the Character and Paragraph Palettes:

•	 Font: chọn kiểu Font
•	  Style: kiểu thường, đậm, nghiêng

•	  Size: kích cỡ chữ

•	  Leading: khoảng cách dòng

•	  Kerning: Khoảng cách giữa hai ký tự (tại dấu nhắc, không cần quét chọn văn bản)

•	  Tracking: Khoảng cách giữa các ký tự

•	  Vertically Scale: co giãn văn bản theo chiều dọc

•	  Horizontally Scale: co giãn văn bản theo chiều ngang

•	  Set the baseline Shift: khoảng cách với đường nền ban đầu
•	 Color: màu văn bản
•	 Faux bold: làm đậm văn bản (bất kể chế độ đậm, nghiêng,… ở bên ngoài thanh option như 

thế nào). Lưu ý, khi sử dụng chức năng này thì không cho phép sử dụng chế độ Create Warped 
Text. 

•	 Faux Italic: tạo văn bản nghiêng (bất kể chế độ đậm, nghiêng,… ở bên ngoài thanh option như 
thế nào).

Paragraph Palette: thiết lập văn bản dạng đoạn

Tạo văn bản dạng đoạn: chọn một trong các công cụ text, kéo rê chuột để tạo một khung giới hạn 
đoạn văn bản, nhập văn bản vào bên trong khung này.
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•	 Left align text: canh trái văn bản.
•	 Center text: canh giữa văn bản.
•	 Right align text: canh phải văn bản.
•	 Justify last left: canh thẳng hàng hai bên, trừ dòng cuối cùng canh trái.
•	 Justify last centered: canh thẳng hàng hai bên, trừ dòng cuối canh giữa.
•	 Justify last right: canh thẳng hàng hai bên, trừ dòng cuối canh phải.
•	 Justify all: canh thẳng hàng hai bên bắt buộc, kể cả dòng cuối cùng.

Lưu ý:  Khi nhập văn bản (dạng Type) sẽ tự phát sinh một Layer riêng (Layer T). Riêng với các dạng 
Type mask thì chỉ là một vùng chọn trên Layer hiện hành. 

Đổi Layer văn bản thành hình ảnh (Layer thường)

•	 Click phải vào Layer văn bản à Chọn Rasterize Layer
•	 Menu Layer\ Rasterize\ Type

Công cụ Horizontal Type Mask Tool 

Công cụ tạo văn bản theo chiều ngang dạng mặt nạ vùng chọn.

Thao tác thực hiện: 

•	 Chọn công cụ Horizontal Type Mask Tool
•	 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) à Kích vào vị trí bất kỳ trên 

hình ảnh, nhập văn bản.
•	 Nội dung văn bản chỉ là vùng chọn, bạn phải tạo Layer mới để chứa văn bản.

Công cụ Vertical Type Mask Tool 

Công cụ tạo văn bản dọc dạng mặt nạ vùng chọn.
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Thao tác thực hiện: 

•	 Chọn công cụ Horizontal Type Mask Tool
•	 Xác lập một số định dạng trên thanh Options (Fonts, Size,…) à Kích vào vị trí bất kỳ trên 

hình ảnh, nhập văn bản.
•	 Nội dung văn bản chỉ là vùng chọn, bạn phải tạo Layer mới để chứa văn bản.

Biến dạng cho Text layer

Uốn  cong tức là cho phép làm biến dạng theo đủ loại hình dạng, chẳng hạn hình cung hoặc hình 
gợn sóng. Kiểu uốn được chọn là một thuộc tính của lớp chữ – có thể thay đổi kiểu uốn lớp bất 
cứ lúc nào cần hay thay đổi dạng uốn cong toàn thể. Tùy chọn uốn chữ giúp điều khiển chính xác 
hướng và phối cảnh của hiệu ứng.

Uốn cong Text

Thao tác thực hiện:

•	 Chọn layer chứa Text.
•	 Thực hiện một trong hai cách:

•	 Chọn công cụ Type, nhấp vào biểu tượng Create Warped Text  trên thanh Option.
•	 Chọn Layer > Type > Warp text.

Các tùy chọn trong hộp thoại
•	 Chọn kiểu uốn từ menu Style.
•	 Chọn hướng uốn Text: Horizontal hoặc Vertical.
•	 Chọn Blend định mức độ uốn Text.



Giáo trình Adobe Photoshop CC 130 Created by GiangPM

www.enterfocus.edu.vn

•	 Horizontal Distortion và Vertical Distortion áp dụng phối cảnh cho chữ.
•	 Nhấp OK.

Gỡ bỏ biến dạng
•	 Chọn Text Layer đã bị uốn.
•	 Chọn công cụ Type, và nhấp và Warp text trên thanh Option hoặc chọn Layer > Type > Warp text.
•	 Chọn None từ menu Style, và nhấp OK.

Đưa Text vào đường dẫn

Thông thường ta thấy Text được trình bày theo chiều ngang, đôi khi cũng thấy text được trình bày 
theo chiều dọc. Tuy khác nhau về chiều, song cả 2 kiểu trình bày trên đều có điểm chung là text 
chạy theo một Baseline là đường thẳng. Muốn có một đoạn text uốn theo ý muốn, bạn cần gán nó 
vào một đường dẫn. 

Thao tác thực hiện như sau: sử dụng công cụ Pen vẽ một đoạn cong tùy ý, sau đó chọn công cụ 
Text, đưa công cụ Text vào sát với đường Path vừa vẽ, khi thấy trỏ chuột đổi trạng thái thì click vào 
đường path, dấu nhắc nhập text sẽ bám vò đường path và nhấp nhấy, yêu cầu bạn nhập nội dung 
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đoạn text vào theo đường đẫn.Khi bạn nhập nội dung Text vào, nó sẽ bám trên đường Path như 
đoàn tàu chạy trên đường ray. Bạn vẫn có thể bôi đen để chỉnh sửa nội dung như với một đoạn text 
thông thường, bạn cũng có thể sử dụng công cụ Direct Path Selection để chọn đường Path và điều 
chỉnh nó, qua đó điều chỉnh luôn độ uốn lượn của đoạn text đang bám bên trên đường dẫn. Khi 
điều chỉnh thì bạn nhìn thấy Path, còn nếu bạn chỉnh xong rồi và bấm vào layer khác, đường Path 
sẽ tự động ẩn đi, chỉ còn nhìn thấy nội dung đoạn text.

Biến một Path khép kín thành Text Box Paragrapht:

Nếu sử dụng công cụ Text để tạo một Text Box thì nó luôn có dạng chữ nhật, như vậy cách trình 
bày sẽ hơi bị đơn điệu. Để làm phong phú thêm cho hình dạng Text Box, bạn có thể vẽ một Path 
khép kín có hình dạng bất kỳ, sau đó đưa công cụ Text vào bên trong Path, khi nào thấy hình dạng 
trỏ chuột biến đổi thành dấu nhắc bao quanh bởi một đường tròn đứt đoạn, bạn click chuột để biến 
đổi Path thành Text Box.
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CHƯƠNG V: LÀM VIỆC VỚI PATH

Khái niệm về Path 

Path là một đường hoặc một hình thể (shape) bất kỳ. Đường path có thể là đường path mở (hở) 
hoặc đóng (khép kín), và ta có thể chỉnh sửa đường Path theo ý muốn bằng các công cụ con bên 
trong hoặc kết hợp phím tắt.

Đường Path có thể sử dụng để cắt lọc hình ảnh, vẽ hình dáng đối tượng và có thể xuất sang sử dụng 
ở những chương trình khác…

Nhóm Công cụ Pen:

Công cụ Pen  

Công cụ để tạo đường Path.

Các chức năng trên thanh Options

Thao tác thực hiện:

•	 Chọn công cụ Pen Tool (P)
•	 Trên thanh Options của công cụ Pen, chọn chức năng Paths 

Vẽ các đoạn thẳng: kích xác định điểm bắt đầu, nhả chuột, di chuyển chuột đến vị trí thứ hai và 
nhấp chuột để kết thúc. Muốn vẽ đoạn thẳng liên tục bạn cứ lặp lại thao tác trên. Ta có thể bấm giữ 
Shift khi kích để vẽ được các đoạn thẳng đứng, ngang, hoặc xiên một góc 45o.
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Vẽ đường cong: Giống các loại bút vẽ Bézier của các chương trình đồ họa. Kích xác định điểm bắt 
đầu, nhả chuột, di chuyển chuột đến vị trí thứ hai và drag mouse về hướng của điểm node (nút) 
kế tiếp. Động tác này làm xuất hiện một tiếp tuyến (handle, tay nắm) và đường vẽ sẽ uốn theo tiếp 
tuyến tại các node (nút) đó. 
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Vẽ đối tượng kín: Lặp lại thao tác giống như trên nhưng muốn khép kín đường path khi vẽ xong 
bạn sẽ dời chuột đến điểm khởi đầu của đường path và thấy một vòng tròn nhỏ xuất hiện bên cạnh 
dấu hiệu ngòi bút và bạn nhấp chuột vào đó lúc này đường path của bạn sẽ được đóng kín và tự 
hủy chọn.

Công cụ Freeform Pen 

Vẽ đường Path bằng cách drag mouse tự do.
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Thao tác thực hiện: 

•	 Chọn công cụ Freeform Pen Tool (P)
•	 Nhấp giữ chuột và rê chuột để vẽ đường Path tự do

Công cụ Add Anchor Point 

Thêm node vào đường Path

Thao tác thực hiện:

•	 Chọn công cụ Add Anchor Point Tool (P)
•	 Nhấp lên trên đường Path để thêm node vào đường Path

Công cụ Delete Anchor Point  

Xoá node trên đường Path

Thao tác thực hiện:

•	 Chọn công cụ Add Anchor Point Tool (P)
•	 Nhấp tại vị trí node trên đường Path để xóa node trên đường Path

Công cụ Convert Point 

Hiệu chỉnh tay nắm, biến node gãy nhọn thành node trơn, mịn
Thao tác thực hiện:

•	 Chọn công cụ Convert Point Tool (P)
•	 Nhấp tại vị trí node cần chỉnh sửa thành node trơn mịn hoặc node gãy nhọn trên đường 

Path 

Công cụ Path Selection 

Dùng để chọn toàn bộ đường path để di chuyển.

Thao tác thực hiện:

•	 Chọn công cụ Path Selection Tool (A)
•	 Nhấp chọn đường Path và di chuyển cả đường Path đến vị trí bất kỳ

Công cụ Direct Selection 

Dùng để chọn điểm neo, node và di chuyển điểm neo, node.
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Thao tác:

Trong thực tế ta chỉ cần dùng công cụ pen khi muốn chỉnh sửa một đường path.
•	 Thêm node: Chọn công cụ pen và vẽ đường path, khi đưa con trỏ chuột vào đường path tại 

vị trí cần thêm node, nó sẽ tự động biến thành công cụ Pen+, nhấp chuột vào đường path để 
thêm node.

•	 Xóa bỏ node: Chọn công cụ pen và vẽ đường path, khi đưa con trỏ chuột tại node trên đường 
path cần xoá node, nó sẽ tự động biến thành công cụ Pen -, nhấp chuột vào từng node để xóa 
bỏ node.

•	 Chỉnh để biến node gãy nhọn thành node cong mịn: Nhấn giữ phím Alt và nhấp chuột vào 
node gãy nhọn đồng thời rê chuột để chỉnh sửa thành đường cong mịn. Bạn có thể di chuyển 
thanh điều khiền của node.

•	 Muốn di chuyển node: Nhấn giữ phím Ctrl và nhấp chuột vào node đồng thời rê chuột và di 
chuyển node tới vị trí bất kỳ.

•	 Để chuyển Path thành vùng chọn, ta bấm Ctrl+ Enter. Hoặc kích mouse phải, chọn chức năng 
“Make Selection…”

•	 Muốn vẽ tiếp một đường Path có sẵn, ta bấm giữ Ctrl + kích chọn đường Path, kích vào node 
cuối cùng, sau đó vẽ tiếp bình thường.

Làm việc với Path Palette 

Menu Window\ Path.

Path palette là nơi liệt kê và lưu trữ đường path.

Các đường path được thể hiện bằng một hình thu nhỏ với cái tên workpath

•	 New path: tạo path mới
•	 Delete path: xóa đường path
•	 Make selection: chuyển path thành vùng chọn
•	 Make work path: chuyển vùng chọn thành đường path
•	 Fill path with foreground color: tô màu nền cho đường path với màu foreground
•	 Stroke Path with Brush: tô đường viền cho path với các dạng Brush Brush (Chọn Path, chọn 

Brush Brush, chọn nét Brush à Kích biểu tượng “Stroke path with Brush”)
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Tất cả các thao tác của công cụ vẽ theo hình dạng đều sử dụng trên bảng Options.

Công cụ Rectangle 
 
Dùng để vẽ hình vuông, hình chữ nhật.
 

Công cụ Rounded Rectangle 
 
Dùng để vẽ hình chữ nhật góc bo tròn (xác định Radius thay đổi góc bo trên thanh Options)

Công cụ Ellipse 

Dùng để vẽ hình tròn, hình ellipse.

Công cụ Polygon 
 
Dùng để vẽ hình sao, hình đa giác (xác định số cạnh tại vị trí sides trên thanh Options)

Công cụ Line 

Dùng vẽ đường thẳng, nhấn giữ phím Shift sẽ vẽ được đường thẳng đứng hoặc đường thẳng ngang.

Công cụ Custom Shape 

Dùng để vẽ những hình tự chọn trong thư viện trên thanh Options.
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CHƯƠNG VI: LÀM VIỆC VỚI BỘ LỌC - FILTER
Adobe Photoshop cung cấp cho bạn một số lượng khổng lồ các bộ lọc để tạo các hiệu ứng đặc biệt 
cho bản thiết kế của bạn. Các bộ lọc này được chia ra thành các nhóm theo chức năng, bao gồm:

•	 Nhóm Artistic
•	 Nhóm Blur
•	 Nhóm Brush Strokes
•	 Nhóm Distort
•	 Nhóm Noise
•	 Nhóm Pixelate
•	 Nhóm Render
•	 Nhóm Shapen
•	 Nhóm Sketch
•	 Nhóm Stylize
•	 Nhóm Texture
•	 Nhóm Video
•	 Nhóm Other

Có 3 kiểu bộ lọc chính là:

•	 Bộ lọc một bước (One - Step filter)
•	 Bộ lọc tham số (Parameter filter)
•	 Bộ lọc ứng dụng mini (Mini - application filter)

Giải thích về 3 kiểu bộ lọc:

Bộ lọc một bước (One - Step filter): 

Áp dụng bô lọc không có sự điều khiển tham số của người sử dụng, kết quả là không thể can 
thiệp, người sử dụng chỉ có thể chọn bộ lọc rồi sử dụng, không thể thay đổi các tham số của 
bộ lọc. Ví dụ như bô lọc Blur...

Bộ lọc tham số (Parameter filter): 

Cho phép bạn định rõ các giá trị tại các trường  hay tại các con trượt trước khi nhấp OK để 
áp dụng bộ lọc. Đa phần các bộ lọc trong Adobe Photoshop đều thuộc dạng này.

Bộ lọc ứng dụng mini (Mini - application filter)

Là bộ lọc cho phép người dùng lưu và gọi lại các xác lập, tạo ra môi trường riêng bên trong 
Photoshop. Nhiều bộ lọc của bên thứ ba (tức là bộ lọc không phải của Adobe) là dạng này.

Loại bộ lọc

Các bộ lọc có thể được phân chia thành nhiều loại chung. Hai loại cơ bản nhất là  Production và 
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Special Effects. Bộ lọc hướng sản xuất được dùng để chỉnh màu hoặc hiệu chỉnh tiêu điểm giúp 
chuẩn bị hình ảnh để in. Bộ lọc hiệu ứng đặc biệt thay đổi hình ảnh theo cách thức không hiện 
thực. Loại này  còn được chia nhỏ thành các loại sau:

•	 Pre-Press: bộ lọc giúp chuẩn bị hình ảnh để in
•	 Special Effects: mục đích thay đổi hình ảnh theo chiều hướng nghệ thuật hơn là hiện thực
•	 Color Change: thay đổi các giá trị màu trong hình ảnh
•	 Deformation: thay đổi dạng hình học của hình ảnh bằng cách uốn, vặn, thu nhỏ vv...
•	 Displacement: sử dụng hình ảnh khác hoặc một thuật toán cài sẵn làm ánh xạ để điều khiển 

sự biến dạng hình ảnh gốc. Làm cho hình ảnh đó có dáng vẻ như được chiếu qua kiểu bề mặt 
khác, chẳng hạn như nước hay thủy tinh...

•	 Destructive: thay thế hình ảnh với hiệu ứng riêng, hình ảnh gốc không tác động đến kết quả lọc.
•	 Distressed: hình ảnh gốc thay đổi hiệu ứng bộ lọc, nhưng hình ảnh được lọc không dễ nhận 

biết được.
•	 Focus: thay đổi tiêu điểm của hình ảnh, làm cho hình ảnh trở nên nhòe hơn hay sắc nét hơn.
•	 Stylizing: tạo hiệu ứng trừu tượng và tạo phiên bản cách điệu hóa của ảnh gốc.
•	 Texture: tạo mẫu kết cấu chất liệu
•	 3D: tạo chiều thứ 3 cho hình ảnh.

Chế độ màu được chấp nhận

Bộ lọc có thể làm việc trên chế độ màu RGB, Grayscale, CMYK, hoặc chế độ màu Lab - hoặc chỉ 
trên một vài chế độ trong số đó. Hình ảnh Bitmap hay Index Color không thể lọc được. Đôi khi 
Filter không thể sử dụng, bởi ảnh bạn muốn xử lý đang ở hệ màu 16-bit hay 32-bit, bạn cần chuyển 
về 8-bit. Bộ lọc luôn làm việc với hệ màu RGB, nhưng với hệ màu CMKY thì chỉ một thiểu số các 
bộ lọc chấp nhận làm việc; do đó nếu vẫn muốn áp dụng bộ lọc cho các ảnh, bạn phải convert 
chúng sang hệ màu RGB.

Kiểu xem trước
 
Sẽ luôn luôn hữu ích khi có khả năng xem xét hiệu ứng lọc trước khi quyết định áp dụng bộ lọc 
đó vào hình ảnh. Điều này đặc biệt quan trọng khi bạn sử dụng bộ lọc dạng tham số, vì nó giúp 
bạn lựa chọn các xác lập thích hợp và rút ngắn thời gian thi hành. Nhiều bộ lọc trong Photoshop 
có khung xem trước - tức là vùng trong hộp thoại của bộ lọc đang sử dụng cho phép bạn quan sát 
những thay đổi của hình ảnh khi áp dụng bộ lọc đó. Các bộ lọc thuộc dạng One - Step không có 
khung xem trước.

Dưới đây là một số kiểu xem trước của bộ lọc:

•	 Không có (None): Bộ lọc không có khung xem trước
•	 Một phần (Small Filter Preview): Có một vùng nhỏ trong hộp thoại hiển thị một phần nhỏ 

của hình ảnh khi được áp dụng bộ lọc.
•	 Toàn phần (Full Image Preview): Ngoài khung xem trước nhỏ, bạn có thể xem các kết quả 

trên ảnh gốc. Cả khung xem trước nhỏ và ảnh gốc đều được cập nhật khi bạn thay đổi các xác 
lập tham số.

•	 Khung dây (Wireframe Preview): Sơ đồ biểu thị đường dẫn biến dạng sẽ được sử dụng để 
lọc hình ảnh. Bạn không xem được màu hoặc dữ liệu hình ảnh.
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Phụ thuộc dữ liệu

Hầu hết các bộ lọc đều cần “nguyên liệu” ban đầu là các điểm ảnh để hoạt động, tức là nếu bạn cho 
bộ lọc áp dụng trên một layer trong suốt không có điểm ảnh (Blank Layer) thì không có kết quả gì 
xảy ra

Làm việc với  Filter Gallery

Kể từ phiên bản Adobe Photoshop 5.5 về trước, việc áp dụng một bộ lọc cho ảnh diễn ra độc lập, 
không có sự liên quan, không thể so sánh được giữa các bộ lọc trong cùng một nhóm thì bộ lọc nào 
đạt hiệu quả cao, hợp lý nhất. Muốn so sánh kết quả giữa các bộ lọc với nhau, người sử dụng chỉ có 
cách nhân bản nhiều ảnh giống nhau, hoặc nhân bản nhiều layer, mỗi layer áp dụng một bộ lọc rồi 
bật tắt các layer để quan sát và so sánh, hầu tìm kiếm bộ lọc hợp lý nhất cho từng trường hợp cụ thể.

Người sử dụng bắt đầu gặp Filter Gallery ở phiên bản Adobe Photoshop 6.0.

Filter Gallery thực sự là một cải tiến đáng giá, giúp cho người sử dụng có một cái nhìn tổng quan và 
toàn diện hơn rất nhiều về Filter trong Photoshop. Khi một người muốn áp dụng một bộ lọc cho bức 
ảnh, tất nhiên người đó muốn tạo ra một hiệu quả hợp lý và đẹp mắt nhất. Nhưng làm thế nào để 
biết đâu là bộ lọc hợp lý nhất, hiệu qua nhất trong số rất nhiều bộ lọc Adobe Photoshop cung cấp?

Giao diện làm việc của Filter Gallery cho phép người sử dụng quan sát trước hiệu quả mà một bộ 
lọc đem lại cho bức ảnh, nó cung cấp các tùy biến cho phép tìm hiểu sự biến thiên của bộ lọc khi 
thay đổi các tham số, nó cũng cho phép người sử dụng chuyển sang một bộ lọc khác, so sánh kết quả 
đạt được giữa các bộ lọc với nhau để tìm ra một bộ lọc đem lại hiệu quả hợp ý họ nhất... sau đó mới 
quyết định sử dụng bộ lọc nào.

Một số các nhóm bộ lọc vẫn giữ cách làm việc đơn lẻ theo kiểu cũ như nhóm Blur, Noise, Render, 
Shapen, Video, Other. Tuy nhiên một số nhóm bộ lọc khác như Artistic, Brush Strokes, Distort, 
Sketch, Stylize, Texture hiện diện trong cửa sổ Filter Gallery; khi áp dụng một bộ lọc nào thuộc một 
trong các nhóm trên thì nó sẽ hoạt động trong cửa sổ Filter Gallery. 

Một số nhóm có tên trong danh sách của Filter Gallery, nhưng chỉ có một số ít các Filter thuộc 
nhóm có mặt trong cửa sổ Filter Gallery; ví dụ nhóm Distort có trong danh sách Filter Gallery 
nhưng chỉ có 3 Filter trong nhóm có tên là Diffuse Glow, Glass và Ocean Ripple còn các Filter khác 
trong nhóm vẫn giữ cách hoạt động độc lập như cũ.

Khi áp dụng bộ lọc trong cửa sổ Filter Gallery, người sử dụng có thể quan sát trực tiếp sự biến đổi 
của bức ảnh trong cửa sổ Preview lớn bên phía trái, chọn nhóm Filter theo chức năng biến đổi và 
chuyển đổi qua lại giữa các Filter trong nhóm, hoặc qua nhóm khác ở phần danh sách bố trí ở giữa 
cửa sổ Filter Gallery, nếu muốn tùy chỉnh để tìm hiểu kỹ về một Filter nào đó, người sử dụng có thể 
thay đổi các tham số của Filter đang chọn trong phần tùy biến hiển thị ở bên phải.

Để áp dụng  Filter cho một vùng chọn, một layer hay cho một đối tượng như Text, Shape Layer hay 
Smart Object, bạn cần chọn layer hay đối tượng muốn áp dụng Filter, sau đó hoặc vào menu Filter, 
chọn một nhóm Filter rồi gọi một Filter cụ thể trong đó. Cách này thường chỉ những người đã khá 
quen thuộc với tính năng của Filter sử dụng; còn nếu bạn là một người mới bắt đầu làm quen với 
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Filter, hay đang muốn so sánh hiệu quả của các Filter trước khi quyết định sử dụng thì bạn nên 
chọn menu Filter> Filter Gallery rồi nhấn chọn từng Filter, quan sát, thử nghiệm, so sánh trước khi 
áp dụng một Filter cho hiệu quả tốt nhất với công việc mà bạn muốn thực hiện.

Bạn có thể quan sát hình dưới để tìm hiểu giao diện của Filter Gallery.

•	 Filter Preview: Đây là khung xem trước Bộ lọc sẽ thay đổi thế nào với ảnh của bạn.
•	 Filter List: Đây là danh sách các Filter mà Photoshop có sẵn, bạn có thể click xem Preview 

trước về ảnh để hiểu thêm về các bộ lọc này.
•	 Currently Selected Filter: Bộ lọc đang được chọn
•	 Filter Options: Tùy biến Filter.
•	 Effect Layers: Thông báo Layer hiệu ứng đang sử dụng trên vùng ảnh
•	 New / Delete Effect Layer: Thêm hoặc xóa Layer hiệu ứng.

Nhóm Artistic
Các bộ lọc trong nhóm Artistic áp các hiệu ứng nghệ thuật vào bức ảnh của bạn, biến một tấm ảnh 
bình thường thành các bức ảnh mô phỏng các chất liệu như chì màu, màu nước, sơn dầu...hay tạo 
các hiệu ứng phá cách lạ mắt cho bức ảnh. 

Các bộ lọc trong nhóm này chỉ hoạt động trên nền ảnh RGB, không làm việc trên nền CMYK hay 
Lab. Ngoài ra chúng cũng không làm việc trên một nền trắng. Đây là nhóm bộ lọc tham số có nghĩa 
là có tham số để bạn có thể thay đổi, từ đó làm thay đổi kết quả nhận được sau khi áp dụng bộ lọc. 
Mọi bộ lọc trong nhóm đều ở có ảnh xem trước dạng một phần (Small Filter Preview) trong hộp 
thoại bộ lọc chứ không có khung xem trước hình ảnh toàn phần (Full Image Preview).
Bộ lọc Colored Pencil 
Bộ lọc Colored Pencil lấy hình ảnh hoặc vùng chọn và cách điệu hoá vùng đó theo các nét chì màu 
được cho là giống nhau trên giấy trung hoà (đen đến trắng). Thực tế, bộ lọc này dùng các màu trội 
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trong hình ảnh và loại bỏ những vùng nó sẽ biến đổi thành “màu giấy” tuỳ thuộc vào các xác lập 
tham số. Bộ lọc để lại một kiểu vẽ gạch chéo khá hấp dẫn nhưng không giống nét vẽ bút chì cho 
lắm. Nếu có chăng nữa thì hầu như tương tự tranh sơn dầu được dát bằng dao trộn sơn dầu và 
đường viền mờ.

Pencil Width: có thể thay đổi từ 1 đến 24. tham số này điều khiển kích cỡ màu Background qua 
lớp hình ảnh. Ở giá tri 1, hình ảnh hầu như nguyên vẹn nên có thể nhìn thấy rõ vết cào xước của 
Background. Ở giá trị 24, hình ảnh bị chia thành các vùng lởm chởm không đều nhau. Tựa như 
màu Pencil được dùng thật ra là xác lập “màu giấy” thực sự, và bạn ấn định bề rộng nét chì bằng 
cách dùng xác lập Pencil Width. Bạn có thể kéo con trượt này ở vị trí bất kỳ dọc theo chiều dài, mặc 
dù nếu bạn định giá trị Pencil Width hơi cao (ít nhất phải lớn hơn 3) thì chi tiết trên một ảnh lớn 
(ảnh có độ phân giải cao và có nhiều điểm ảnh) sẽ được tái tạo tốt hơn.

Hình gốc Hình áp dụng bộ lọc Colored Pencil
Stroke Pressure: có thể thay đổi từ 0 đến 15. Tham số này điều khiển cường độ màu trong hình 
ảnh. Khi Stroke Pressure là 0, không có hình ảnh được tạo ra - bất kể các xác lập khác. Khi giá trị 
là 15, độ chói ban đầu của hình ảnh được bảo lưu. Khi Stroke Pressure là 1, sẽ biểu hiện màu đội 
chút trong các vùng sáng nhất của hình ảnh và không hoàn toàn không có màu ở các vùng tối nhất 
của ảnh.

Paper Brightness: thay đổi từ 0 đến 50. Giá trị độ chói là 0, làm cho màu giấy biến thành đen; độ 
chói là 50 làm cho hình ảnh có màu background ở Toolbox. Paper Brightness có giá trị 25 là hỗn 
hợp của hai hiệu ứng trên. Nếu màu Background của bạn là trắng, nên dùng Brightness ở giá trị 0 
hoặc 50, các giá trị trung gian sẽ làm xỉn màu của hình ảnh.

Bộ lọc Cutout
Bộ lọc Cutout được cải tiến từ lệnh Posterize, đơn giản hoá các màu trên hình ảnh thành một số 
cấp độ theo yêu cầu. Nhưng Cutout sử dụng các màu từ ảnh gốc - thay vì không gian màu “nguyên 
thuỷ” (RGB hoặc CMYK) như ở lệnh Posterize. Đó là bộ lọc “thông minh “ theo ý nghĩa nó tìm 
kiếm các hình dạng để đơn giản hoá, và khử răng cưa ranh giới nơi các màu gặp nhau.

Number of Levels: có thể thay đổi từ 2 đến 8. Tham số này điều khiển số lượng các màu trong hình 
ảnh được lọc. Ở xác lập thấp nhất, tham số này tìm hai cấp độ màu trong hình ảnh được lọc. Tuy số 
lượng màu này đơn giản hoá hình ảnh ở mức độ đáng kể, nhưng đây vẫn là một con số có ý nghĩa.

Edge Simplycity: có thể thay đổi từ 0 đến 10. Ở các xác lập cao hơn, các mép được đơn giản đến 
mức không còn nữa; bộ lọc tạo ra một khối màu thuần nhất. Các xác lập tốt nhất cho tham số này 



Giáo trình Adobe Photoshop CC 145Created by GiangPM

www.enterfocus.edu.vn

dường như biến thiên trong khoảng từ 0 (chi tiết cao nhất ở mép) cho đến 5.

Hình gốc Hình áp dụng bộ lọc Cutout 
Edge Fidelity: có thể thay đổi từ 1 đến 3. Tham số này có vẻ như không tác động đến hình ảnh 
nếu Edge Fidelity được cài đặt là 0. Tuy nhiên, nếu Edge Simplycity được cài đặt là 5, bạn sẽ thấy 
sự khác biệt ở các đường viền của các hình dạng bằng cách thay đổi vị trí con trượt Edge Fidelity. 
Giá trị là 1 sẽ tạo đường viền rất trừu tượng (tương tự xác lập auto trace tự do trong chương trình 
vecto). Giá trị 3 sẽ bắt giữ đường viền của vùng đó càng thật, càng tốt.

Bộ lọc Dry Brush
Bộ lọc Dry Brush mô phỏng kỹ thuật vẽ cọ khô truyền thống, hiệu ứng này làm cho đường viền bị 
răng cưa và sắc nét, mặc dù việc che bóng bên trong vẫn giữ các biến thể và các bóng nhoè.

Hình gốc Hình áp dụng bộ lọc Dry Brush
Brush Size: có thể thay đổi từ 0 đến 10. Nó điều khiển kích cỡ các vết cọ (nét bút) với 10 là lớn nhất.
Brush Detail: có thể thay đổi từ 0 đến 10. Nó quyết định mức độ chi tiết được bắt giữ từ hình gốc. 
Với giá trị là 10, các chi tiết hầu hết được bắt giữ.

Xác lập Texture: có thể thay đổi từ 1 đến 3. Giá trị 1 tao ra ảnh dịu. Giá trị 3 tạo ra ảnh chứa các bit 
màu không có ở vị trí đó trong ảnh gốc, nó thêm các điểm ảnh vào hình ảnh.

Bộ lọc Film Grain
Bộ lọc Film Grain là bộ lọc Noise được kết hợp với logic để làm sáng và tăng cường các phần của hình 
ảnh. Bộ lọc Add Noise có thể làm biến dạng hình ảnh với nhiễu. Ngay cả khi ở cài đặt cao nhất cũng 
không gây ra tai hoạ. Hơn nữa, bộ lọc Film Grain cho phép bạn định rõ một vùng sáng và cường độ 
có thể thêm nhiễu cho các vùng tối của hình ảnh nhiêù vùng sáng hơn. Bộ lọc này cho hình ảnh khá 
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đẹp khi được dùng cho các ký tự (trên hình ảnh). Ở các xác lập thấp nhất, bộ lọc Film Grain không 
tạo bất cứ hiệu ứng gì. Bộ lọc dường như làm phẳng màu trong hình ảnh - xác lập Grain càng cao, các 
màu càng phẳng.

Hình gốc Hình áp dụng bộ lọc Film Grain

Grain: điều khiển lượng nhiễu được bổ sung và có thể thay đổi từ 1 tới 20.

Hightlight Area: có thể thay đổi từ 1 tới 20 điều khiển phạm vi hình ảnh được chiếu sáng chỉ có 
vùng hình ảnh nơi sáng hơn được bão hoà hởn trong hình ảnh gốc mới được chiếu sáng.

Intensity: thay đổi từ 0 đến 10, điều khiển cường độ chiếu sáng xảy ra. Nếu tham số này được xác lập 
là 0, thì dù bạn định Hightlight Area ở giá trị là bao nhiêu cũng không quan trọng. Với Intensity lớn 
hơn, hiệu ứng hạt trên film giảm đi một cách đáng kể trong các vùng có cường độ chiếu sáng cao.

Bộ lọc Fresco
Bộ lọc Fresco làm tăng cường độ tương phản và làm cho các vùng tối đậm hơn. Bộ lọc Fresco có 
cùng các điều khiển như bộ lọc Dry Brush. Mọi xác lập trong bộ lọc này đều tao ra hình ảnh hữu 
dụng. Bộ lọc Fresco rất tốt để làm trừu tượng một hình ảnh và làm sắc thêm độ tương phản. Các 
màu trở nên rất đậm.

Hình gốc Hình áp dụng bộ lọc Fresco
Brush Size: có thể thay đôỉ từ 0 đến 10, điều khiển kích cỡ các vệt cọ vẽ, với 10 là lớn nhất.
Brush Detail: quyết định có bao nhiêu chi tiết được giữ từ ảnh gốc. Nó thay đổi từ 0 đến 10. Giá trị 
10 sẽ giữ nguyên hầu hết các chi tiết.

Xác lập Texture: thay đổi từ 1 đến 3. Với giá trị 1, Texture cho ảnh nhẵn nhụi, với giá trị 3 tạo ra 
hình ảnh chứa một ít màu không có ở vị trí đó trên hình ảnh gốc. Nó thêm các đốm điểm ảnh cho 
hình ảnh.
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Bộ lọc Neon Glow
Bộ lọc Neon Glow tạo nên tông màu nhị tông hoặc tam tông lạ lùng từ hình ảnh tuỳ thuộc vào các 
lựa chọn màu của bạn.

Size: có thể biến thiên trong khoảng - 24 đến + 24.

Brightness: có thể thay đổi từ 0 đến 50. Với Brightnes nhỏ hơn 7, bạn không nhận được kết quả bất 
kể gí trị xác lập Size là bao nhiêu. Khi Size là số âm, bạn có hình ảnh âm bản.

Cài đặt Color tương tác với các xác lập Brightness và Size. Xác lập Size là 0, các vùng sáng nhất 
trong hình ảnh sẽ biểu thị màu trong Color.

Hình gốc Hình áp dụng bộ lọc Neon Glow

Bộ lọc Paint Daubs
Bộ lọc này được giả thiết là để tạo dáng vẻ tựa như các đốm màu vẽ. Nhưng thật ra không phải như 
vậy. Tuy nhiên, ở đây có nhiều cài đặt, đưa ra các kết quả thú vị - thậm chí có vẻ không phù hợp 
với tên bộ lọc này. 

Logic của bộ lọc này dường như là sự giao thoa giữa bộlọc Dust & Scratches với Radius là 16 và 
Threshold là 0 (tức là các vùng nhoè màu) với bộ lọc Unsharp Mask. Nó tựa như bạn có thể chọn 
một lượng làm sắc nét bạn muốn sau khi hình ảnh đã được chia thành các vùng màu. Bộ lọc Paint 
Daubs còn có thể chọn một cọ vẽ thực hiện tiếp các kỳ diệu toán học trên bộ lọc đó. Bộ lọc làm việc 
tốt trên toàn bộ hình ảnh để cách điệu hoá và làm trừu tượng hoá hình ảnh đó.

Hình gốc Hình áp dụng bộ lọc Paint Daubs với cọ dạng Simple



Giáo trình Adobe Photoshop CC 148 Created by GiangPM

www.enterfocus.edu.vn

Hình áp dụng bộ lọc Paint Daubs với cọ dạng Light Rough Hình áp dụng bộ lọc Paint Daubs với cọ dạng Dark Rough

Hình áp dụng bộ lọc Paint Daubs với cọ dạng Wide Sharp Hình áp dụng bộ lọc Paint Daubs với cọ dạng Wide Blurry

Hình áp dụng bộ lọc Paint Daubs với cọ dạng Sparkle

Khi Brush Size và Sharpening ở khoảng giữa, cọ vẽ Sparkle dường như cho cùng kết quả tựa như 
bạn đã dùng bộ lọc Gaussian Blur và bộ lọc Find Edges và sau đó làm sắc nét các mép này. Đó là 
một dáng vẻ thú vị.

Các khoảng giữa của các cài đặt Brush Size và Sharpness dường như là hiệu quả nhất. Nếu bạn cài 
đặt cả Brush Size và Sharpness quá thấp, bạn sẽ thấy không có thay đổi gì trong hình ảnh của bạn.

Brush Size: thay đổi từ 1 đến 50. Brush Size điều khiển kích cỡ các vùng khối màu.
Sharpness: có thể thay đổi từ 0 đến 40. Sharpness điều khiển lượng sắc nét được áp dụng.
Brush Type: các loại cọ Simple, Light Rough, Dark Rough, Wide Sharp, Wide Blurry, và Sparkle. 
Các cọ vẽ Rough thường tạo nhiễu.
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Bộ lọc Palette Knife
Bộ lọc Palette Knife có thể làm cho hình ảnh của bạn có dáng vẻ tựa như đã được vẽ bằng dao pha 
màu - nếu bạn chọn các cài đặt đúng và muốn sử dụng dao pha màu, chừa lại màu vẽ hoàn toàn 
phẳng trên vải vẽ.

Bộ lọc cho hiệu ứng tựa như bạn đã quệt các vết màu lên vải vẽ đã được vẽ lót bằng màu đen. Các 
vùng bóng tối nhất trở nên đen hoàn toàn và hình ảnh tựa như tăng thêm độ bão hoà. Bộ lọc có 
thể giúp làm tăng cường đồ hoạ nghệ thuật đường nét đơn giản. Bộ lọc khá tốt cho toàn bộ hình 
ảnh hoặc khi bạn muốn dùng bộ lọc Crystallire. Đó có thể là bộ lọc tốt nhất cho việc tạo hoạ tiết ở 
Stroke Sire lớn. Nó cũng kết hợp tốt với bộ lọc Emboss.

Stroke Size: thay đổi từ 1 đến 50, nhưng với các kích cỡ lớn sẽ làm mất mọi chi tiết trong hình ảnh 
và chỉ còn các vệt màu. Với các kích cỡ Stroke Sizes nhỏ nhất không có sự thay đổi. Stroke Size 
khoảng 12 là lựa chọn tốt để giữ chi tiết hình ảnh.

Hình gốc Hình áp dụng bộ lọc Palette Knife

Stroke Detail: điều khiển là hình dạng các vệt vẽ, biến thiên trong khoảng từ 1 đến 3. Với giá trị 1, 
các màu được áp dụng tựa như bạn dùng bộ lọc Crystallire. Với giá trị 3, bạn sẽ thấy hiệu quả cọ 
vẽ khô, có tính hấp dẫn cao.

Softness: điều khiển lượng Anti - aliasing trên các mép của các vệt vẽ. Xác lập này trong khoảng 0 
đến 10. 0 rất sắc nét, còn 10 thì rất nhoè ở mép.

Bộ lọc Plastic Wrap
Bộ lọc Plastic Wrap giúp tăng cường đồ hoạ nghệ thuật đường nét đơn giản. Bộ lọc này khá tốt khi 
được dùng cho các ký tự.

Nếu bạn lọc một hình ảnh mầu đậm theo các xác lập cao nhất, bạn sẽ nhận được dạng ngôi sao. Lọc 
lại lần nữa tạo ra một đóm chất dẻo rất thú vị. Nếu lấy một phần của đốm này và tạo mẫu hoa văn 
không có đường nối, bạn có thể nhận được một dáng vẻ tựa như bản đồ mấp mô.

Highlight Strength: biến thiên trong khoảng từ 0 đến 20. Phải lớn hơn 0 mới xảy ra thay đổi trên 
hình ảnh, bất chấp các xác lập khác. Highlighth Strength điều khiển lượng phản chiếu bạn nhận 
được từ Plastic Wrap.

Detail: xác định mức độ “bám chặt” Plastic Wrap với các chi tiểt trong hình ảnh.
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Smoothness: dường như điều khiển độ dầy màng chất dẻo. Smoothness bằng 1 sẽ chỉ cho kết quả 
có vẻ nhân tạo và ít hữu dụng; Smoothness bằng 15 làm nhoè hình ảnh, chôn vùi hình ảnh trong 
chất dẻo.

Hình gốc Hình áp dụng bộ lọc Plastic Wrap

Bộ lọc Poster Edges
Bộ lọc Poster Edges phân tích hình ảnh theo các màu riêng của hình ảnh và bổ sung chi tiết đen 
xung quanh các mép. Mọi xác lập đều tạo ra các thay đổi có thể nhìn thấy được trong hình ảnh.
Edges Thichness: điều khiển mức độ đen xung quanh các mép của hình ảnh (Edges ở đây được 
dùng như trong bộ lọc Find Edges). Độ biến thiên của Edges Thickness xê dịch từ 0 đến 10. Giá trị 
0 không có đường mép.

Edges Intensit: điều khiển số lượng các đường viền tìm được. Giá trị 0 chỉ tìm các vùng tối chính, 
tạo hình và tăng cường độ các bóng đen xung quanh chúng. Edges Intensity bằng 10 sẽ tìm thấy 
nhiều đường viền hơn - nếu Edges Thickness được định một giá trị đủ thấp.

Xác lập Posterization: làm việc theo chiều ngược laị. Giá trị 0 tạo nhiều đường viền nhất, và giá trị 
6 tạo ra ít nhất.

Hình gốc Hình áp dụng bộ lọc Poster Edges

Bộ lọc Rough Pastels

Bộ lọc   có thể giúp cải thiện ảnh nét trắng đen đơn giản và tạo hiệu ứng đẹp mắt cho các ký tự. Bộ 
lọc Rough Pastels rất hiệu quả khi cần tạo các cấu trúc hoa văn trên hình ảnh trắng được điền đầy 
với nhiễu nhẹ đến vừa.
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Hình gốc Hình áp dụng bộ lọc Rough Pastels

Xác lập Stroke Length(độ dài nét vẽ): thay đổi từ 0 đến 24. Khi Stroke Length và Stroke Detail được 
xác lập đến các giá trị cực đại là 40 và 20 hình ảnh này có dáng vẻ tựa như được quét tới lui theo 
đường chéo ngang qua canvas với rất nhiều màu khi bút vẽ phấn màu quẹt chéo xuống. Với Stroke 
Length được kéo trở lại giá trị 0, những đường chéo dài bị đứt đoạn, nhưng sự đa màu vẫn được 
duy trì.
Stroke Detail: có thể thay đổi trong khoảng 0 đến 20. Khi Stroke Detail bằng 1, nhưng Stroke 
Length vẫn ở 40, nét vẽ phấn màu dường như cho giá trị tối hơn trong hình ảnh và dịch chuyển 
qua hình ảnh các đường ngang lẫn đường chéo. Nếu tạo cac Stroke Length ngắn hơn sẽ cắt bớt các 
đường ngang.

Một số xác lập liên quan đến vân cấu trúc được áp dụng:

Texture: bao gồm Brick, Burlap, Canvas và Sandstone, nhưng cũng có thể tải cấu trúc riêng của 
mình từ một tập tin trên Photoshop.

Scaling: có thể được lập tỷ lệ từ 50 đến 200%.

Relief: có giá trị trong khoảng 0 đến 50. Giá trị này tạo độ nổi hoặc hiệu ứng ba chiều cho kết cấu.
Light Derection(hướng chiếu sáng): bạn có thể chọn góc độ bất kỳ. Bạn cũng có thể đảo ngược kết 
cấu này nếu muốn đảo ngược hiệu ứng chạm nổi.

Bộ lọc Smudge Stick

Bộ lọc Smudge Stick tạo hiệu ứng trông tựa như bạn cầm miếng giẻ chà lên bản vẽ hoặc bôi bẩn lên 
bản vẽ phấn màu. Với mọi xác lập ở các gía trị tối thiểu hình ảnh chỉ hơi bị nhoè hoặc vấy bẩn. Các 
màu bị giảm và bị chà lẫn vào nhau. Bộ lọc Smudge Stick là bộ lọc tạo vân kết cấu rất tốt khi được 
dùng trên hình ảnh trống đã được bổ sung thêm các nhiễu.

Stroke Length: thay đổi từ 1 đến 10 và quyết định chiều dài quãng đường bạn “đẩy miếng giẻ” trước 
khi nới lỏng áp lực. Giá trị Stroke Length nhỏ sẽ làm tăng cường độ vùng tối trên hình ảnh.

Highlight Area: có thể thay đổi từ 1 đến 20 và cho phép bạn tăng cường độ vùng sáng trong hình 
ảnh khi bôi bẩn các vùng tối.
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Inensity: thay đổi từ 1 đến 10, quyết định mức độ khả kiến của vùng Highlight. Xác lập cao làm 
tăng độ chói trong hình ảnh, đặc biệt khi chọn Highlỉght Area với giá trị lớn. Nếu xác lập Highlight 
Area với giá trị lớn nhưng xác lập Inensity với giá trị thấp, bạn sẽ không thấy được hiệu ứng vùng 
sáng này.

Hình gốc Hình áp dụng bộ lọc Smoudge Stick

Bộ lọc Sponge
Bộ lọc Sponge trông tựa như ai đó chấm nhẹ sơn lên hình ảnh. Lượng sơn và kích cỡ miếng bọt xốp 
có thể điều khiển được. Đây là một trong nhiều bộ lọc cách điệu hoá thành công.

Brush Size: thay đổi trong khoảng 1 đến 10. Brush Size điều khiển kích cỡ miếng bọt xốp.

Definition: có thể thay đổi từ 0 đến 25. Definition điều khiển độ chênh lệch giá trị của Sponge với 
hình ảnh phía sau. Nếu định Definition cao làm cho các màu được chấm lên hình ảnh bằng miếng 
bọt có giá tri tối hơn hình ảnh gốc.

Smoothness: thay đổi từ 1 đến 15. Xác lập Smoothness quyết định mức độ răng cưa của đường viền 
nét chấm bằng bọt xốp. Smoothness thấp, đường viền bị răng cưa thấy rõ; Smoothness cao, đường 
viền được khử răng cưa và trở nên nhẵn nhụi.

Hình gốc Hình áp dụng bộ lọc Sponge
  
Bộ lọc Underpainting
 Khó có thể nói hết về công dụng của bộ lọc Underpainting. Sử dụng kết cấu Canvas và cọ vẽ cỡ nhỏ 
với xác lập Texture Coverage cao nhất, bạn nhận một ảnh thực đến mức bạn nghĩ rằng sơn vẫn còn 
ướt. Hình ảnh hoàn toàn trông tựa như bạn đã phác thảo các chi tiết với sơn mỏng trên vải vẽ. Nó 
còn giúp cải tiến một ảnh nét trắng đen đơn giản.



Giáo trình Adobe Photoshop CC 153Created by GiangPM

www.enterfocus.edu.vn

Áp dụng bộ lọc Underpainting với chất liệu Sandstone Áp dụng bộ lọc Underpainting với chất liệu Brick

Áp dụng bộ lọc Underpainting với chất liệu Burlap Áp dụng bộ lọc Underpainting với chất liệu Canvas

Brush Size: thay đổi từ 0 đến 40. Nếu dùng giá trị Brush Size lớn, diện tích được phủ bởi cọ vẽ sẽ 
không cho thấy kết cấu, do vậy lớp sơn phủ bị đốm mạnh.
Texture Coverage: có thể thay đổi trong khoảng từ 0 đến 40. Nếu cả hai xác lập Texture Coverage 
và Brush Size đều thấp, kết cấu xuất hiện bị thu nhỏ bớt.

Texture bao gồm: Brick, Burlap, Canvas, và Sandstone, nhưng bạn cũng có thể tải kết cấu riêng của 
mình từ một tập tin Photoshop.

Scaling: có thể định tỷ lệ 50 - 200%.

Relief: biến thiên trong khoảng giá trị từ 0 đến 5.

Light Derection (hướng chiếu sáng): bạn có thể chọn từ góc độ bất kỳ. Bạn cũng có thể đảo ngược 
kết cấu nếu bạn muốn nghịch đảo hiệu ứng chạm nổi.
 
Bộ lọc Watercolor
Bộ lọc Watercolor tìm kiếm các hình dạng và đơn giản hoá màu sắc. Nó tạo một khoảng biến thiên 
giá trị và hình dạng rất lý tưởng trong tiến trình đơn giản hoá màu từ “nhiếp ảnh” sang “hội hoạ”. 
Tuy nhiên, dấu hiệu của màu nước, thường là cảm giác nhẹ, thanh thoát, trong khi hiệu ứng tạo 
thành từ bộ lọc Watercolor lại có màu quá mạnh. Bộ lọc Watercolor làm tăng cường cá vùng tối 
trong hình ảnh quá mức, và các màu ở hiệu ứng cuối cùng cực kỳ mạnh và chói.

Xác lập Brush Detail: thay đổi từ 1 đến 14, quyết định liệu bộ lọc này có sao chép hình ảnh gốc hay 
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chỉ lấy màu chung và đồng thời còn quyết định cảm giác của bức ảnh.

Shadow Intensity: có thể thay đổi từ 1 đến 10 nhưng giá trị này luôn có giá trị 1.
Texture: thay đổi từ 1 đến 3. Xác lập Texture rất tinh tế. Không có sự khác biệt lớn giữa việc dùng 
giá trị 1 hoặc 3.

Hình gốc Hình áp dụng bộ lọc Smoudge Stick

Nhóm Blur 
Các bộ lọc Blur làm mờ vùng chọn hoặc hình ảnh, rất hữu ích trong việc chấm sửa ảnh. Có thể tạo bóng 
mờ cho hình ảnh.

Blur 
Tạo hiệu ứng làm mờ hình ảnh, tạo cảm giác về sự mềm mại. Các biên cạnh màu của hình ảnh 
cường độ mịn có giá trị thấp.

Blur More 
Tạo hiệu ứng làm mờ hình ảnh có hiệu ứng mạnh gấp đôi so với Blur.

Gaussian Blur

Nhanh chóng làm nhòe vùng chọn theo mức 
độ có thể điều chỉnh. Giá trị Radius càng cao 
thì mức độ nhòe càng mạnh.
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Motion Blur 

Làm nhòe theo hướng cụ thể (từ –360 độ đến 
+ 360 độ) và cường độ xác định (từ 1 – 999). 
Hiệu ứng của bộ lọc này tương tự như chụp 
ảnh đối tượng đang chuyển động.

Radial Blur 
Làm nhòe một cách đa dạng và phong phú hơn. Nó tạo ra vòng xoáy đồng tâm hoặc theo đường 
hướng tâm (Spin, Zoom).

•	 Spin: Làm nhòe dọc theo các đường tròn đồng tâm (cuộn xoáy)

•	 Zoom: Làm nhòe theo đường hướng tâm
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Smart Blur 
Làm nhòe chính xác hình ảnh. Làm nhiệm vụ tinh lọc các mảng màu. Nó chuyển hóa hình ảnh về 
dạng đơn giản của các pixel màu.

Nhóm Blur Gallery

Các bộ lọc thuộc Blur Gallery này đều thuộc nhóm bộ lọc cải tiến, có cách sử dụng và thao tác khác 
rất nhiều so với nhóm bộ lọc cổ điển. Sử dụng Gallery Blur giúp nhanh chóng tạo ra các hiệu ứng 
làm mờ ảnh riêng biệt, có thể điều khiển trực quan trên hình ảnh bao gồm:

•	 Field Blur
•	 Iris Blur
•	 Tilt_Shift 
•	 Path Blur
•	 Spin Blur

Mỗi công cụ Blur cung cấp trực quan về điều khiển hình ảnh để áp dụng và kiểm soát các hiệu ứng 
làm mờ. Với những điều chỉnh hoàn toàn mờ, sử dụng điều khiển Bokeh để tạo kiểu hiệu ứng blur 
tổng thể. Photoshop cung cấp một kích thước đầy đủ, xem trước trực tiếp khi bạn làm việc với các 
hiệu ứng trong Gallery Blur.

Chọn Filter> Blur Gallery và sau đó chọn hiệu ứng mong muốn.

Đối với các Lens blurs (Field blur, Iris blur, và Tilt/Shift blur), nhấn phím M để xem các mặt nạ 
làm mờ áp dụng cho ảnh. Các khu vực màu đen không bị mờ, trong khi vùng sáng cho biết tham 
số làm mờ áp dụng cho ảnh.

Field blur

Sử dụng Field Blur để xây dựng một gradient của bóng mờ, bằng cách xác định nhiều điểm mờ với 
tham số khác nhau của blur. Thêm nhiều pin vào hình ảnh và chỉ định tham số blur cho mỗi pin.

Kết quả cuối cùng được kết hợp hiệu quả của tất cả các blur pin trên ảnh. Bạn thậm chí có thể thêm 
một pin bên ngoài hình ảnh, áp dụng blur ở các góc.

•	 Chọn Filter> Blur Gallery> Field Blur.

Một Field blur pin được đặt trên hình ảnh. Bấm vào ảnh để bổ sung thêm blur pins.

•	 Nhấn vào một pin để chọn nó, và thực hiện một trong các cách sau:

•	 Kéo blur handle để tăng hoặc giảm giá trị blur. Bạn cũng có thể sử dụng Blur Tools panel 
để điều chỉnh tham số blur.

•	 Kéo pin đến một vị trí mới.
•	 Nhấn Delete để loại bỏ nó.
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A. Blur pin không được chọn

B.  Blur pin được chọn

Iris blur

Sử dụng Iris blur để mô phỏng hiệu ứng độ sâu cho hình ảnh của bạn, mà không cần quan tâm bạn 
sử dụng máy ảnh hoặc ống kính nào. Bạn cũng có thể tạo nhiều tiêu điểm, điều mà không thể đạt 
được bằng cách sử dụng các kỹ thuật máy ảnh truyền thống.

•	 Chọn Filter> Blur Gallery> Iris Blur.

Iris blur pin mặc định được đặt trên hình ảnh. Bấm vào ảnh để bổ sung thêm các blur pins.

A. Khu vực sắc nét 

B. Khu vực mờ dần

C. Khu vực mờ
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•	 Kéo handles để di chuyển chúng để xác định lại các khu vực khác nhau. 
•	 Kéo  blur handle để tăng hoặc giảm độ mờ. Bạn cũng có thể sử dụng Blur Tools panel để 

điều chỉnh tham số blur.

Tilt-Shift

Sử dụng các hiệu ứng Tilt-Shift để mô phỏng một hình ảnh chụp với một ống kính tilt-shift. Hiệu 
ứng làm mờ đặc biệt này tạo một vùng sắc nét, và sau đó mờ dần ra phía biên ảnh. Hiệu ứng Tilt-
Shift có thể được sử dụng để mô phỏng hình ảnh của đối tượng thu nhỏ.

•	 Chọn Filter > Blur Gallery > Tilt-Shift.
Tilt-Shift blur pin mặc định được đặt vào hình ảnh. Bấm vào ảnh để thêm blur pin khác.

C. Vùng mờ

B. Vùng mờ dần 

A. Vùng sắc nét 

•	 Kéo  blur handle để tăng hoặc giảm độ mờ. Bạn cũng có thể sử dụng Blur Tools panel để điều 
chỉnh tham số blur.

•	 Để xác định các khu vực khác nhau, làm như sau:
•	 Kéo đường ranh giới giữa các vùng để di chuyển chúng
•	 Kéo và xoay handles
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Path blur
Sử dụng hiệu ứng Path Blur, bạn có thể tạo ra chuyển động mờ đi theo đường dẫn. Bạn cũng có 
thể kiểm soát hình dạng và tham số làm mờ. Photoshop sẽ tự động tổng hợp ảnh hưởng của nhiều 
path blurs áp dụng cho một hình ảnh.

 

Spin blur 
Tạo hiệu ứng mờ theo hình tròn hoặc hình elip. Với filter này thì bạn có thể tạo hiệu ứng chuyển 
động của bánh xe ở tốc độ cao một cách dễ dàng.
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Nhóm Distort 

Các bộ lọc Distort làm biến dạng hình học của hình ảnh, tạo hiệu ứng 3D hoặc tái tạo hình dạng khác. Lưu 
ý, những bộ lọc này có thể chiếm dụng rất nhiều dung lượng nhớ.

Ảnh gốc:

Diffuse Glow 
Hình ảnh tựa như được nhìn qua bộ lọc khuếch tán mờ dịu. Bộ lọc này đưa thêm sọc trắng vào 
hình ảnh, với quầng sáng mờ dần từ tâm vùng chọn.

Displace 
Bộ lọc này sử dụng một ảnh PSD, gọi là họa đồ thay thế để quyết định cách biến dạng một vùng 
chọn.
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Glass 
Làm cho hình ảnh hiển thị như thể được nhìn ngắm qua các kiểu kính khác nhau.

Ocean Ripple 
Thêm những gợn sóng cách nhau một cách ngẫu nhiên vào bề mặt hình ảnh, làm cho hình ảnh tựa 
như ở dưới nước.

Pinch

Xoáy vùng chọn. Giá trị dương tối đa 100% sẽ xoắn vùng chọn vào tâm, giá trị âm tối đa –100% sẽ 
xoắn vùng chọn hướng ra ngoài.
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 Polar Coordinates 

Chuyển vùng chọn từ tọa độ vuông góc sang tọa độ cực và ngược lại.

Ripple 
Tạo mẫu gợn sóng trên vùng chọn, y hệt sóng nước lăn lăn trên mặt hồ. Muốn chi phối hiệu ứng ở 
mức cao hơn, hãy dùng bộ lọc Wave.
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Shear
Làm biến dạng hình ảnh dọc theo đường cong. Xác định đường cong bằng cách kéo vạch trong hộp 
để tạo đường cong biểu thị mức biến dạng.

Spherize 
Cung cấp hiệu ứng 3D cho đối tượng bằng cách bao quanh hình dạng cầu, làm biến dạng hình ảnh 
và kéo dãn hình ảnh sao cho khớp với đường cong đã chọn.
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Twirl 
Xoáy hình ảnh mạnh dần về phía tâm. Việc chỉ định góc sẽ tạo ra một mẫu thức xoáy.

Wave 

Hoạt động tương tự như bộ lọc Ripple nhưng mức chi phối cao hơn. Các tùy chọn bao gồm số bộ 
sinh sóng, độ dài sóng, độ cao sóng, và kiểu sóng.

Zigzag 
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Làm biến dạng ảnh theo hướng xuyên tâm với các đường chữ chi. Ta có thể xác lập số bước nghịch 
hướng trên đường chữ chi. Hiệu ứng tạo cảm giác như ném viên đá xuống nước, nước loang ra.

Để có được ánh phản chiếu màu trắng, ta có thể dùng Brush Brush màu trắng vẽ vài nét lên hình 
trước khi áp dụng hiệu ứng.

Nhóm Texture

Các bộ lọc Texture cung cấp cho hình ảnh dáng vẻ của độ sâu hay tình trạng của vật chất trong thực 
tế, hoặc bổ sung một dáng vẻ hữu cơ.

Craquelure 

Tạo hiệu ứng trông như ảnh được vẽ trên một bề mặt của chất giấy bìa sần hay một bề mặt trát vữa  
bị nứt nẻ ngang dọc.
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Grain 

Bổ sung dạng kết cấu vào hình ảnh bằng cách giả lập các loại hạt khác nhau.

            
Mosaic Tiles 
Làm cho hình ảnh trông như được ghép thành từ nhiều mảnh nhỏ hoặc ghép lặp, đồng thời bổ 
sung các kẽ hở giữa các mảnh.
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Patch Work 

Phá vỡ hình ảnh thành các mảnh vuông được tô bằng màu trội trong khu vực.

Stained Glass 
Chức năng Stained Glass vẽ lại hình ảnh ban đầu bằng các hình đa giác không đều liên kết với 
nhau. Mỗi hình đa giác có một màu đơn.
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Texturizer 

Áp lên hình ảnh một dạng kết cấu do ta chọn hoặc tự tạo ví dụ như vải, tường gạch, nền vữa cát xi măng
   

Nhóm Render

Clouds

Kết hợp ngẫu nhiên biến đổi giữa màu Foreground 
và màu Background (tạo hiệu ứng mây).

Difference Clouds

Sử dụng các giá trị ngẫu nhiên biến đổi giữa màu 
tiền cảnh và màu nền nhằm tạo nên mẫu thức mây. 
Nó hòa trộn dữ liệu mây với các điểm ảnh y như 
chế độ Difference hòa trộn các màu.

Lens Flare 

Giả lập hiện tượng khúc xạ ánh sáng, cực sáng thẳng vào camera (còn gọi là hiện tượng ngược 
sáng).
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Lighting Effects 

Bộ lọc Lighting Effects cho phép bạn hiệu chỉnh kiểu chiếu sáng, loại nguồn sáng, thuộc tính chiếu 
sáng và kênh chứa mẫu kết cấu.

Filter/ Render/ Lighting Effects. Chọn một loại đèn trong hộp Style

•	 Point: Chiếu sáng theo mọi hướng như bóng đèn tròn.
•	 Infinite: Chiếu sáng từ xa sao cho góc chiếu sáng không thay đổi, tương tự như mặt trời.
•	 Spot: Chiếu chùm tia sáng hình elip, ta có thể xác định hướng và góc chiếu sáng, bốn handle 

xác định rìa của hình elip.
Chọn một kiểu Light Type. Nếu đang dùng nhiều nguồn sáng thì ta có thể chọn On (Bật) hoặc 
hủy chọn On (tắt). Muốn thay đổi màu của nguồn sáng, nhấp vào ô màu ở mục Color trên bảng 
Properties và chọn màu tùy ý.
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Xác lập thuộc tính chiếu sáng:

•	 Gloss: Quyết định mức độ phản xạ ánh sáng của bề mặt (như trên bề mặt giấy ảnh) từ Matte 
(phản xạ thấp) đến Glossy (phản xạ cao).

•	 Metalic: quyết định giữa nguồn sáng hoặc đối tượng được chiếu sáng, thành phần nào phản 
xạ mạnh hơn. Plastic phản chiếu màu của nguồn sáng, Metallic phản chiếu màu của đối 
tượng.

•	 Exposure: tăng nguồn sáng (giá trị dương) hoặc giảm nguồn sáng (giá trị âm). Giá trị bằng 0 
sẽ không có tác dụng.

•	 Ambience: Khuếch tán ánh sáng như nó được phối hợp với nguồn sáng khác trong phòng, 
như ánh nắng hoặc đèn huỳnh quang. Nếu muốn dùng duy nhất nguồn sáng này thì ta chọn 
giá trị 100, giá trị –100 là loại bỏ nguồn sáng.

Để sao chép một nguồn sáng, nhấp Alt và kéo nguồn sáng trong cửa sổ xem trước. Để áp dụng cho 
mẫu tô đầy dạng kết cấu, hãy chọn một kênh cho Texture Channel.

Điều chỉnh nguồn sáng Point:

•	 Để dịch chuyển nguồn sáng, kéo hình tròn ở tâm.
•	 Tăng hoặc giảm kích cỡ nguồn sáng: kéo một trong bốn handle xác định các rìa của hiệu 

ứng này.
•	 Điều chỉnh nguồn sáng Directional:
•	 Dịch chuyển nguồn sáng: kéo hình tròn ở tâm.
•	 Muốn đổi hướng nguồn sáng, kéo handle ở cuối vạch nhằm quay góc chiếu sáng. Nhấn Ctrl 

và kéo sẽ giữ độ cao nguồn sáng (chiều dài vạch) không đổi.
•	 Thay đổi độ cao nguồn sáng, kéo handle ở cuối vạch. Rút ngắn vạch để có cường độ chiếu 

sáng mạnh hơn. Kéo dài vạch sẽ giảm cường độ chiếu sáng.

Điều chỉnh nguồn sáng Spot:

•	 Dịch chuyển nguồn sáng: kéo hình tròn ở tâm.
•	 Tăng góc chiếu sáng: kéo handle rút ngắn vạch
•	 Co giãn hình elip hoặc quay nguồn sáng: Kéo một trong các handle. Bấm Shift và kéo sẽ giữ 

góc không thay đổi, bấm Ctrl và kéo sẽ cho phép thay đổi góc mà không làm thay đổi kích 
thước của nguồn sáng.

•	 Thiết lập cường độ chiếu sáng: thay đổi giá trị Intensity
•	 Mức độ chứa ánh sáng: Focus

Chọn loại nguồn sáng: Mặc định có 17 loại nguồn sáng, ta có thể tạo thêm bằng cách thêm nguồn 
sáng vào xác lập Default.

•	 2 o’clock Spotlight: Đèn pha vàng với cường độ trung bình và tiêu điểm rộng.
•	 Blue Omni: Aùnh sáng xanh từ trên chiếu xuống với cường độ toàn phần và không có tiêu 

điểm.
•	 Circle of Light: Bốn đèn pha. Đèn trắng có cường độ toàn phần và tiêu điểm tập trung, đèn 

vàng có cường độ tương đối mạnh và có tiêu điểm tập trung, đèn đỏ có cường độ trung bình 
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và tiêu điểm tập trung, đèn xanh có cường độ toàn phần và tiêu điểm trung bình.
•	 Crossing: Đèn pha trắng với cường độ trung bình và tiêu điểm rộng.
•	 Crossing Down: Hai đèn pha trắng với cường độ trung bình và tiêu điểm rộng.
•	 Five Lights Down/ Five Lights Up: Năm đèn pha trắng chiếu xuống hoặc chiếu lên với cường 

độ toàn phần và tiêu điểm rộng.
•	 FlashLight: Đèn vàng với cường độ trung bình.
•	 FloodLight: Đèn pha trắng với cường độ trung bình và tiêu điểm rộng.
•	 Paralle Directional: Đèn định hướng xanh với cường độ toàn phần và không có tiêu điểm.
•	 RGB Lights: Các đèn đỏ cờ (Red), xanh lục (Green) và xanh dương (blue) tạo ánh sáng có 

cường độ trung bình và tiêu điểm rộng.
•	 Soft Direct Lights: Đèn pha trắng với cường độ toàn phần và tiêu điểm trắng.
•	 Three Down: Ba đèn pha trắng với cường độ dịu và tiêu điểm rộng.
•	 Triple SpotLight: Ba đèn pha với cường độ dịu và tiêu điểm rộng.

Bổ sung nguồn sáng: Trong hộp thoại Lighting Effects, kéo tâm của biểu tượng đèn ở cuối hộp 
thoại vào vùng xem trước (tối đa là 16 đèn).

Làm việc với Smart Filter

Khi bạn áp dụng một Filter cho một layer, một vùng điểm ảnh hay một bức ảnh, thực chất là các 
điểm ảnh gốc đã bị thay đổi triệt để dưới sự tác động của các thuật toán của Filter. 

Nếu bạn không ưng ý lắm với hiệu quả của một Filter đã áp dụng, bạn không thể chỉnh sửa nữa nếu 
ảnh đã Save và đã đóng lại vì lúc này trạng thái mới của các điểm ảnh đã được xác nhận. Mặt khác, 
nếu một người khác muốn nghiên cứu và học hỏi từ một bức ảnh đã áp dụng Filter mà bạn làm thì 
hầu như cũng không thể vì ngoài sự thay đổi hiển thị trên các điểm ảnh thì không có bất cứ thông 
số nào được hiển thị để có thể xem và học hỏi về Filter đã được sử dụng.

Từ các phiên bản Adobe Photoshop CS, khi khái niệm Smart Object xuất hiện thì cũng đồng thời 
xuất hiện thêm khái niệm Smart Filter. Nói một cách dễ hiểu thì đó là thao tác áp dụng Filter cho 
đối tượng dạng Smart Object.

Nếu bạn muốn áp dụng Smart Filter cho một layer điểm ảnh thông thường thì việc đầu tiên bạn cần 
làm là mở menu Filter, chọn lệnh Convert for Smart Filter để biến đổi layer đó thành dạng Smart 
Filter, sau đó thao tác như áp dụng Filter thông thường.

Điều khác biệt giữa một Smart Filter và một Filter là các hiệu ứng biến đổi không trực tiếp tác 
động lên đối tượng gốc như ở layer điểm ảnh thông thường mà nó hiện diện như một phần đính 
kèm của Smart Object, đại loại như Layer Style đính kèm một layer. Với cách làm việc như vậy, nếu 
không thích Filter đã áp dụng, hoặc muốn so sánh sự biến đổi giữa tài liệu gốc và sau khi áp dụng 
filter, bạn chỉ việc tắt bật biểu tượng con mắt ở phần Filter hay xóa bỏ hẳn Filter đính kèm là xong.

Mặt khác, nếu đã tương đối ưng ý với hiệu quả mà Filter mang lại, và cần hiệu chỉnh thêm một chút 
để có một kết quả hoàn hảo hơn, thì với Smart Filter, bạn chỉ việc nhấp đúp vào tên của Filter đã 
áp dụng được đính kèm trong Layer Panel là hộp thoại của Filter đó sẽ mở ra cho phép bạn hiệu 
chỉnh thông số.
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Một Smart Object có thể được gán nhiều Smart Filter, có thể tắt bật hay xóa bỏ một hoặc nhiều 
Filter đã áp dụng. Các Filter đã sử dụng được liệt kê đày đủ ở phần đính kèm bên dưới layer, muốn 
xem cụ thể thông số của từng Filter bạn chỉ cần nhấp đúp vào tên layer đó để mở ra xem. Với cách 
làm việc này, người chưa có nhiều kinh nghiệm sẽ có cơ hội học hỏi từ người khác để hoàn thiện 
thêm kiến thức của mình, việc mà Filter thông thường trên điểm ảnh không thực hiện được.
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CHƯƠNG VII: LÀM VIỆC VỚI ACTIONS
Photoshop Action là một trợ giúp tuyệt vời cho người thiết kế, dù bạn là dân “Pro” hay chỉ là thành 
phần “Amateur”; Action giúp bạn thực hiện một cách chính xác một nhiệm vụ nào đó, giúp công 
việc lặp đi lặp lại chán gắt và mất nhiều thời gian trở nên nhanh và dễ hơn bao giờ hết.

Để tìm hiểu về Actions, bạn cần vào menu Window > Action (Alt + F9)

Panel Action mở ra, bạn sẽ thấy trong đó có sẵn một Set có tên là Default Action. 

Action Panel của Adobe Photoshop
Trong danh sách xổ xuống của Default Actions Set, bạn thấy có rất nhiều Action như:

•	 Vignette (selection)
•	 Frame Channel - 50 pixel
•	 Wood Frame - 50 pixel
•	 Cast Shadow (type)
•	 Water Reflection (type)
•	 Custome RGB to Grayscale
•	 Molten Lead
•	 Make Clip Path (selection)
•	 Sepia Toning (layer)
•	 Quadrant Colors
•	 Save as Photoshop PDF
•	 Gradient Map

Bạn click chuột chọn lấy tên một Actions trong Panel ví dụ như Custome RGB to Grayscale, sau đó 
click tiếp vào nút Play ở dưới đáy Actions Panel và xem kết quả...
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Chọn Actions Custome RBG to Grayscale và Play

 
Và đây là kết quả sau khi play Actions 

Như vậy Actions là một dạng kịch bản tạo sẵn, người dùng chỉ việc chọn lựa một trong số rất nhiều 
kịch bản và yêu cầu Photoshop thực hiện lại một cách chính xác thông qua việc nhấn nút Play.

Mọi việc sẽ tự động được Photoshop thực hiện và cho ra một kết quả hoàn hảo mà bạn không mất 
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nhiều công và thời gian để thực hiện, kể cả trường hợp bạn hoàn toàn không có một chút kiến thức 
nào về chỉnh sửa ảnh hay thiết kế trên môi trường Adobe Photoshop thì kết quả sau khi bạn Play 
một Actions vẫn là mỹ mãn.

Lưu ý tại mỗi tên của Acion trong Action Panel, đôi khi bạn tháy xuất hiện một nội dung nằm 
trong ngoặc, đó chính là yêu cầu cần bạn thực hiện trước khi cho chạy Action. Ví dụ như bạn thấy 
(selection) thì cần phải tạo một vùng chọn (selection) trước khi nhấn Play, hoặc bạn thấy (type) thì 
cần phải có một text layer và chọn layer đó trước khi cho Play. Một số trường hợp bạn không thấy 
kết quả khi áp dụng Action, có thể do bạn đang áp dụng trên lớp Background mà action đó lại yêu 
cầu phải làm việc trên layer thông thường, lúc này bạn cần rename cho Background layer bằng cách 
nhấp đúp vào tên của layer và xác nhận cho nó đổi thành Layer 0; tiếp theo bạn áp dụng lại Action 
đã dùng trước đó và xem kết quả.

Photoshop Actions từ đâu mà có?

Photoshop Actions là kết quả ghi lại các thao tác khi thực hiện một thiết kế của một Designer nào 
đó, chương trình sẽ ghi lại đầy đủ các thao tác, các lệnh, các tham số, các công cụ đã sử dụng trong 
suốt quá trình thiết kế mẫu, và tạo thành một Actions. Khi bạn hay bất cứ một người sử dụng Pho-
toshop nào chọn Actions đã ghi lại đó và cho Play, thì toàn bộ các thao tác với các lệnh, các công 
cụ và các tham số sẽ được đối chiếu theo bản ghi mà lần lượt thực hiện lại một cách chính xác trên 
bức ảnh mới.

Có bao nhiêu thư viện Actions trong Actions Panel?

Muốn gọi một Actions Set khác, bạn cần nhấn váo hình tam giác nhỏ phía trên bên phải của Ac-
tions Panel, khi menu ngữ cảnh mở ra, bạn sẽ thấy phân khu thứ 2 từ dưới lên chứa một loạt các 
Actions Set như: 

•	 Commands
•	 Frames
•	 Image Effects
•	 LAB - Black & White Technique
•	 Production
•	 Stars Trails
•	 Text Effect
•	 Texture
•	 Video Action

Để gọi sử dụng một thư viện Actions - Actions Set, bạn chỉ việc nhấn vào tên của nó trong menu 
ngữ cảnh , set sẽ được mở trong Actions Panel.

Bạn có thể làm gì với 1 Action?

•	 Play Action để áp dụng nó cho 1 bức ảnh
•	 Mở từng bước của 1 Action để học cách thực hiện
•	 Can thiệp vào tham số của Action để cá nhân hóa kết quả mà action đó sẽ thực hiện
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Thao tác ghi một Actions:

•	 Mở một bức ảnh mà bạn muốn xử lý
•	 Vào menu Window> Actions hoặc nhấn tổ hợp phím Alt+F9 để gọi Actions Panel
•	 Nhấn vào nút Create new set để tạo một thư viện actions của riêng bạn, đặt tên cho Set.
•	 Nhấn tiếp vào nút Create new action có hình trang giấy trắng
•	 Khi hộp thoại New Action hiện ra, bạn đặt tên cho actions của mình ở trường Name, nếu 

muốn, có thể gán luôn một Function Key (Phím tắt) cho action đó, cuối cùng nhấn nút 
Record.

•	 Hộp thoại New action ẩn đi, đồng thời tại Actions Panel , nút Record được bật lên
•	 Thực hiện thao tác bạn muốn với bức ảnh.
•	 Khi đã hoàn thành mọi thao tác mà bạn muốn và nhận được kết quả như ý, nhấn nút Stop 

tại đáy Actions Panel.

Như vậy là Action của bạn đã được ghi lại, và từ nay trở đi, thao tác mẫu mà bạn vừa thực hiện, 
nếu cần lặp lại thì bạn chỉ việc mở bức ảnh bạn cần, sau đó nhấn Function Key mà bạn đã gán cho 
Action là xong.

Tự động hóa hoàn toàn một Action 

Nếu số lượng ảnh cần áp dụng action nhỏ thôi thì bạn chỉ việc mở toàn bộ số ảnh đó rồi nhấn 
Function Key vài lần là xong. Tuy nhiên khi số lượng ảnh lớn, đồng thời dung lượng của các 
ảnh cũng lớn thì cách làm này không ổn vì nguyên việc mở một số lượng lớn ảnh cùng một 
lúc có thể đã làm máy tính không đủ bộ nhớ để hoạt động rồi. 

Gặp trường hợp này bạn có thể vào menu File> Automate> Batch. Khi hộp thoại Batch hiện ra, bạn 
cần thiết lập các thông số thích hợp để chạy action cho cả một Folder.

•	 Tại mục Play, bạn cần chọn 2 tham số là Set và Action
•	 Tại mục Source, bạn cần chọn dạng Folder để xử lý theo gói cho cả một Folder, bên dưới, 

bạn nhấn chon Choose... và trỏ tới folder chứa ảnh gốc cần xử lý bằng Action.
•	 Tại mục Destination, bạn cũng chọn kiểu xử lý là Folder, còn phần Choose... bạn trỏ tới 

Folder sẽ chứa kết quả sau xử lý. 
•	 Nhấn OK để Photoshop hoàn toàn tự động xử lý cả Folder ảnh cho bạn.

Lưu ý, nếu folder ở mục Destination không phải là folder mẫu mà bạn đã thực hiện trong khi ghi 
Action thì bạn cần đánh dấu thêm vào mục Override Action “Save as” Command để Photoshop 
chuyển hướng khi ghi kết quả.

Mặt khác để tránh lỗi trong quá trình cho Action chạy tự động, bạn cần lọc trước các ảnh sẽ cho 
chạy action về cùng loại ví dụ như toàn bộ ảnh là .JPEG hay .TIFF ... vì nếu trong quá trình hoạt 
động, action đã ghi của bạn chỉ có thông số chỉ dẫn đối với một dạng ảnh mà lại gặp một định 
dạng ảnh khác, nó sẽ mở ra một hộp thoại yêu cầu xác nhận rồi mới chạy tiếp. Lúc này nếu bạn 
không có mặt để xác nhận thì tác vụ sẽ bị dừng mãi ở đó, không thể chạy để xử lý tự động cae 
Folder ảnh như bạn mong muốn được.
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Menu File> Automate>Batch để xử lý cả gói Images bằng Action

 
Các Options cần thiết lập khi xử lý 
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